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System Requirements

       
Chapter 1: Welcome To EditDV Unplugged

Welcome to Radius EditDV Unplugged, the easy to use, QuickTime 
nonlinear editing software for all digital video post production using the 
DV format. With integrated titling and keyframe animation Radius 
EditDV Unplugged provides important easy to use tools for the digital 
artist working in desktop video. EditDV Unplugged includes both drag 
and drop and professional three-point video and audio editing, high 
quality easy to use transitions, and multi-colored, WYSIWYG titling 
right on your video in a simple three window environment.

With Radius EditDV Unplugged you can: 

• Organize audio and video media to use in a program

• Capture source clips from DV tape

• Trim source clips for use in a program

• Assemble source clips into a sequential program

• Add transitions between clips

• Apply filters to add special effects

• Utilize the Titling filter to create titles and credits 

• Animate effects over time with keyframing capabilities

• Print final programs to DV tape to create digital masters

System Requirements
Radius EditDV Unplugged is a QuickTime application and is 
compatible with IEEE 1394, FireWire hardware. To use Radius EditDV 
Unplugged effectively for video production you need the following:

• Mac OS computer with a minimum of 32 megabytes of memory

• Qualified hard disk. 

• FireWire card.

• Apple System 8.0 or later and QuickTime 2.5 or later
1
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Note:  Please refer to the specifications of your FireWire card for 
complete compatibility information. Please check the Radius Web 
site at www.radius.com for the latest information on recommended 
equipment.

Optional Equipment:

• one or more hard drives (internal or external) for storing your video 
and audio media.

• A DV format camera or VTR with bi-directional FireWire support 
(DV in/out).

• A video monitor attached to your DV device is required for full 
motion full screen play back of your DV footage.

Before Running Radius EditDV Unplugged
Make sure that you’ve installed your FireWire card and software and 
that everything is working properly. Owners of MotoDV can capture 
their clips using MotoDV and are ready to edit them. Owners of Apple 
FireWire must first install device control into EditDV Unplugged.

To install Device control plug-in for Apple FireWire owners:

1. Locate your “FireWire” folder that was installed on your system 
and open the folder called “FireWire Plug-ins for Premiere”.

It should look like this.



 

Before Running Radius EditDV Unplugged

    
2. Drag the file named “DV Device Control” into the EditDV 
Unplugged/Plug-ins/Device control folder.

It should look like this.
3



 

CHAPTER 1: WELCOME TO EDITDV UNPLUGGED                                       

 

4



 

A Tour of the Windows in Radius EditDV Unplugged

      
Chapter 2: An Overview of Radius EditDV 
Unplugged

This chapter provides an overview of Radius EditDV Unplugged to get 
you started on your first project. After installing your FireWire card and 
Radius EditDV Unplugged application you are ready to begin working 
with Radius EditDV Unplugged to create a video program.

This chapter includes a tour of EditDV Unplugged that describes the 
three main windows of the interface and how they relate to each other. 
It then provides a step-by-step tour of creating a complete video project 
— from capturing video clips to completing your final video tape.

A Tour of the Windows in Radius EditDV Unplugged

The Monitors Window 

The picture above shows the Monitors window with the Source monitor 
and Program monitor displayed. EditDV Unplugged uses a side by side 
display where the player on the left is used to review source clips that are 

Source
monitor Program

monitor

Source clip
pop-up

Source monitor
controls

Program
monitor controls

Patch Matrix
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then assembled into a sequence to create a program, displayed on the 
right. Your program will ultimately contains all clips and effects that you 
specify in the Sequencer window.

The Source monitor - on the left of the Monitors window is used to 
play your source clips and select the frames you want to use in your 
program. It includes controls to play your clips, scrub through them by 
dragging the mouse on the time pointer. You can also select part of a 
clip by marking the beginning (mark in) and ending (mark out) of the 
section of the clip that you want to use in your program.

The Program monitor - on the right of the Monitors window displays 
your program as you assemble it. You can play or scrub the entire 
program, or any individual track.

The FX monitor - replaces the Program monitor when you are working 
with the special effects filters included with Radius EditDV Unplugged. 
The FX monitor displays previews of how your video will look after it 
has been modified by an effect. It provides a highly interactive 
workspace where you can work directly with the mouse to position 
video, text and graphic effects.

FX
monitor 
with Iris 
transition
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The Trim window - is used to adjust the cut points between your clips 
after you have placed them into your program. The Trim monitor is a 
film style, tail/head, side-by-side display of the cut point. It allows you 
to adjust one or more cut points to create roll and split edits, including 
audio trimming.

The Project Window
The Project window - is used to organize your audio and video source 
clips. You place information about your clips in separate bins that can 
be displayed in either text or picture view. These references are 
maintained as part of your project so EditDV Unplugged can locate all 
of your clips on disk.

Outgoing
clip

Incoming 
clip

Trim window
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The Sequencer Window
The Sequencer window - is a graphic representation of your entire video 
and audio program along a Timeline with the beginning of your 
program at the left. This visual description of your program is one of the 
most powerful features of a non-linear editing system. It allows you to 
see the relative position of video clips, audio clips and special effects in 
your program. To add source clips to the Timeline in the Sequencer 

Picture view

Text view
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window, you drag them either from the Source monitor or the Project 
window, or you can set the in and out points in the Source monitor and 
use the Edit button to add them to the timeline.

Window Management 
Radius EditDV Unplugged is preset to display the Project window, 
Sequencer window, and Monitors window on your computer monitor. 
You can show or hide any of the windows using the Window menu. 

Building a Program with Radius EditDV Unplugged
The following sections describe how to build a program in Radius 
EditDV Unplugged — from starting a new project to printing the final 
project to videotape.

Getting Started
To start Radius EditDV Unplugged:

1. If necessary, double-click the icon for the hard disk where 
Radius EditDV Unplugged is stored.

You see the Radius EditDV Unplugged folder in the volume you 
chose during installation.

2. Double-click the Radius EditDV Unplugged folder.

SkyView

Video track
FX track 

Audio tracks

Timeline cursor

Transition
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3. Double-click the Radius EditDV Unplugged icon.

You see the Open Project dialog.

4. Click New to create a New Project.

The New Project Setting dialog box will appear.

5. Select a project preset from the dialog box and click OK to start 
a new project.

When you select a project preset you see a short description of it in the 
Description box. Each preset specifies video and audio options that will 
be used to build your final project.

The project presets provided with Radius EditDV Unplugged provide 
options for the audio formats supported by the DV format. Select the 
audio sampling rate that will work with your DV system, to output to 
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tape when you print your final project. If your DV system supports 
multiple sample rates select the sample rate that matches the audio 
format that you will be using for your project.

Capture Source Media
If you are a MotoDV owner, use Radius MotoDV to capture your DV 
format video and audio clips following the instructions in the MotoDV 
manual. If you have any other FireWire boards use the capture window 
to capture your clips. You can also import PICT files, QuickTime 
movies and music from CD’s, and a variety of other computer graphics 
and animation files into EditDV Unplugged.

Using MotoDV

Radius EditDV Unplugged includes special drag and drop features to 
facilitate importing clips captured with MotoDV. Use MotoDV and the 
Finder to organize your clips into separate folders, then import them 
into EditDV Unplugged by dragging files or folders to the left or right 
side of the Project window as follows:

• Drag clips from the Finder into the appropriate bin.

Select one or many clips (using Shift-Select) in the Finder and drag 
them into the right side of the Project window to put them in the 
currently opened bin. You can also drag them to the left side of the 
Project window over the bin name you would like them stored in.

• Drag a folder to the left side of the Project Window.

A new bin will be created with the folder name and all of the clips in 
that folder will be stored in that bin.

• Drag a folder to the right side of the Project Window

All of the clips in the folder will be placed in the currently open bin.

You can also use the Import command in the File menu to import clips 
one at a time into bins.

After importing source clips, you are ready to use Radius EditDV 
Unplugged to create a video program.
11
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Using the Capture Window

Radius EditDV Unplugged is designed to capture clips using the 
Capture window. Be sure to capture to a drive that you’ve configured 
and tested for DV performance with your FireWire card. Before 
capturing clips you must configure your system for capture from a DV 
device. Be sure that the Device control/Plug-ins folder contains the 
appropriate device control plug in. For more information see, “To install 
Device control plug-in for Apple FireWire owners:” on page 2.

To Configure System for Capture:

1. Select Open Capture Window from the Capture Menu.

You see the Radius EditDV Unplugged Capture window the con-
trols will be grayed-out until a DV device control plug-in has been 
selected.

DV Device
control

Click to choose
capture options

Click to begin or 
stop capture

Configure media 
drives
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2. Select the Options button.

You see the Radius EditDV Unplugged Options dialog. Select DV 
Device Control from the Plug-in pop-up.

3. Set the Sound and Video input dialogs for DV.

For more information, see “To Configure Video Input Settings:” on 
page 35 and “To Configure Sound Input Settings:” on page 36.

4. Be sure your DV device is attached and in VTR mode.

You are now ready to capture clips using Radius EditDV Unplugged.

To Capture Clips:

1. Select Open Capture Window from the Capture Menu.

You see the Radius EditDV Unplugged Capture window.

2. Use the controls in the Capture window to control your camera 
to navigate to the position on your tape that you wish to record.

DV Device
control

Click to choose
capture options

Click to begin or 
stop capture

Configure media 
drives
13



 

CHAPTER 2: AN OVERVIEW OF RADIUS EDITDV UNPLUGGED                                       

 

14

      
3. When you find the starting point you want to record, make sure 
the DV device is playing the tape and press the Capture button.

4. Each clip you capture will be placed in the current bin in the 
Project window.

Reviewing and Choosing Source Clips
After placing source clips in the Project window, you are ready to view 
the clips in the Source monitor. Double-clicking on the clip icon in the 
Project window or dragging the clip from the Project window to the 
Source monitor opens the clip in the Source monitor. Once the clip is 
in the Source monitor, you can play it, scrub through it and mark In and 
Out points to select the portions of clips you want to add to your 
program. 

Overwrite

Edit Patch 
Matrix

Insert
Mark Out

Mark In

Play from 
In to Out
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Assembling a Program
You assemble a program by moving clips from the Source monitor or 
Project window into the Sequencer window. This window contains a 
graphic representation of your program along a Timeline beginning at 
the left of the window. It shows the order the clips will play in your 
program, and which audio and video clips will play together. Clips that 
are positioned at the same time in the Sequencer window play back 
simultaneously. 

When you first open a new project, this window contains empty tracks 
into which you place video media, audio media and filters to create 
special effects. It opens with one empty video track (V1), two audio 
tracks (A1 and A2) and one (FX1) track. You add source clips to your 
program by dragging from the Source monitor to the position on the 
Timeline where you want that clip to play, or by using the Patch Matrix 
and pressing the Edit button. To create a program, you place source clips 
one after the other along the Timeline in the Sequencer in the order you 
want them to play, then add special effects and audio tracks to 
accompany them.

You modify clips after placing them in the Timeline by adjusting the cut 
point between them using the Trim window. To select a cut for 
trimming, place the Timeline cursor over it and press the Trim button. 
The Trim monitor is a film style, tail/head, side-by-side display of the 
cut point. The tail of the outgoing clip is displayed on the left and the 
head of the incoming clip is displayed on the right. The Trim window 
allows you to adjust two adjacent video clips as if they were two pieces 

SkyView

Video track

FX track 

Audio tracks

Timeline cursor

Trim button
Eliminate

Erase

Source button

FX button 
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of film spliced together. You can shorten or lengthen either piece, 
separately or together. The Trim window includes support for traditional 
roll and split edits, while maintaining the splice.

The Erase and Eliminate buttons are also used to adjust clips after 
placing them in the Timeline. You first mark in and out points in the 
Sequencer to define the section of your program to be removed. You 
then click the Erase button to remove that section and replace it with 
filler that will appear as black in video or silence in audio. You click the 
Eliminate button to remove that section and shorten your program by 
the length of the removed section.

Tail of
outgoing clip

Head of 
incoming clip

Eliminate
Erase

Erased 
section

Program 
selection



 

Building a Program with Radius EditDV Unplugged

     
Placing Transitions Between Clips
Radius EditDV Unplugged provides a variety of professional quality 
transitions you can use between clips. To apply a transition, drag it from 
the Effects window to a cut between two clips in the Sequencer window. 
Because transitions involve two clips side by side, they are placed on the 
cut point between the clips, rather than in an FX track. You can adjust 
the length and position of the transition after it is applied and you can 
modify a transition to create a custom version. You can also trim the two 
clips involved in the transition using the Trim window without 
disturbing the transition itself.
17
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Applying Filters to Achieve Special Effects
You create special effects with Radius EditDV Unplugged by choosing a 
filter from the Effects window and dragging it onto an FX track in the 
Sequencer window just below the video that you wish to modify. You 

Drag Transitions from the 
Effects window to the 
Sequencer window

Each transition
has a control

panel to create
specific settings
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can also use the filters as a starting point for creating your own custom 
filters, which can be saved to disk and used again in other parts of your 
program or in other projects.

The FX monitor appears in place of the Program monitor whenever you 
drag the timeline cursor over a selected special effects filter or double 
click an effects filter. Each filter has a Control window where you adjust 
controls to choose the style of the effect. Filters can be previewed using 
the Animate button in the Sequencer window. With Radius EditDV 
Unplugged’s keyframing capabilities you can animate any filter control 
over time to create dynamic effects.

Drag Filters from
the Effects window

to the Sequencer

Animate 
button

Snapshot 
button
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Tint Control Window

FX Monitor

Adding Titles
The Radius EditDV Unplugged Titling filter provides the ability to 
easily create titles, credits, and other text for use in your program. It 
provides access to these powerful features: 

Select the new
bright tint color

Select the new
dark tint color

Select the
percentage of
blend with the

original

Tint applied 
with above 
settings 
creates a 
black and 
white image

Title and Action safe button
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• an assortment of TrueType and Type 1 fonts and font sizes 

• the capacity for developing shadows and backgrounds to your 
specifications 

• a color palette for text, shadows, and backgrounds

• settings for opacity and the creation of gradients for text, shadows, 
and backgrounds

• the ability to work with an unlimited number of text layers and to 
move text through a video, in a variety of ways, using keyframes

Use the Titling filter as you would any other filter in Radius EditDV 
Unplugged by dragging it into an FX track in the Sequencer window. 
With the Titling filter you can then type and format text directly in the 
FX monitor.

Using Keyframes
Radius EditDV Unplugged keyframes allow you to create dynamic 
effects that change over time. A keyframe is automatically created at the 
beginning of any filter. When you adjust the controls on a filter, 
21
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additional keyframes are created. Radius EditDV Unplugged calculates 
and uses progressive settings for each frame between the keyframes to 
create the final effect frame by frame.

Arrowheads 
indicate keyframe

Position and Scale boxes indicate 
the text location and scale at each 
keyframe
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Previewing a Program
While the Source monitor allows you to view source clips, the Program 
monitor is used to review the program you are constructing in the 
Sequencer window. Since it is possible to have many video and audio 
tracks within the Sequencer that are all combined to create your final 
program, buttons are provided along the left edge of the Sequencer 
window to allow you to select the tracks to play at any given time. When 
you click Play in the Program monitor, the track in the Sequencer with 
the Eyeball button active will be displayed All audio tracks, within the 
limits of the processing power of your computer, that have active Ear 
buttons will be played at the same time. 

When you place your first video clip on the video track (V1) in the 
Sequencer window, you will see that clip in the Program monitor as long 
as the Eyeball button on track one is active. The buttons on the button 
bars below the Program monitor allow you to play your program in 
different ways: play, play selection only and play to the next mark point.

Previewing Effects:

You work directly with a single special effect by selecting it in the 
Sequencer, or double clicking it to bring up its Control panel. The result 
of any adjustment you make to the effect controls are previewed on the 
current frame in the FX monitor. To see the effect in the context of your 
entire program, including all video tracks, click the Snapshot button. 

The Animate button in the Sequencer window is used to preview an 
animation of the effect over the entire length of the filter so you can 
review how the effect will play in your final program. This is especially 
useful with filters that move in the video frame, such as titles.

You can view a single finished frame containing effects in the Program 
monitor by positioning the Timeline cursor in the Sequencer window at 
the desired frame and clicking the Snapshot button in the Sequencer 
window. Radius EditDV Unplugged renders a snapshot of your video 
program at that time by applying any transitions and filters used in the 
frame. The resulting frame is displayed in the FX monitor for review but 
not stored on disk.
23
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Making Your Master Videotape
If your video program only contains cuts you can play it immediately 
either in the program monitor or on your video display (using Print to 
Video). However, if it contains transitions, filters or too many audio 
tracks for your computer to mix in realtime, it must first be rendered 
before it can be played. When using Radius EditDV Unplugged you can 
render all or part of your program by making a selection in the Timeline. 
If there are no mark in and mark out points defining a selection, the 
entire program will be rendered. 

You build your program into two special tracks: the VP (Video Program) 
and AP (Audio Program) tracks. These tracks take the place of the 
program or record tape deck in a traditional studio where final programs 
are assembled. Thus, rendering causes EditDV Unplugged to assemble 
all of your source clips, transitions and filters into a final, playable 
program in your Program Tracks. These program tracks can then be 
played in the Monitors window, played at full screen through your DV 
tape deck or camcorder, or recorded to video tape. 

Snapshot button
Animate button

Selected filter



Building a Program with Radius EditDV Unplugged
This chapter has been a brief overview of the main steps in completing a 
program using Radius EditDV Unplugged. The following chapters 
discuss each of the Radius EditDV Unplugged digital video production 
tools in depth to help you utilize the full potential of the power of 
Radius EditDV Unplugged to create high quality video programs.

Audio Program Track

Video Program Track

Program 
Selection
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Creating a Project
Chapter 3: Managing Source Media

The source material used in production of a Radius EditDV Unplugged 
program can include many different kinds of media. CDs, DATs, 
videotapes, audio tapes, computer graphics and animation, can all be 
used as source material. You combine and edit the source media to 
create a video production or program with Radius EditDV Unplugged. 
All of the different formats are converted to DV when the program 
tracks are updated so your final program can play out through your DV 
camcorder.

Creating a Project
“Chapter 2: An Overview of Radius EditDV Unplugged” on page 5 gave 
an overview of beginning work with Radius EditDV Unplugged. On 
subsequent start-ups or during work sessions, you can create completely 
new projects or open an existing project. By double-clicking on the 
project file in the Finder, you can open Radius EditDV Unplugged and 
the existing project at the same time. Only one project can be open at a 
time in EditDV Unplugged.

To start Radius EditDV Unplugged and open an existing 
project:

1. Double-click the icon for the hard disk where Radius EditDV 
Unplugged is stored.

The Radius EditDV Unplugged folder appears in the volume you 
chose during installation.
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2. Double-click the Radius EditDV Unplugged folder. Double-click 
the icon.

You see the Open dialog box.

3. Open the folder you want to use, click the project to select it and 
click Open.

Radius EditDV Unplugged starts and the file you selected is opened. 
You see the project as it was last saved.

If you choose Open from the File menu with a project already 
opened, you see a dialog box. Select a project and click open. The 
project you were working on closes and your new choice is opened.

You can also open a project file by double clicking it in the Macin-
tosh Finder, or dragging it to the EditDV Unplugged application 
icon.

Creating a New Project During a Work Session
You can create new projects at subsequent start-ups or in the middle of a 
work session. 

To create a new project:

1. Choose Save from the File menu to save any changes you have 
made to the existing project.

You can close your current project or keep it open until you start 
your new project. Once you open a new project, Radius EditDV Un-
plugged automatically closes your previous project. If you have not 
saved changes on your previous project, a dialog will appear asking 
if you want to save the changes.



Saving and Backing up a Project
2. Choose New from the File menu.

You see the New Project Setting dialog box. 

Select a project preset. Each preset specifies the audio options for the 
program you will be creating in the project. The audio data rate that 
you select in the preset will be the rate at which all audio in your pro-
gram is mixed and sent out over FireWire. 

3. Select a preset for your new project and click OK.

Saving and Backing up a Project
It is a good idea to save your project on a regular basis to protect your 
work. When you save your project all of the changes you have made 
since your last save, which are temporarily stored in computer memory, 
are written to your hard disk. It is generally advisable to save your 
project on a regular basis, every 10 or 15 minutes, while working. It is 
also advisable to occasionally save a copy of your project using the Save 
Copy As command under a different file name to protect yourself in the 
event that your project file should become corrupted.

You can also change the name of your project at anytime using the Save 
As command without altering any previously saved versions of the 
project.

The project you are working on resides only in computer memory until 
you use one of the save commands to create a hard disk version of the 
project. 
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It is advisable to save often so that your saved version of the project is 
always up-to-date. If there is a system failure, your most recent changes 
to the project will remain intact.

The individual save commands are described below.

Saving a Project for the First Time
To save your current project the first time:

1. Choose Save from the File menu.

You see the Save dialog box.

2. Choose the volume and folder where you want to store your 
project.

By default your project is saved in the same volume and folder where 
Radius EditDV Unplugged is stored, unless you choose a different 
one. It is recommended that you save your project in a separate fold-
er at the same level as your source clips folder and media drive folder 
to keep all of the media required for a project in a one place. Thus, 
a project folder might contain a project named My Project, a folder 
named My Project Source Clips and another named My Project Me-
dia Drive. This organization separates source clips, rendered pro-
gram clips and the project itself, making it easy and efficient to locate 
projects and source clips.

You can choose a different volume or folder in which to save your 
project from the Save dialog box, or you can click New to create a 
new folder.

3. Type a name for your project in the Save File As box.

Current volume



Saving and Backing up a Project
4. Click Save.

Saving a Project During a Work Session
To save your current project:

1. Choose Save from the File menu.

Your project file on disk is updated to reflect any changes since your 
last save. A progress window displays clip names as your project is 
saved.

Saving a Copy of a Project
You can also save a copy of the project you are currently working on 
under a different name and in a different volume or folder, creating a 
back-up version of your project. You may want to save your project first, 
in its current form.

To save a copy of your current project:

1. Choose Save A Copy As from the File menu.

The Save Copy As dialog box will appear.

2. Type a new name in the Save File As box.

You can choose a different volume or folder in which to save the 
project, or click New to create a new folder.

3. Click Save.

Your current project is saved under a new name and in its new loca-
tion. 

Note: The current project remains on disk with its previous name and 
location as it was when you last saved it, and is not updated. Only the 
copy is updated.

Changing the Name of a Project 
You can save the project you are currently working on under a new 
name and make that newly named project the current working project. 
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To save your current project under a new name:

1. Choose Save As from the File menu.

You see the Save As dialog box.

2. Type a new name in the Save File As box.

Choose a different volume or folder in which to save the project, or 
click New to create a new folder.

3. Click Save.

Your project is renamed, saved and opened with the new name. 

Reverting to a Previous Copy
If you are not satisfied with the latest changes you made to your current 
project, you can revert to the project as you last saved it. 

To revert to the most recently saved version of your project:

• Choose Revert to Saved from the File menu.

The changes you made since last saving your project are discarded. 
The project returns to what it was when it was last saved.

Note:  If you want to preserve your current project changes for later 
use, make a copy of the project by choosing Save A Copy As from 
the File menu before reverting to the most recently saved version. 

Radius EditDV 
Unplugged displays the 
name of the file so you 
can add a version 
number or rename it.



Capturing Media Into a Project
Capturing Media Into a Project
If you are a MotoDV owner, use Radius MotoDV to capture your DV 
format video and audio clips following the instructions in the MotoDV 
manual. If you have another FireWire board and software use the 
capture window to capture your clips. You can also import PICT files, 
QuickTime movies and music from CD’s, and a variety of other 
computer graphics and animation files into EditDV Unplugged.

Using MotoDV for Capture
Radius EditDV Unplugged includes special drag and drop features to 
facilitate importing clips captured with MotoDV. Use MotoDV and the 
Finder to organize your clips into separate folders, then import them 
into EditDV Unplugged by dragging files or folders to the left or right 
side of the Project window as follows:

• Drag clips from the Finder into the appropriate bin.

Select one or many clips (using Shift-Select) in the Finder and drag 
them into the right side of the Project window to put them in the 
currently opened bin. You can also drag them to the left side of the 
Project window over the bin name you would like them stored in.

• Drag a folder to the left side of the Project Window.

A new bin will be created with the folder name and all of the clips in 
that folder will be stored in that bin.

• Drag a folder to the right side of the Project Window

All of the clips in the folder will be placed in the currently open bin.

You can also use the Import command in the File menu to import clips 
one at a time into bins.

After importing source clips, you are ready to use Radius EditDV 
Unplugged to create a video program.
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Configuring EditDV Unplugged for Capture
Radius EditDV Unplugged is designed to capture clips using the 
Capture window. Be sure to capture to a drive that you’ve configured 
and tested for DV performance with your FireWire card. Before 
capturing clips you must configure your system for capture from a DV 
device. Be sure that the Device control/Plug-ins folder contains the 
appropriate device control plug in. For more information see, “To install 
Device control plug-in for Apple FireWire owners:” on page 2.

To Configure EditDV Unplugged for Device Control:

1. Select Open Capture Window from the Capture Menu.

You see the Radius EditDV Unplugged Capture window that is 
grayed out.

DV Device
control

Click to choose
capture options

Click to begin or 
stop capture

Configure media 
drives



Capturing Media Into a Project
2. Select the Options button.

You see the Radius EditDV Unplugged Options dialog. select DV 
Device Control from the Plug-in pop-up.

3. Click OK.

4. Be sure your DV device is attached and in VTR mode.

5. Select the Preview window.

To Configure Video Input Settings:

1. Select Video Input from the Capture menu.

You see the Video Input dialog. If the Video Input menu item is grey 
be sure that the Preview window is selected.
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2. Set the compressor pop-up to DV- NTSC or DV-PAL.

Choose the format that is appropriate for your video standard. Typ-
ically NTSC if you are in the Americas or Japan and PAL if you are 
in Europe or Australia.

To Configure Sound Input Settings:

1. Select Sound Input from the Capture menu.

You see the Sound dialog.

2. Set the Compression pop-up to None.

3. Select Source from the Compression pop-up.

4. Select DV Audio from the Device pop-up.

You see the Sound dialog source settings.



Capturing Media Into a Project
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Choosing Volumes and Folders for Storing Clips 

Organize your disk storage by constructing a list of volumes and folder
which to store your source clips. If you fill one volume, EditDV 
Unplugged uses the next volume on the list to store your clip. If a clip 
too large to be stored in the available space in one volume, the entire c
stored on the next volume.

To set up multiple volumes and folders for storing captured clips:

1. Choose Configure from the Capture To pop-up in the Capture 
window.

2. Click the Add button in the dialog box.

3. Select a volume and folder and click Open. 

4. Click Select this Folder to add the volume and folder to the 
bottom of your list. 

Available storage space on disk is shown. 

5. Arrange your list so that the first volume to be used is at the top 
of the list. 

Select items in the list and use the Move Up and Move Down butto
to create the order in which your volumes are used during batch d
tizing. To delete a volume and folder from the list, select it and clic
the Delete button. 

6. When your list is complete, click OK.

Your list of volumes and 
folders appears here
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Capturing clips with EditDV Unplugged
Radius EditDV Unplugged is designed to capture clips using the 
Capture window and a QuickTime VDIG supported FireWire card. 
Please be sure to capture to a drive that you’ve configured and tested for 
DV performance with your FireWire card.

To capture source clips:

1. After selecting the Project window where you plan to store your 
clip information and preparing your DV device for use, choose 
Open Capture Window from the Capture menu.

You see the Capture and Preview windows on your computer mon

2. Choose the volume and folder where you want to store your 
captured clips.

See “Choosing Volumes and Folders for Storing Clips” on page 37,
specific directions on setting up volumes and folders to store infor
tion and organize your projects. 

DV Device
control

Preview
window

Click to choose
capture options

Click to begin or 
stop capture

Configure media 
drives

Displays available space 
on selected media drive

Timecode at 
current position 
on videotape
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3. Start playing your source tape using the controls in the Capture 
window.

You see the tape playing in the preview window and on your video
monitor if attached to your camera.

4. When you reach the position in the tape where you want to 
capture a clip, click the capture button in the capture window (or 
press Command-T).

Your clip is captured to your disk in the location you specified. The
capture button in the capture window becomes the Stop button. 

5. When you reach the position in the tape where you want to end 
your clip, click the Stop button in the capture window (or press 
Command-period).

Capturing stops. Clip information entered in the capture window is
added to the selected bin in the Project window. The tape in your vi
deck continues to play unless you stop it.   

You will see the Clip name box.

6. Type a name for your clip in the Clip Name box.

Being descriptive and consistent in naming your clips can be help
If you do not type a name for your clip, the clip is given a name untit
with a numerical suffix.

7. Continue capturing clips using this procedure. 

When you finish capturing your clips, choose Close capture from t
capture menu to close both the Capture and Preview windows. 

Importing Media Into a Project
Radius EditDV Unplugged is designed to capture clips using the Apple 
FireWire software and hardware, however clips captured in MotoDV can 
easily be organized into file folders in the Finder and imported into 
Radius EditDV Unplugged maintaining the same structure that you 
devised in the Finder. 

To drag a clip or clips into your project:

1. In the Project window, select the bin where you want to store the 
imported clip. 
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2. Drag the clip or selected clips into the right side of the Project 
window.

If you would like to place them in a bin other than the currently se-
lected one, drag over the bin name on the left side of the project win-
dow. Your clips will be imported into that bin.

To create a new bin and import a folder of clips:

1. In the Finder, select the folder of clips you want to import. 

2. Drag the folder to the left side of the Project window.

A new bin is created with the name of the folder and all of the clips 
are stored in that bin.

Radius EditDV Unplugged allows you to use clips from other projects 
and files. You can also use clips in other digital formats. Radius EditDV 
Unplugged supports the following digital media formats: PICT, Photo 
CD, QuickTime, and AIFF. 

By using the Import command on the File menu, you can move 
multiple clips directly into your project, without closing Radius EditDV 
Unplugged or going to your desktop. 

To use a clip from another project or in another format:

1. In the Project window, select the bin where you want to store the 
imported clip. 

2. Choose Import from the File menu.

You see the Import Dialog box.

Current volume

Folders in volume



Importing Media Into a Project
3. Choose the volume and folder where the clip is located.

4. Select the clip.

You can view your selected clip by clicking Create in the dialog. The 
clip will be shown under the word Preview, to the left of the file list. 
If the clip you selected is a PICT, see “To import a PICT:” on 
page 41.

If the clip you select is an audio clip, the Import command becomes 
Convert. By clicking Convert your audio clip is changed to the 
QuickTime file format and is added to your project.

5. Click Import.

The clip is added to the currently selected bin. 

After you have added your clips to your project, save it.

To import a PICT:
1. In the Project window, select the bin where you want to store the 

imported PICT. 

2. Choose Import from the File menu.

You see the Import Dialog box.

3. Choose the volume and folder where the PICT is located.

4. Select the PICT.
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5. Click Import.

You see the Import PICT window

6. Adjust the PICT to accommodate your needs.

Use the Import Pict window to change your PICT clip to the appro-
priate size for use in your program.

Click to keep 
aspect radio

Length of 
movie created 
from PICT



Importing Media Into a Project
7. Click OK.

You see the Save PICT Dialog box.

The PICT is automatically given the .MooV suffix and is converted 
into a movie clip the length you selected, and is added to the cur-
rently selected bin. 

Note:  It is not necessary to keep the .MooV suffix you may name 
the clip any appropriate descriptive name.

After you have added your PICTs to your project, save it.

To Import Audio
Make sure that the audio CD is inserted into the drive and appears on 
the desktop.

To import an audio track from a CD:

1. In the Project window, select the bin where you want to store the 
imported audio track. 

2. Choose Import from the File menu.
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3. Choose the volume where the Audio CD is located.

You see the Audio Import dialog box

4. Select the Track to be imported.

5. Click Convert.

You see the Audio Save as dialog.



Importing Media Into a Project
6. Click Options.

You see the Audio Options window.

Select the audio import options and the start and end time of the clip 
you want to import.

7. Click OK to convert the audio clip.

Select a folder and name for the audio file. 

8. Click Convert.

The audio clip will be converted to a QuickTime audio file and 
stored in the selected bin.

Click to play 
selection

Select 44.1kHz, 
16 bit, Stereo for 
Audio CDs

Audio rate 
pop-up

Select the 
start and end 
time to import
45



CHAPTER 3: MANAGING SOURCE MEDIA                                       

46
Organizing Source Clips in Bins
When you begin a new project, you see one bin in the Project window. 
You see the bin name at the left of the window, and columns for 
information about source clips appear at the right.

As you add source clips to your project, information about the clip is 
stored in the bin, including its location on your hard disk.

Creating Bins
You can create as many bins as you need to organize your source clips in 
groups that work best for you and your editing style. 

To create a bin:

• Click the New Bin button in the control ribbon of the Project 
window.

A new bin name appears in the left column of the Project window. 
When you add a new bin, it is selected as the current bin.

Renaming Bins
When you create a new bin, it is automatically assigned a number. You 
can rename bins to organize your clips into meaningful groups and put 
them into bins with descriptive names you have chosen.

Bin name

Control
ribbon for

project
window



Organizing Source Clips in Bins
To rename a bin:

1. Double-click the bin name in the left column of the Project 
window.

You see the Bin Name dialog box.

2. Type a new name for the bin and click OK.

The selected bin in the left column of the Project window changes 
to the new name and all bins are sorted in alphabetical order. The 
renamed bin remains selected.

Selecting Bins for Use
To add clips to a bin, use the clips in a bin, or delete an empty bin, you 
must first select the bin.

To select a bin:

• Click the bin name in the left column of the Project window.

You see the selected bin highlighted. Its contents are displayed at the 
right.

Deleting Bins
If you decide you no longer need a bin, you can delete it. You cannot 
delete a bin that contains clips or is the last bin in a project.

To delete a bin:

1. Select the empty bin that you want to delete.

2. Choose Clear from the Edit menu (or press the Delete key). 

The bin name disappears from the left column of the Project win-
dow.
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Using Text View
You can view the content of a bin as a list of names or as pictures. When 
you create a new project, Radius EditDV Unplugged is preset to display 
in text view as shown. Use the mouse to click on bins or column 
information or use the arrow keys to move through the text view. 

In addition to the first column of clip names, the text view contains 
several other columns of information described in the following table.

Sorting the Text View

The text view is sorted in alphabetical order, according to the names of 
the clips, but you can choose any column for use in sorting the text 
view. 

Column: Gives you this information:

Name The name of the clip.

Duration The length of the clip.

In The SMPTE timecode for the frame where the clip begins, o
an assigned number if there is no SMPTE timecode.

Out The SMPTE timecode for the frame where the clip ends, or
an assigned number if there is no SMPTE timecode.

Tracks Which video and audio tracks are contained in the clip.

Comment Your comments regarding the clip.

Status States whether the clip is On Tape, On Disk, or Off-line.



Organizing Source Clips in Bins
To change the column to be sorted in the text view:

• Click the column header for the column you want to use. 

The contents of that column are sorted and displayed accordingly. 
All columns are sorted in ascending order and the column header 
used for sorting is underlined. 

If you want to see the contents of a bin sorted according to the 
lengths of the clips in the bin from smallest to largest, click Duration. 

Changing the Column Width

When you first see the text view, each column is preset to a specific 
width. You can change the width of the Name and Comment columns.

To change the width of a column in the text view:

1. Click on the vertical line to the right of the heading, in either the 
Name or Comment columns.

You see a short vertical line with two arrows. 

2. Drag the line to the right to increase the size of the column or to 
the left to decrease the size.

The other columns remain the same size.

Hiding Columns in Text View

The text view is preset to display the Name, Duration, In and Out Point, 
Tracks, Status and Comment columns. To change the columns that are 
displayed, you must change specifications in the Project window 
Preferences dialog box.

Change the 
column width
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To hide information columns: 

1. Choose Preferences from the File menu and Project window 
from the submenu.

You see the Project Window Preferences dialog box. 

2. Click the checkbox to remove the checkmark for a column you 
don’t want to display in the text view. 

When the checkmark is shown, that column is displayed in the 
Project window. 

3. Click Save.

When you save your preference settings and return to your project, 
you see the Project window with the information columns you se-
lected. 

Using Picture View
View the content of a bin as pictures by clicking the radio button in the 
control ribbon of the Project window. You see a small version of one 
frame in the clip, called the poster frame. The poster frame defaults to 
the first frame in each clip. The name of the clip appears under the 
picture. Use the mouse to click on areas in the picture view or use the 
arrow keys to move through it.

Checked items 
are displayed in 
the text view

Displays whether 
clip is on disk or 
not
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Changing the Frame Displayed for a Clip

It may be helpful to change the frame that is displayed in the picture 
view to one that is more descriptive of the entire clip.

To change the poster frame displayed in the picture view:

1. Double-click the source clip in the Project window to display it 
in the Source monitor.

2. In the Source monitor, move the Source Timecursor to the 
frame you want to use in the picture view. 

3. Choose Set Poster Frame from the Edit menu.

You see the frame in the Source monitor replace the frame currently 
in the picture view of the Project window.

Changing the Order in the Picture View

You can change the order of clips in the picture view as a first step in 
sorting clips for your program.

To change the order of clips in the picture view:

• Drag the clip you want to move to an empty block in the picture 
view.

When you release the mouse button, the picture of the clip moves 
from its previous position to the empty block.

• You can also drag several pictures to a new location, at the same 
time. Click on the first picture, then hold down the shift key. While 
you continue to hold down the shift key, click on as many pictures 
as you want to move. When all your pictures are selected, you can 
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drag them, as a group, to the new location. Radius EditDV 
Unplugged places them in the order they were selected beginning at 
the new location.

Note:  These clips may also be dragged directly to the Sequencer 
window and they will be placed in the order they were selected. This 
is a quick way to make a rough cut of your material to review how it 
works together in a program.

Changing the Number of Columns in the Picture View

Radius EditDV Unplugged is preset to display five columns in picture 
view. You can change this setting and display from one to fifteen clips 
across the Project window. 

To change the number of columns displayed in the picture 
view: 

1. Choose Preferences from the File menu and Project window 
from the submenu.

You see the Project window Preferences dialog box.

2. Change the number after # of Columns in the Picture Mode area 
of the dialog box. 

Type a number between 1 and 15. 

3. Click Save.

When you save your preference settings and return to your project, 
the requested number of columns are displayed across the Project 
window.

Enter the number 
of columns to 
display in the 
picture view
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You might need to extend your view of the Project window to see all 
of your columns. Use the scroll bar at the bottom of the Project win-
dow to scroll through the window.

If you are using the picture view and decide you want to switch to 
viewing the contents of a bin in the text view, click the Text button in 
the control ribbon of the Project window.

Working With Clips in Bins
You can view additional information about the source clips you store in 
a project, move the clips, or delete them when they are no longer 
needed. You also can create secondary source clips that refer to primary 
source clips.

Viewing Additional Information About a Source Clip

For more detailed information about a source clip than what is 
displayed in the text view, for example, the size and frame rate of a clip; 
refer to the Clip Info window. 
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To access information about a source clip:

1. Click the clip in the Project window to select it.

You also can click the clip in the Sequencer window.

2. Choose Get Info from the Edit menu (or press Command-I).

You see the Clip Info window with the information about the select-
ed clip. 

Moving Clips Between Bins

You can move clips from one bin to another within a project to help 
organize your source material. 

Note: Moving clips between bins does not move the location of the file 
in the Finder on your hard disk. It only changes the references from 
within your project.

To move clips from one bin to another:

• Drag the clip over the name of the bin you are moving it to and 
release the mouse button.

• Or, click on the name of the first clip you want to move, then hold 
down the shift key. While holding down the shift key, click on as 
many clips as you want to move. You can now drag them as a group 
over the name of the bin you are moving the group to and release 
the mouse button.

Creating Secondary Clips

When you import a source clip into a project, you create a primary 
source clip in a bin in the Project window. That clip points to a media 
file stored on a hard disk. To store source clips in more than one bin in a 
project, you create one or more secondary source clips from your 
primary clip. A secondary source clip does not point to a media file. It 
points to the primary source clip. 

To create a secondary source clip:

1. Click to select a source clip in the Project window. This is your 
primary clip. 

2. Choose Create Secondary from the Edit menu (or press 
Command-D).



Organizing Source Clips in Bins
The new secondary clip, created from the In and Out points marked 
in the selected primary clip, appears next to the selected clip, in the 
picture view or below the selected clip in the text view. The second-
ary clip is given the same name as the selected primary clip, but is 
marked as a copy.

You also can create a secondary source clip from another secondary clip. 
Both secondary clips refer to the primary clip. 

Renaming Clips

You can make a correction to the name of a clip or rename a clip at any 
time. Using descriptive names is generally useful in organizing your 
source material.

To rename a clip:

1. Click the name of the clip in the Project window.

2. Type a new name for the clip and press Enter.

If you want to make a correction to the name of a clip, click the name 
in the Project window. Use the arrow keys to move the text cursor to 
the letters needing correction. Or, press Return to erase the entire 
name, then make your changes.

Note: Renaming clips in the Project window does not affect the name of 
the media file in the Finder.

Secondary
clip icon
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Deleting Clips From a Bin

Deleting a clip from a project bin deletes the clip information from that 
bin. It does not delete the clip information from other bins in the 
project or the clip media file from the hard disk, unless specified. For 
more information on managing your hard disk space see, “Chapter 10: 
Managing Disk Storage” on page 205.

To delete a clip from a project bin:

1. Click the clip in the Project window to select it.

2. Choose Clear from the Edit menu (or press the Delete key).

You see a dialog box asking you if you want to delete the clip media 
from disk.

3. If you want to delete the media from disk, click the checkbox in 
the dialog box. 

If you are deleting a secondary source clip, no media files are re-
moved from disk. Be cautious when removing media from your hard 
disk that may be used in other projects. Once removed, it will no 
longer be available to the other projects.

4. Click OK. 



Working With Source Clips
Chapter 4: Creating a Program

Creating a program consists primarily of placing video and audio clips 
in the order you want them to play in your final video to convey your 
story to the viewer. Reviewing clips in the Source monitor and placing 
the sections you want on the Timeline in the Sequencer window is the 
first step. The clips are then played for review, cut points adjusted, 
transitions and special effects added and the entire program rendered to 
final, playable form. This final movie can then be recorded out to video 
tape. This chapter outlines the Radius EditDV Unplugged tools used to 
develop a program from reviewing source clips to final program.

Working With Source Clips
After gathering a set of source clips into the Project window, you move 
them individually, or as a group, into the Source monitor, where they 
can be reviewed and trimmed before adding them to your program. It is 
also possible to directly drag clips from the Project window into the 
Sequencer.

Reviewing Clips in the Source Monitor
The Source monitor lets you play your clips to see and hear what you 
have available. The Source monitor also provides the ability to scrub 
through your material with the mouse, mark in and out points as your 
movie plays to select the section you want and tools for frame accurate 
adjustment of in and out points. 

To view a source clip in the Source monitor: 

1. In the Project window, double-click on a clip or, drag the clip 
into the Source monitor.

The first frame of the clip appears in the Source monitor. The name 
of the clip appears under the slider bar in a pop-up menu.
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To view multiple source clips in the Source monitor: 

1. In the Project window, shift select the clips you plan to view then 
double-click on a clip or, drag the clip selection into the Source 
monitor.

The first frame of a clip appears in the Source monitor. The name of 
the all of the clips appear in the Source monitor pop-up menu.

When a source clip is placed in the Source monitor, the slider bar 
represents the full length of the clip. In and Out points marked on the 
slider bar represent the beginning and ending of the clip. As you adjust 
the In and Out points you create a reference to the original clip with a 
new length.

Duration timecode displays the length of the clip from the In point to 
the Out point of the clip. The Source Time timecode indicates the 
position of the cursor on the slider bar. The Patch Matrix shows the 
video and audio tracks in the source clip along the top. The arrow shows 
where each track will be placed in the Sequencer. By default video is 
placed in track V1 and audio in track A1. Click in the grid of the Patch 
Matrix to change the target track in the Sequencer. 

Slider bar

Source monitor 
pop-up menu

Button bars

Source monitor

Timecode for
location of Source

Timecursor

Duration of 
In to Out

Patch Matrix

Source Timecursor
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.

In the Source monitor, you can drag the Timecursor on the slider bar to 
scrub the clip or use the buttons on the button bar to step through and 
play the clip.

The following table summarizes the buttons in the Source monitor.

Button: Name: Key Stroke: Use To:

Audio adjust Adjust the level of the audio in a clip. Audio changes
made in the Source monitor continue to affect a clip 
in the Program.

Play/Stop “d” or 
spacebar

Toggle between playing and stopping the clip. 
The spacebar can also be used to play and stop.

   

Play In/Out “f” Play only the media between the clip’s In and Out 
points.

        

Play to mark “g” Play to the next mark in the clip (the In or Out point)

        

Step back-
ward ten

“j” Move backward ten frames.

Play In/Out

Play/Stop

Loop

Step forward one

Step backward one

Audio
adjust Step 

forward ten

Step backward ten Play to mark

Source monitor 
Timecursor
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Note: For keyboard equivalents for each of the buttons in the Source 
monitor, see “Appendix B: Radius EditDV Unplugged Shortcuts” on 
page 223 for a keyboard layout specifying these keys.

The Source monitor provides easy access to the most recently used clips 
through the pop-up menu below the monitor. Selecting a clip in the 
pop-up places it in the Source monitor for viewing. 

To play Source clips at full screen using DV Player:

• Press Option and click the Play/Stop button in the Source monitor.

While at full screen the space bar will Play and Stop the movie. 
While the movie is stopped the Option left arrow returns to the be-
ginning of the movie and Option right arrow goes to the end, Shift 
left arrow fast scans in reverse and Shift right arrow fast scans for-
ward.

Note:  For a summary of keyboard commands for controlling your 
full screen movie, see “Appendix B: Radius EditDV Unplugged 
Shortcuts” on page 223 for keyboard command table.

Changing In and Out Points in the Source Monitor
In and Out points default in the Source monitor to the first and last 
frame of your clip. Radius EditDV Unplugged provides many options 
for adjusting In and Out points. You choose In and Out points to define 

       

Step back-
ward one

“k” or 
left arrow

Move backward one frame.

        

Step forward 
one

“l” or 
right arrow

Move forward one frame.

         

Step forward 
ten

“;” Move forward ten frames.

       

Loop When used with the Play buttons, causes the clip to 
play continuously as determined by the Play button.
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the section of the clip that you plan to use in your program. The 
illustration below indicates the buttons in the Source monitor used for 
setting In and Out points.

To set In and Out points in the Source monitor: 

• Click the Mark In and Mark Out buttons at any time, whether the 
movie is playing or paused. The current time becomes the In or Out 
point.

Play the clip and select the In point as the frame that you want to be 
the start of your clip is played, allow the clip to continue playing and 
mark the Out point when the last frame of the clip you want is 
played. Review your selection by pressing the Play In/Out button.

Mark In can also be set by pressing the ’i’ key and Mark Out the ’o’ 
key at any time. In and Out points can also be set by selecting in the 
Source Time timecode area and typing a timecode, then clicking 
Mark In or Out.

Adjust In and Out points in the Source monitor with any of the 
following methods:

• Use the Move to In or Out point, use the step keys to move frame 
by frame to the new point you want. Click Mark In or Out.

• Drag an In or Out point marker on the slider bar to a new position.

• Clear a point and reset it. 

Source
monitor

Move to In point

Move to Out point

Clear In Mark In

Mark Out

Clear Out

Clear In/Out

In point Out point
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• Use the right or left arrow keys to advance or back up the Source 
timecursor one frame at a time, then mark an In or an Out point.

• Mark an In or an Out point and type in a duration.

Note: For a summary of keyboard equivalents for each of the buttons in 
the Source monitor, see “Appendix B: Radius EditDV Unplugged 
Shortcuts” on page 223 or a keyboard layout.

Creating Secondary Source Clips in the Source Monitor
When a clip is imported into a project, a primary source clip is created 
and placed in a bin in the Project window. The primary source clip 
references a media file stored on hard disk. To use that primary source 
clip in more than one bin in a project, one or more secondary source 
clips must be created by selecting the primary clip and using the Create 
Secondary command on the Edit menu. A secondary source clip can be 
used to create another secondary source clip. A secondary source clip 
doesn’t point to a media file stored on disk, it points to a primary source 
clip. 

A secondary source clip created in the Project window uses the In and 
Out points last marked in the primary clip. To create a secondary clip 
that uses different In and Out points, the Source monitor is used. There, 
the In and Out points for the source clip can be changed and the 
secondary clip created. 

To create a secondary source clip in the Source monitor:

1. In the Project window, double-click on a source clip to display it 
in the Source monitor. 

2. Set new In and Out points. 

These will be the In and Out points for the secondary source clip.



Assembling a Program
3. Choose Create Secondary from the Edit menu (or press 
Command-D), or drag the source clip from the Source monitor 
back to the Project window.

A secondary clip is created. It is given the same name as the primary 
clip, but is labeled as a copy. 

 For more information on creating secondary source clips see, “Creating 
Secondary Source Clips in the Source Monitor” on page 62. 

Assembling a Program
A program is assembled by moving source clips into the Timeline in the 
Sequencer window. Source clips can be moved into the Timeline by 
using the Patch Matrix in the Source monitor. They can also be moved 
into a program from the Source or Project window, by dragging them 
into the Timeline.

The smaller icon 
indicates clip is 
a secondary clip
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When a source clip is moved into the Timeline in the Sequencer, Radius 
EditDV Unplugged creates a reference to the section of the source clip 
marked by the In and Out points.

When the Sequencer window is first opened, it contains one video track 
(V1), one special effects track for this video track (FX 1), and two audio 
tracks (A1 and A2). You assemble your program by placing clips on the 
tracks in the Sequencer, left to right, in the order you want them to play. 

The Timeline cursor shows your current position on the Timeline, its 
location in your program is reflected in the timecode at the top of the 
window, and the frame at that position is shown in the Program 
monitor.

Patch Matrix

Timeline 
cursor

Indicates 
position of 
Timeline cursor 
on Timeline

SkyView

Video track

Audio tracks

Special effects track

Button bar

Control
ribbon

Timeline 
ruler



Assembling a Program
The buttons in the button bar at the bottom left of the Sequencer 
window let you select portions of the program, mark In and Out Points, 
and move through a program in a variety of ways. The SkyView is a 
graphic overview of the entire program as an aid to navigating from one 
place in your program to another.

Using the Patch Matrix to Place Clips in the Timeline
The Patch Matrix in the Monitors window shows the tracks in the 
source clip and defines where the source clip will be placed in the 
Sequencer. 

When the Monitors window is first displayed, the Patch Matrix contains 
two columns of gold Patch buttons that represent the tracks in the 
Sequencer. When a source clip is placed in the Source monitor, the 
Patch Matrix displays a row of blue buttons that represent the tracks in 
the source clip. 

For example, the clip shown in the Source monitor below has one video 
and one audio track mapped to Sequencer tracks V1 and A1.

Patch Matrix
Video track one Audio tracks one and two
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Choosing the Source Clip Tracks to Use

With the Patch Matrix, you can choose source tracks to use in a 
program. The video track in the source clip can be used without the 
audio, or the audio without the video. If a source clip has two audio 
tracks, either one can be used alone. Also, the source tracks may be 
mapped to any tracks of the appropriate type.

Note:  Source clips can also be dragged directly to any appropriate track 
in the Sequencer.

When a source clip is placed in the Source monitor, it’s tracks are active 
and ready to flow into the Sequencer tracks. A source track can be 
deactivated if it is not to be used in the program. 

To deactivate a track in the source clip:

• Click the blue button for the track in the Patch Matrix.

Radius EditDV Unplugged grays the blue button representing the 
track in the Patch Matrix. The media in this track will not be edited 
into the Sequencer. You can reactivate the track by clicking it again. 

Mapping Tracks With the Patch Matrix

The source tracks to be included in a program are placed into the 
appropriate tracks of the Sequencer via the mapping in the Patch Matrix.

Audio track on source clip 
mapped to first audio track in 
Sequencer window

Video track on source clip 
mapped to video track in 
Sequencer window
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To change the mapping for tracks in the Patch Matrix: 

• Click the intersection of the source track and a Sequencer track in 
the Patch Matrix.

For example, to map the audio track for a clip to the second audio 
track, click the intersection for the source clip audio track and the A2 
Sequencer track. When you click, the mapping line changes. It indi-
cates that source track, A1, will flow to the Sequencer track, A2.

Synchronizing Sequencer Tracks

The gold Patch buttons that represent Sequencer tracks in the Patch 
Matrix also appear in the Sequencer window.

When the Sequencer window is opened, the Patch buttons are active, 
which means the tracks to the right of the buttons are available for 
editing. A source track can only flow into a Sequencer track if the 
Sequencer track is active. 

Source clip track

Clicking here remaps the source clip audio 
track to program track A2

Sequencer track

Patch buttons

Selection bar
67



CHAPTER 4: CREATING A PROGRAM                                       

68
If a Sequencer track is active and nothing is mapped to it in the Patch 
Matrix, Radius EditDV Unplugged adds blank space (called filler) to 
that track. The filler is equal to the length of the source clip flowing into 
other Sequencer tracks and thus keeps all active tracks synchronized.

If a Sequencer track is inactive, you cannot patch source tracks into it 
and it will not be altered by edits to any other tracks.

To make a Sequencer track inactive: 

• Click the Patch button for the track in the Patch Matrix or in the 
Sequencer window. 

Radius EditDV Unplugged grays the gold Patch button for the track 
in both the Patch Matrix and the Sequencer window. You can acti-
vate the track again by clicking its Patch button in either the Patch 
Matrix or Sequencer window. 

Flowing the Clip Into the Timeline

After choosing In and Out points for a source clip, choosing the source 
clip tracks for a program, and mapping those tracks to Sequencer tracks, 
the source clip tracks are moved into the Timeline in the Sequencer 
window by flowing them through the Patch Matrix. 

To flow a source clip into the Timeline using the Patch Matrix:

1. In the Sequencer window, position the Timeline cursor where 
you want to place the source tracks.

The timecode display in the Sequencer window indicates the exact 
position of the Timeline cursor.



Assembling a Program
2. Click the Insert or the Overwrite button in the Monitors 
window.

If Insert is clicked, the clip will be inserted at the position of the 
Timeline cursor when the Edit button is clicked. Any clips to the 
right of the cursor are moved farther to the right to make room for 
the clip and making the overall program longer.

If Overwrite is clicked, the clip will be placed at the position of the 
Timeline cursor covering as much media to the right of the cursor as 
is necessary to place the clip when the Edit button is clicked. Over-
write has no effect on tracks that are active, but have nothing 
patched to them. Filler is not added when using the Overwrite com-
mand.

3. Click the Edit button or press the Enter key to flow the source 
clip into the Timeline of the Sequencer. 

Dragging Clips Into the Timeline
You can drag a source clip onto the Timeline in the Sequencer from the 
Source monitor. One or more source clips can also be moved into the 
Timeline at the same time by selecting them in a bin in the Project 
window and dragging them into the Sequencer. 

Overwrite 
button

Insert 
button

Edit 
button
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To drag a clip into the Timeline:

1. Point to a clip in the Project window or the Source monitor and 
press the mouse button.

To drag several source clips from a bin at the same time, press Shift 
and click the clips you want to select. 

Note:  Clips will be placed in the Sequencer in the order that you 
select them.

2. Drag the clip into an active track of the Sequencer.

An insertion cursor is seen if the track is active. The Patch button is 
gold whenever a track is active, the button is gray if the track is inac-
tive. 

3. Position the insertion cursor where the clip is to begin. Release 
the mouse button.

When dragging several source clips from a bin, the clips are placed 
in the Timeline in the order they were selected, providing a quick 
method for creating a rough cut of a program.

If a source clip has multiple tracks, Radius EditDV Unplugged places 
each track in the first appropriate track in the Timeline (video on a 
video track and audio on an audio track) as long as there are active 
tracks available. 

After dragging a clip into a track in the Timeline, it can be reposi-
tioned by dragging it within the track.

Note:   When dragging clips into the Sequencer they are 
Overwritten into the Timeline. If you wish to insert them into the 
Timeline, hold the Command key while dragging.

Selecting Part of a Program
Any portion of a program in the Timeline can be selected for updating, 
playback or editing. By marking an In and Out point in a program a 
selection is defined. The length of this selection can be changed and the 
position of the selection in the Timeline adjusted by dragging the mark 
points or gold selection bar in the Sequencer window. This selection 
defines a portion of the program that may then be played, Erased (which 
leaves blank space in the program) or Eliminated (which shortens the 
overall program). This selection can also be used for fit-to-fill edits that 



Assembling a Program
adjust the playback speed of the clip being placed to fit into a specific 
portion of the program. It also is used to define the portion of the 
program to be rendered when updating program tracks.

The button bar at the bottom left of the Sequencer window includes 
buttons to set In and Out points to define a selection. 

To select a portion of your program in the Timeline:

1. Drag the Timeline cursor to the selected position for the In 
point. Click the Mark In button. 

The timecode display in the Sequencer window indicates the exact 
position of the Timeline cursor. It can be used to position the cursor 
precisely. If there is currently no selection, a click in the narrow track 
between the Timeline ruler and the first video track, the selection bar 
area, will set an In point.

2. Drag the Timeline cursor to the selected position for the Out 
point. Click the Mark Out button. 

A yellow bar appears in the selection bar area. If there is only an In 
point marked, a click in the selection bar area will set an out point. 
However, if the click is to the left of the In point, a new In point will 
be set.

This selection bar can be extended or shortened by dragging the In 
and Out point markers.

The entire selection bar can also be dragged to a new position by 
clicking and holding on the yellow bar and dragging.

To create a selection for an entire clip:

1. Click the clip in the Timeline to select it. 

Move to In
point

Move to Out point

Clear In point

Mark In point
Mark Out point

Clear Out 
point 

Clear In and 
Out points 

Mark In and 
Out points 

Move backward ten frames

Move backward one frame

Play/Stop

Move forward 
one frame

Move forward 
ten frames
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2. Click the Mark In/Out button. 

A selection bar the size of the clip with the In and Out points for the 
clip marked at either end appears. If there is no clip selected before 
clicking Mark In/Out, Radius EditDV Unplugged creates a selection 
for the clip currently under the Timeline cursor.

When you click the Move to In or Move to Out buttons, the Time-
line cursor moves to the In point or the Out point.

Displaying Drop Frame Timecodes
To display drop frame timecodes in the Sequencer window:

1. Choose Preferences from the File menu and choose Sequencer 
window from the submenu.

The Sequencer Preferences dialog box appears.

Selection bar Timeline ruler

Mark in/out
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2. Click the Use drop frame time scale checkbox and click OK.

Drop frame timecode is displayed for the program in both the Se-
quencer window and below the Program monitor in the Monitors 
window.

Navigating a Program
As a program grows, only a portion of it can be seen in the Sequencer 
window. EditDV Unplugged provides tools to allow you to move 
efficiently from place to place in a program to work effectively. 

To navigate through a program:

• Drag the Timeline cursor through the program in the Sequencer 
window. As the cursor reaches the end of the Timeline that is visible, 
the view in the window changes and moves with the cursor. In this 
way you can move sequentially through an entire program.

• Move to the next or previous interesting time in the program, which 
may or may not be visible in the Sequencer prior to making the 
move. Interesting times include cut points and the beginning and 
end of special effects filters. 

• Use the SkyView in the Sequencer to move easily to areas of a 
program that are outside of the display in the Sequencer window. 
The SMPTE time of the new location is displayed in the Sequencer 
as you drag the SkyView controller.

• Drag the Timeline cursor in the Program monitor.

Using the Timeline to Navigate a Program
The Timeline in the Sequencer window is the graphic representation of 
a program. The Timeline cursor can be moved through the Timeline in a 
variety of ways.

To move the Timeline cursor:

• Drag it with the mouse cursor

• Click a desired point along the Timeline and the cursor will move to 
that point. 
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The timecode displayed above the Timeline reflects the position of 
the cursor in the Timeline. The timecode display changes as the 
cursor moves. 

• Highlight the timecode display and type a new timecode. The 
Timeline cursor will then change to the point reflected by the new 
timecode.

Using Interesting Times
The Sequencer window contains two buttons that allow movement to 
interesting times in a program.

Any change in a program is considered an interesting time. For example, 
the beginning and end of a clip, a transition, or a filter are interesting 
times. When a clip is selected any markers within it are considered 
interesting times and when a filter is selected keyframes are interesting 
times. Clicking either button to move to the previous or next interesting 
time moves the Timeline cursor accordingly. A track must be active for 
an interesting time to be recognized. 

Note:  Using the Previous Interesting Time and Next Interesting Time 
buttons can quickly and easily position the Timeline cursor exactly at a 
cut between two clips or directly on a keyframe. They are also useful for 
moving to the very end of a filter to set a keyframe at the last frame of 
an effect.

Click here to move to 
previous interesting time

Click here to move to 
next interesting time

Previous 
Interesting time

Next Interesting 
time
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Inserting and Moving to Markers

As a program is created, markers can be inserted in clips to help locate 
additional points of interest. Markers are considered interesting times 
only when a clip is selected. 

To insert a marker in a clip:

1. In the Sequencer window, click the clip to select it.

When a clip is selected, there is a black border around it.

2. Drag the Timeline cursor to the position in the clip where the 
marker is to be inserted.

3. Choose Add Marker from the Edit menu, or press Command-M.

The marker is inserted at the position of the Timeline cursor in the 
selected clip. In the Edit menu, Add Marker becomes Remove Mark-
er.

 To remove a marker from a clip:

1. Select the clip.

2. In the Sequencer window, position the Timeline cursor at the 
marker to be removed.

The Move to Interesting time buttons can be used to easily position 
directly on the marker.

3. Choose Remove Marker from the Edit menu, or press 
Command-M.

The marker is removed from the clip.
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 far 
ep-
Using the SkyView
The SkyView in the upper right corner of the Sequencer window shows 
an overview of your entire program. Each track of the program is 
represented by a line in the corresponding color in the SkyView. As clips 
are added to a program, the display in the SkyView grows, from left to 
right.

Within the black border of the SkyView controller, is a view of the 
segment of the program that is visible in the Sequencer window. 
Dragging the controller moves it to any segment of the program. That 
segment becomes visible in the Sequencer window. 

The SkyView is particularly helpful when you are working with a lengthy 
program or wish to move to a specific timecode.

Zooming the Timeline In and Out
The amount of detail seen in the Sequencer is controlled by zooming in 
and out. Zoom in to see less of a program in greater detail. You can 
zoom in to the point where each tick mark on the ruler represents one 
frame of a program. Zoom out to see more of a program, but in less 
detail.

To zoom in:

• Click the plus (+) sign at the right of the Sequencer window. 

The Timeline zooms in. When you have zoomed in the Timeline as
as possible, the plus sign is grayed and each tick in the Timeline r
resents one frame of video.

SkyView controller

 In the SkyView, you see your 
entire program as color-coded tracks
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 To zoom out:

• Click the minus (-) sign at the right of the Sequencer window. 

The Timeline zooms out. When the Timeline is zoomed out as far 
as possible, the minus sign is grayed.

To toggle between the current view of a program and a 
closeup view.

1. Move the mouse cursor to the ruler above the Timeline.

2. Press Option and Click the mouse button.

A magnifying glass with a plus sign in it appears. The Timeline 
zooms in to its maximum magnification (every tick mark on the 
Timeline equals a frame), and the plus sign in the magnifying glass 
changes to a minus sign. 

3. Click again, to zoom the Timeline back to its previous zoom 
level.

As the Timeline in the Sequencer is zoomed in or out, the size of the 
SkyView controller is adjusted accordingly. Zoom in to see a smaller 
segment of a program in more detail, and the controller is smaller. 
Zoom out to see a larger part of a program in the Sequencer, in less 
detail and the controller becomes larger.

Click here to 
zoom in.

Click here to 
zoom out.
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Reviewing a Program
The Program monitor, in the Monitors window, is used to review your 
program. 

The slider bar in the Program monitor represents the entire length of 
your program, while the Duration timecode displays the length of the 
current selection. The Program Time timecode indicates the position of 
the cursor on the slider bar. Drag the slider on the slider bar to scrub 
through the program or use the buttons in the button bar below the 
Program monitor to play the program in different ways. 

Playing a Video Track
You play a video track by making it the visible track in the Sequencer 
window and using the Play/Stop button in the Sequencer window or the 
Program monitor. 

To make a video track in the Sequencer window visible:

• Click the eye icon to the left of the video track. 

The eye icon is gold when the track is visible, grayed when the track 
is not. Only one video track may be made visible at a time. To review 
your entire program you first update the Video Program track then 

Button bars

Program 
monitor

Slider bar
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make it the visible track.

To play the visible track in the Program monitor:

1. Click the Play/Stop button in the Program monitor or Sequencer 
window.

The track begins playing from the current position of the Timeline 
cursor in the Sequencer window.

2. To stop playing, click the Play/Stop button again or press the 
space bar.

To preview a section of the visible track:

• Drag the Timeline cursor in the Sequencer window.

or:

• Select a portion of the program in the Sequencer window and click 
Play in Selection. For more information, see “Selecting Part of a 
Program” on page 70 

To play the Program monitor at full screen:

• Press Option and click the Play/Stop button in the Program 
monitor.

Use the space bar when the Program monitor is at full screen to start 
and stop play. Arrow and Option-arrow keys provide for stepping 
and moving to the beginning and end of your movie. Shift-arrow 
keys provide fast scan forward and reverse.

• To return the Program monitor to its usual size, press Command-
period (.).

Using Program Tracks
Before you can see your program at final quality the result of any 
transitions or special effects that you have applied must be calculated by 
your computer. This process is called rendering. The entire program can 
be rendered, reviewed, and changes made; or, it can be rendered and 
reviewed in sections, as it is assembled. 

Setting Up Storage Space for Rendered Media

Rendering creates playable movies of your effects. A special area should 
be set up on a hard disk for storing this media using the project 
preferences.
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To set up space for storing rendered media:

1. Choose Preferences from the File menu and Media Drive from 
the submenu.

The Media Drive dialog box appears.

2. Click Change.

3. Select the volume and folder where you want to store rendered 
media and click Open.

4. Click Select this Folder.

You see the Program Preferences dialog box with the folder you se-
lected listed.

Rendering a Program Section

To render a section of a program:

1. Add a program track to the Sequencer window by choosing one 
of the Add options on the Program menu. 

Choose Add VP Track to add a video program track, or choose Add 
AP Track to add an audio program track. The program track is added 
below the existing video or audio tracks in the Sequencer window.

2. Select the portion of your program that you want to render.

Define a selection by marking an In and an Out point in the Se-
quencer. See “Selecting Part of a Program” on page 70 for specific in-
structions.



Reviewing a Program
3. Ensure that all tracks that you want included your program are 
render enabled.

When the render button to the left of a track is red, that track is en-
abled for rendering. The button is grayed when a track is inactive for 
rendering and will not appear in the final program.

4. Choose one of the options from the Program menu.

Choose Update or Overwrite VP Track for a video program track, 
and choose Update or Overwrite AP Track for an audio program 
track. Choose Update or Overwrite All Program Tracks for both.

5. Radius EditDV Unplugged renders the selection. 

While rendering, a progress window appears and indicates the num-
ber of frames still to be rendered. The thumbnail of the frames can 
be seen as they are rendered in the display in the Progress window.

 

When rendering is completed, the rendered section is assigned a 
name by Radius EditDV Unplugged, and is displayed in the program 
track. The rendered clip is placed in the Program bin and stored to 
the disk drive specified in Media Drive preferences.

These buttons enable 
or disable a track for 
rendering
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Playing a Rendered Section

After rendering a section of a program, it can be reviewed in the 
Program monitor.

To play a rendered section:

1. Click the eye icon to the left of the program track to make it the 
visible track in the Sequencer window.

The eye icon is gold when the track is visible, grayed when the track 
is not. 

2. Click the Play/Stop or Play in Selection button in the Program 
monitor.

The rendered section is played in the Program monitor.

Removing Obsolete Sections of a Program Track

As you make changes to your program, sections of your program track 
become obsolete in that they no longer reflect the current state of your 
program. The program track, however, maintains the last render until 
you erase or overwrite it, so you can maintain a playable version of your 
program until you are ready to take the time to render again.

Full quality 
rendered section 
in program track

Program 
selectionVisible track

Click to make 
Video Program 
track visible

Enabled 
Render 
buttons
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Sections of the program track can be erased either by selecting a clip in 
the program track and pressing the delete key, or making the program 
track the only active track, marking a selection and then erasing.

To erase a rendered section that is obsolete:

1. Make the program track active for editing by clicking the gold 
activate button.

The program track may be made the only active video track by press-
ing the option key and clicking the active button. All other video 
tracks will be made inactive.

Note:  Be sure that your audio tracks are appropriately set before 
erasing any selection.

2. Define the program selection to be erased by defining In and 
Out points on the selection bar.

Or, use the buttons in the button bar at the bottom of the Sequencer 
window to reset the mark In and Out points. 

3. Click the Erase button to remove the media in the active 
program track.

The program track will be erased under the selection and replaced 
with filler. The remaining blank section will be rendered again dur-
ing the next Update program track.

Updating a Rendered Section

After rendering a section of a program, it can be added to and updated. 
When a rendered section is updated, Radius EditDV Unplugged only 
renders media where there is blank space in the program track.

To update a rendered section:

1. Define the program section to be updated by dragging the In and 
Out points on the selection bar. 

Or, use the buttons in the button bar at the bottom of the Sequencer 
window to reset the mark In and Out points. If no selection has been 
defined, your entire program will be rendered.

For more information about selecting a section of a program, see 
“Selecting Part of a Program” on page 70.
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2. Choose one of the Update options from the Program menu.

Choose Update VP Track for a video program track, and choose Up-
date AP track for an audio program track. Choose Update All Pro-
gram Tracks to update both (or press Command-G).

3. Your program track is updated.

A progress window is displayed to indicate the number of frames per 
section still needing to be rendered. You see the frames, as they are 
rendered, in the display window of that progress window. When ren-
dering is completed, the new section is assigned a name and is placed 
in the appropriate rendered section in the program track.

Overwriting a Rendered Section

After rendering a section of a program, if tracks and special effects are 
added or the media in that section of the media tracks is changed, the 
rendering will need to be redone. When overwriting a rendered section, 
the media in the tracks being rendered is changed. The media on 
previously rendered tracks is still in a bin and still on the Finder level, 
but is no longer in the program track. 

To overwrite a rendered section:

1. Select the portion of the program to render.

See “Selecting Part of a Program” on page 70 for specific instruc-
tions.

2. Click the red Render button to the left of any track not to be 
included in the rendering process.

Radius EditDV Unplugged grays the Render button when a track is 
disabled for rendering. Click the Render button again to enable the 
track for rendering.

3. Choose one of the Overwrite options from the Program menu.

Choose Overwrite VP Track for a video render track, and Overwrite 
AP track for an audio render track. Choose Overwrite All Program 
Tracks if both are to be involved in the overwrite (or press Com-
mand-H).

4. The rendered section is overwritten to include any changes.

While rendering, the progress window is displayed and indicates the 
number of frames still needing to be rendered. The frames can be 
viewed as they are rendered in the display of the progress window. 
When rendering is completed, the section is automatically assigned 



Changing the Program Preferences
a new name and displayed on the program track. 

Rendering The Final Version Using Program Tracks

Program tracks are used to render the final version of a program. 

To render the final version using program tracks:

1. Choose Add AP track or Add VP track from Program Menu.

Be sure both VP and AP have been added to render a final program 
with audio.

2. Select all of the program that needs to be updated. This may be a 
small portion or the entire program, depending on how much 
you have rendered thus far.

Personal styles of using program tracks differ. You may wish to ren-
der small portions of your program as you work, or do a great deal 
of editing then render a large section of your program at one time.

3. Choose Overwrite All Program tracks to render everything in the 
selection and replace the program track.

Removing a Program Track

If a program track is no longer needed, it can be removed.

To remove a program track:

1. Click to select the program track to be removed. 

When a track is selected, there is a black border around it.

2. Choose Remove Track from the Sequencer menu.

The rendered clips remain on the hard drive and in their bin, but not 
in the sequencer. To clean up old render clips, click the Program bin 
in the Project window to make it the current bin, then select Clean 
Up Bin from the Edit menu. Unused clips will be removed from the 
Project window and associated files will be removed from disk.

Changing the Program Preferences
The media drive and render Mode settings can be changed through the 
Preferences submenu of the File menu. This can be used for rendering a 
selection or the entire program. 
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To change the media drive for rendering:

• Choose Media Drive from the Preferences submenu of the File 
menu. 

Choose the folder and drive from the list presented on the screen. 

To change the Mode for rendering for the program tracks:

• Choose Program Track from the Preferences submenu of the File 
menu.

Choose a rendering mode from the Mode pop-up. When using Ra-
dius EditDV Unplugged for video production the render mode 
should be set to Reference Clips. This mode allows complete clips to 
be quickly referenced when rendering.



Selecting Tracks for Editing
Chapter 5: Editing a Program

Radius EditDV Unplugged provides the video and audio tools for 
computer based nonlinear video editing. As you construct a program, 
work may be done in any order you choose. Sections of the program 
may be removed, clips rearranged and cuts repositioned. 

Radius EditDV Unplugged provides easily accessible tools to address the 
complex video production issues of synchronization, split edits, back-
timing, section replacement and speed changes to allow frame accurate 
modification of your program in the Sequencer window. 

Selecting Tracks for Editing 
The gold Patch buttons to the left of each track activate or deactivate the 
tracks for editing. Only active tracks will be affected by an edit. These 

buttons are used to keep a video track synchronized with its audio while 
not affecting background music or additional dialog tracks.

To deactivate a track on the Timeline:

• Click the gold Patch button to the left of the track. 

The Patch button is grayed when a track is inactive. To activate the 
track again, click the Patch button.

You can also activate and deactivate tracks from the Patch Matrix, 
see “Using the Patch Matrix to Place Clips in the Timeline” on 
page 65

Use the Patch
buttons to activate

or deactivate a
track for editing
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Adding Filler to the Timeline
Blank space, called filler, can be added to the Timeline. Filler creates 
space for clips to be added later, or can be used to hold a location to 
maintain the length of a program. It can also be used to move an entire 
section of a track or tracks later in time to synchronize them with 
another track, such as a particular section of music.

To insert filler on the Timeline:

1. Position the Timeline cursor where filler is to be added.

2. Deactivate any tracks where you do not want filler added. Click 
the gold Patch button to the left of a track to deactivate it. 

3. Choose Insert Filler from the Sequencer menu.

You see the Insert Filler dialog box.

4. To specify the amount of filler, select the appropriate numbers in 
the Filler Length area and type the duration desired.

The Insert Filler dialog box is preset to add one second of filler space 
and remembers the amount you last specified. The duration is spec-
ified as a SMPTE time code represented as four number hours:min-
utes:seconds:frames.

5. Click Insert.

The filler is inserted at the position of the Timeline cursor in all ac-
tive tracks. Filler is placed at the location of the Timeline cursor, any 
In and Out points in the program are ignored. 

The timecode at 
the Timeline 
cursor position

Type length of 
filler space here
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Removing Part of a Program
Media in a track may be removed in one of two ways. If the clip or 
segment is Erased, filler is left in place of the segment and the overall 
length of the program remains unchanged. This is similar to erasing a 
portion of a tape and leaving that portion blank. If the clip or segment is 
Eliminated, all clips to the right of the removed section are moved left 
in the timeline to earlier times. In the this case the length of the 
program is reduced by the duration of the removed segment. The effect 
is similar to cutting out a section of film and splicing the remaining 
sections together.

To erase part of a program and leave filler: 

1. Select the segment of the program to be removed.

Mark in and out points in the program to define your selection. The 
gold selection bar is drawn over the section that will be removed. See 
“Selecting Part of a Program” on page 70 for specific directions.

Note:  The selection may be defined in either the Program monitor 
or the Sequencer, these both refer to the same Program at all times.

2. Activate only the tracks where you want to erase your program.

A track is active when the Patch button to the left of it is gold, inac-
tive when the button is gray. Click the Patch button to activate or 
deactivate the track.

Note:  All active tracks, including audio, video, VP and AP will be 
affected by the Erase command.

3. Click the Erase button in the control ribbon of the Sequencer 
window.
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When the Erase button is clicked, the selected section of each acti-
vated track in the Timeline in the Sequencer window is removed. 
Filler is left in its place. 

To remove part of a program and leave no filler space:

1. Select the portion of the program to be removed.

See “Selecting Part of a Program” on page 70 for specific directions.

2. Activate only the tracks to be changed.

To remove clips or segments of a clip from a video track that is syn-
chronized with an audio track, leave both tracks active to keep them 
synchronized. 

3. Click the Eliminate button in the control ribbon of the 
Sequencer window.

When the Eliminate button is clicked, Radius EditDV Unplugged 
removes the selected section of each active track in the Timeline and 
shortens those tracks to close the space occupied by it. The segment 
of the program following the deleted segment is shifted to the left 
and the overall program is shortened by the duration of the removed 
section.

Erase buttonEliminate button

Filler
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Editing Clips
There are multiple ways to edit clips once they are in your program, 
depending on how you want the overall length of the program effected. 
The following sections describe 3 and 4 point edits, trimming and 
synchronization while editing. 

Using a 3-Point Edit
Creating high quality video programs constantly presents a variety of 
editing challenges. At times, space in a program must be filled by 
adjusting the length of a clip, or clips. At other times it will be 
important to preserve the length of a clip or use a specific In and Out 
point in a clip. In these cases, professionals have developed a technique 
called 3-point editing. 

This technique allows you as editor to define three of the four mark 
points used to create an edit: In and Out point in the source clip and In 
and Out point in the Program. Once three points are defined EditDV 
Unplugged calculates the 4th and executes the edit. The three-point 
editing process is a powerful method for solving complex editing 
problems. For example, by marking In and Out points in your Program 
and one point in your Source clip you can fill in a segment of a 
predefined duration. The following section describes in detail how to 
use the power of 3-point editing for modifying your program.

To use a 3-point edit to fill a specific amount of space on the 
Timeline:

1. In either the Sequencer or Program monitor set the In and Out 
points over the space to be filled.

Radius EditDV Unplugged also provides a “Mark In, Mark Out” but-
ton that will automatically mark the in and out points of a selected 
clip or filter.

2. In the Source monitor, set the point that is most important. 

Set the In point if you want the clip to begin at a specific frame. Set 
the Out point if you want the clip to end at a specific frame.

Note:  Setting only an Out point in the source clip and letting 
EditDV Unplugged use as much of the source clip as necessary is 
referred to as Back-timing.
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3. In the Patch Matrix in the Monitors window, map the clip to the 
desired Sequencer tracks.

Make sure the Sequencer tracks are active for editing. When a Se-
quencer track is active, the Patch button for the track in the Patch 
Matrix and in the Sequencer window is gold.

4. Click the Insert or Overwrite button.

If Insert is selected, the clips in the Timeline are moved to make 
room for the new clip. If Overwrite is selected, the new clip will be 
placed exactly over the section as marked by the In and Out points. 

5. Click the Edit button.

The edit is executed on the Timeline. As much of the Source clip as 
necessary will be used to fill the space marked in the Sequencer.

To insert a clip of a specific length:

1. In the Source monitor, set the In and Out points for the clip.

2. In the Sequencer, set an In or Out point at the position where 
the clip is to be placed. 

Set an In point if the starting place for the clip in the Timeline is the 
most critical point. If having the clip end at a specific point in your 
program is more important, set an Out point on the Timeline. 

Note:  If no points are marked in the Sequencer, the Timeline 
cursor will be used as the insertion point.

3. In the Patch Matrix in the Monitors window, make sure the clip 
is mapped to the appropriate Sequencer tracks. 

The Sequencer tracks must be active for editing. 

4. Click the Insert or Overwrite button.

If Insert is selected, Radius EditDV Unplugged moves clips in every 
active track in the Timeline to make room for the clip. If Overwrite 
is selected, Radius EditDV Unplugged places the new clip over as 
much of the Timeline as necessary. 

5. Click the Edit button to execute the edit. 
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Using a 4-Point Edit
A 4-point edit can be used when a specific clip must fill a precise 
amount of space on the Timeline. In this case the playback speed of the 
Source clip is changed to achieve the fit.

To create a 4-point edit:

1. In the Sequencer, set the In and Out points for the space to be 
filled on the Timeline.

2. In the Source monitor, set the In and Out points for the clip.

3. In the Patch Matrix in the Monitors window, map the clip to the 
Sequencer track.

4. Choose Fit to Fill from the Edit menu, or press Command-F.

Radius EditDV Unplugged speeds up or slows down the clip as nec-
essary to make it fit into the designated space in the Timeline. Fit to 
Fill is always an overwrite edit so any media on the track within the 
in and out points will be overwritten.

Note:  Some playback speeds will not result in smooth motion. In 
those cases, try changing the length of either the Source clip or the 
section to be filled and repeating the Fit to Fill.

Force an Edit
Inserting a cut (force an edit) may be necessary at a point in a clip where 
there is currently none. For example, you might insert a cut in a clip so 
that part of a clip can be moved to another position in the Timeline. 

To force an edit:

1. Move the Timeline cursor to the position in the clip where the 
cut is to be made. 

2. Activate only the tracks that you want to cut.

The Patch button to the left of the track is gold when the track is ac-
tive.

3. Choose Force Edit from the Sequencer menu, or press 
Command-Slash (/).

A cut is created at the location of the Timeline cursor in the active 
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tracks. Any FX track(s) associated with the newly edited clip will be 
cut off to the right of the new cut point. 

You see two clips with the same name in the Sequencer. 

Changing the Speed of a Clip
The Speed command in the Sequencer menu can change the speed of a 
clip in a program, reverse the direction of a clip, and freeze the frame at 
the In point for a clip.

To change the speed of a clip:

1. Click the clip on the Timeline to select it.

Forced edit



Editing Clips
2. Choose Speed from the Sequencer menu.

The Speed dialog box appears.

3. Choose the new speed from the Speed pop-up in the New 
Settings area of the dialog box, or Type in a new duration.

When a speed is selected, the length of the reference clip is adjusted 
to accommodate that speed.

Note:  Due to the fixed frame rate and interlaced field nature of 
video some speed changes play more smoothly than others. 
Whenever possible, use the preset speed changes in the Speed pop-
up for best playback.

4. Click OK to set the new playback speed.

5. The selected speed is shown in the clip on the Timeline.

The Program monitor will be black whenever a clip with a changed 
speed setting is played until the program track has been updated.

Reversing the Direction of a Clip

To reverse the direction of a clip, use the Speed dialog box.

To reverse the direction of a clip:

1. In the Timeline, select the clip to be reversed.
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2. Choose Speed from the Sequencer menu.

3. In the Speed dialog box, click the Reverse Clip checkbox and 
click OK.

The clip’s speed is indicated as a negative number, indicating that it 
will play backwards after it has been rendered.

Freezing a Frame

Selecting the Freeze Frame option in the Speed dialog box freezes the 
frame at the In point of the clip for the duration of that clip.

To freeze the frame at a clip’s In point:

1. Click the clip in the Timeline to select it. The frame at the In 
Point of the selected clip is the frame that will freeze. 

To freeze a frame other than at the In point, use Force Edit as de-
scribed in the previous section to create a new In point, then Freeze 
the resulting clip.

2. Choose Speed from the Sequencer menu.

3. In the Speed dialog box, click the Freeze Frame checkbox and 
click OK.

Synchronizing Clips
When a clip that contains both video and audio is placed in the 
Sequencer, Radius EditDV Unplugged places the video and the audio at 
the same position in the Timeline. The audio and video in clips 
captured with MotoDV are synchronized when they are captured. As 
clips are manipulated, it is possible for the video and audio to get out of 
sync if one is moved by an edit and the other is not. Radius EditDV 
Unplugged will display clip sync information to aid you in maintaining 
synchronization between picture and audio.
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To display clip sync information in a project:

1. Choose Preferences from the File menu and Sequencer Window 
from the submenu.

The Sequencer Preferences dialog box appears.

2. Select Show Clip Sync option and click OK.

A number is displayed in the audio track Timeline of each clip. The 
number indicates whether the clip is out of sync with its video coun-
terpart and if so, by how many frames, and in which direction. A 
plus or minus sign precedes each number to indicate whether the au-
dio occurs late or early relative to the video. 

To hide the clip sync information from the Timeline, open the 
Sequencer Preferences dialog box and uncheck the Show Clip Sync 
option. 

This audio clip starts 9 frames 
later than its video counterpart
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The Show Clip Sync option can also be activated by using the 
Sequencer menu.

To turn clip sync on and off: 

1. Choose Show Clip Sync from the Sequencer menu. 

Show Clip Sync becomes Hide Clip Sync on the Sequencer menu. 

2. To turn clip sync off, choose Hide Clip Sync.

As long as the clips share some common point in the Timeline, Radius 
EditDV Unplugged reports how many frames they are out of sync. If the 
clips become completely removed from each other and share no 
common point, they effectively become detached and are not reported 
as out of sync.

Finding a Source Frame from a Program
To find the location in the source clip of a specific frame in a program, 
use the Find Frame command on the Sequencer menu. You can use 
Find Frame to quickly locate a source clip that you would like to re-use 
in the Sequence.

To find a specific frame in a program:

1. In the Sequencer, click on the clip containing the frame you 
want to find. 

The clip is displayed with a black border around it. 

2. Drag the Timeline cursor to the timecode for the frame you want 
to find.

The timecode display in the Sequencer window indicates the exact 
position of the Timeline cursor. It can be used to position the cursor 
precisely at a frame.

If the track containing the clip is the visible track, the frame is seen 
in the Program monitor. Click on the eye icon to the left of the track 
to make it the visible track. 

3. Choose Find Frame from the Sequencer menu.

The clip currently in the Source monitor is replaced by the source 
clip containing the selected frame. The Source monitor cursor is po-
sitioned to match the frame in the Program under the Timeline cur-
sor. 
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Trimming Cuts
The Trim window is used to adjust cut points and modify clips after they 
have been placed in your Program. It allows you to view cuts as if they 
represented splice points between two pieces of film. The left display 
shows the last frame of the outgoing clip and the right display shows the 
first frame of the incoming clip. Using the Trim window, the cut points 
of two adjacent clips can be adjusted in several ways. A single cut point 
can be edited by itself, or multiple cuts, including audio can be edited 
simultaneously. You can:

• adjust the end (outpoint) of the outgoing clip, changing the overall 
length of the program. This removes frames from or adds frames to 
the clip on the left, then resplices the remaining clip back onto the 
unchanged one on the right.

• adjust the beginning (inpoint) of the incoming clip, changing the 
overall length of the program. This changes the clip on the right and 
resplices the result to the unchanged clip on the left.

• adjust the end of the outgoing clip and beginning of the incoming 
clip (shortening one while simultaneously extending the other) so 
that the program length remains the same. This is called a roll edit 
and consists of adding frames to one clip while simultaneously 
removing them from the other.

• maintain synchronization by trimming multiple audio and video 
cuts together.

• create split edits (L and J-cuts) by trimming video or audio cuts 
independently.

Note: In all cases the frames that are added or removed are from the 
original Source clip. When there are no more frames available in that 
clip, no more can be added. Also, Trimming can also be used at the 
splice point between filler and a Source clip, so the filler can be trimmed 
as if it were an independent Source clip.
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 To use the Trim window to edit cuts:

1. All tracks to be trimmed must be active in the Sequencer.

The Patch button to the left of active tracks is gold.

Trim button
Previous Trim button
Next Trim button



Editing Clips
2. Position the Timeline cursor at the cut and press the Trim 
monitor button or press F15.

Or, use the Previous Trim or Next Trim button to easily move to the 
exact position of a cut. 

Icons indicate
cuts being

trimmed

Indicates tracks 
being trimmed

Shows media 
available beyond 
outpoint, constrained 
by shortest clip

Trim Frame box

Next and Previous 
Trim buttons
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3. Click the Trim button in the control ribbon of the Sequencer 
window.

Cuts in all active tracks at the location of the Timeline cursor are se-
lected for trimming. The trim cursor will be displayed over each se-
lected cut. The Trim window replaces the Monitors window. It 
displays the cut on the track with the eye icon on, and a list of the 
tracks involved in the trim.

Once the Trim monitor is displayed, you can select other cuts to 
trim by clicking on the cut in the Sequencer, or shift-clicking to se-
lect multiple cuts. You can also deselect a cut that you do not want 
to trim by shift-clicking it in the Sequencer.

The slider bars in the Trim window graphically depict the amount the 
currently selected clips can be lengthened or shortened. 

The following sections describe the different ways the Trim window can 
be used for editing.

Shortening or Lengthening the Outgoing or Incoming Clip

The outgoing clip can be shortened or lengthened at the cut without 
affecting the incoming clip, and vice versa, but doing so will affect the 
overall length of a program.

Next Trim
Previous Trim

Play Trim

Trim Both

Frames to
play before

and after trim Trim IncomingTrim Outgoing

List of all 
tracks being 
trimmed

Outgoing Clip Incoming Clip
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Note: Clips can be eliminated by trimming them to zero length using 
the trim buttons or by entering a number of frames directly. Clips will 
not be eliminated while dragging with the mouse.

Note: Any transitions applied to trimmed cut points will move 
appropriately with the trim.

To shorten or lengthen the outgoing clip:

1. Click the Trim Outgoing button in the Trim window or press F9.

The Sequencer track containing the clip must be active and visible, 
the Patch button and eye icon to the left of it gold.

Note:  You can also Trim Outgoing with the mouse by clicking on 
the picture in the left trim frame and dragging left to shorten the 
Outgoing clip, and right to lengthen it, without first selecting the 
Trim Outgoing button. The cursor displays an icon indicating that 
you are trimming the Outgoing clip whenever the mouse is over the 
outgoing frame. When you press the mouse button down to begin 
trimming, the Trim Outgoing button will be selected automatically.

2. Clicking the arrow buttons pointing to the left will shorten the 
outgoing clip, either one or ten frames. Clicking the arrow 
buttons pointing to the right will lengthen the outgoing clip, 
either one or ten frames.

Function keys F5-F8 mirror the action of the four trim buttons.

Or, you can enter a number of frames in the left Trim Frame box. 
This text box indicates the change in the clip since you began the 
trim. Negative numbers trim to the left and shorten the clip, positive 
numbers trim to the right and lengthen the clip.

Note:  Your overall program length will change by the amount you 
have trimmed the Outgoing clip. 

3. The end of the clip shifts in the Trim window and in the 
Sequencer. The Incoming clip remains unchanged.

The left text box in the center of the Trim window displays the total 
number of frames added to or subtracted from (indicated by a num-
ber with a plus or minus sign) the outgoing clip. 

4. When the cut is in the desired position, click the Play Trim 
button to review it.

A player window replaces the Trim window and plays the cut. The 
movie will stop if you press the space bar while it is playing. After the 
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movie plays once, you are returned to the trim window. Click Op-
tion-Play Trim to play the clip out through FireWire using the DV 
Player. 

Note:  You can also set the “Play frames out FireWire” in SoftDV 
Playback preferences to play full screen at all times.

To shorten or lengthen the incoming clip:

1. Click the Trim Incoming button in the Trim window or press 
F11.

The Sequencer track containing the clip must be active, the eye icon 
and patch button gold.

Note:  You can also Trim Incoming with the mouse by clicking on 
the picture in the right trim frame and dragging left to lengthen the 
incoming clip, and right to shorten it, without first selecting the 
Trim Incoming button. The cursor displays an icon indicating that 
you are trimming the Incoming clip.

2. Clicking the arrow buttons pointing to the left will lengthen the 
incoming clip, either one or ten frames. Clicking the arrow 
buttons pointing to the right will shorten the incoming clip, 
either one or ten frames.

Function keys F5-F8 mirror the action of the four trim buttons.

Negative numbers always move the mark point to the left, i.e. to ear-
lier times in your program. Positive numbers always move the mark 
point to the right.

3. The end of the clip shifts in the Trim window and in the 
Sequencer. The Incoming clip remains unchanged.

4. When the cut is in the desired position, click the Play Trim 
button to review it.

A player window replaces the Trim window and plays the cut. Use 
the space bar to toggle between playing and stopping play. After the 
movie plays once, you are returned to the trim window.

The right text box in the center of the Trim window displays the 
number of frames added to or subtracted from (indicated by a num-
ber with a minus or plus sign) the incoming clip. Moving the mark 
point to the right results in a positive trim number, which shortens 
the Incoming clip. Moving the mark point to the left results in a neg-
ative number, which lengthens the Incoming clip.



Editing Clips
Trimming Both Clips

Trimming both the outgoing and incoming clips at a cut allows one to 
be shortened while at the same time lengthening the other. This 
maintains the overall length of a program and is called a roll edit. 

To trim both outgoing and incoming clips:

1. Click the Trim Both button in the Trim window or press F10.

The eye icon to the left of the Sequencer track should be active, or 
gold. The Patch button must also be gold to make the track active 
for editing. 

Note:  You can also Trim Both clips with the mouse by clicking on 
the picture between the two frames. The outgoing and incoming 
clips will both be adjusted as you drag left and right. The cursor 
displays an icon indicating that you are trimming both the 
Outgoing and the Incoming clips.

2. Click one of the arrow buttons above the Trim buttons, to move 
the cut in the direction of the arrow, either one frame or ten 
frames.

Function keys F5-F8 mirror the action of the four trim buttons.

The end of the outgoing clip and the beginning of the incoming clip 
will shift in the Trim window and in the Sequencer window. The di-
rection and the duration of the shift depends on the arrow you click. 

3. When the cut is in the desired position, click the Play Trim 
button to review it. 

A player window replaces the Trim window and plays the cut. Use 
the space bar to toggle between playing and stopping play. After the 
movie plays once, you are returned to the trim window.

Note:  To move to a cut or trim point adjacent to the one showing 
in the Trim window, use the move to Previous Trim and Next Trim 
buttons in the Sequencer.

Note:  To return to the Source/Program monitor click on the 
Monitors button in the Sequencer or press F13.
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Trimming Multiple Tracks - Trimming Audio and Video 

Simultaneously

Multiple Audio and Video tracks in the Sequencer can be trimmed at 
the same time. The tracks to be edited must be active with the Patch 
buttons to the left of the tracks gold.

To trim multiple tracks: 

• Click the Trim button in the Sequencer. All cuts that are aligned 
with the Timeline cursor will be selected. Thus, if video and audio 
tracks are both active, they will both be selected and video and audio 
will be trimmed together. 

If you want to trim cuts that are not aligned, such as in adjusting a
cut, press and hold the Shift key while clicking each track at the cu
be trimmed. Only one cut may be selected for trimming in each tra

The slider bar in the Trim window indicates the length of the short-
est clip in the tracks being trimmed. This limits trim to only as much 
media as the shortest clip provides.

Split Edits: L-Cuts and J-Cuts

A split edit is typically used when the editor wants to smooth a 
transition from one clip to another. If audio and video in a clip are cut 
at precisely the same spot, the cut may be too noticeable and abrupt. An 
editor can create a split edit to reduce the abruptness of the cut by 
moving the audio cut point a few frames away from the video cut point. 
The incoming clips audio can begin before its video (a J-cut), or vice-
versa (an L-cut).

To start playing one synchronized clip before or after another, the Trim 
window can be used to create a split edit. To establish a split edit the 
video and audio tracks must be adjusted independently of each other.

To establish a split edit do one of the following:

• Make either the audio or video track inactive by clicking the gold 
patch button to the left of the track so that it is grayed out. Trim the 
other track by placing the Timeline cursor at the cut point and 
clicking the Trim button in the Sequencer.

• Select both the video and audio tracks to be trimmed by placing the 
Timeline cursor at the cut and clicking the Trim button. Then shift-
click either track to deselect it for trimming.



Editing Clips
In the Trim window, adjust the cut point of the selected track. The audio 
and video will no longer cut at the same time, but will remain 
synchronized wherever they play together.

Changing the Number of Frames Played

Radius EditDV Unplugged is preset to play 90 frames (3 seconds) before 
and after a cut when you use the Play Trim button. The number of 
frames can be changed in the Trim window.

• Type a number of frames desired in the text box below the Outgoing 
Trim window on the left.

The next time you click the Play Trim button in the Trim window, 
Radius EditDV Unplugged will play the new number of frames typed in, 
before and after the cut point.
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Applying Radius EditDV Unplugged Transitions
Chapter 6: Using Transitions Between 
Clips

The most common transition between clips in a program is a cut. A cut 
is the instantaneous switch from one clip to another. When you are 
creating a program, however, you may want some of your transitions to 
be different than a straight cut. You can use them to help define flow, 
feeling and pacing in your program. Radius EditDV Unplugged 
transitions provide you with a wide variety of controls and the option of 
creating custom transitions. With them, your program can move 
smoothly from one clip to the next.

Applying Radius EditDV Unplugged Transitions
The Cross Fade Audio, Dissolve, Iris, Radial Wipe, and Wipe (including 
Barn Door, Venetian Blind, and Band Wipe) transitions are easy to apply 
to a program. You can also use transition controls to vary the 
appearance of a transition to achieve pushes, pulls and zoom effects, 
based on the standard transitions provided in Radius EditDV 
Unplugged. In addition, many transitions support the addition of 
colored borders and softness settings.

Applying a Transition to Your Program
To apply a transition:

1. Choose Show Effects Window from the Window menu, or press 
Command-1.

You see the Effects window. 
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2. Click Transitions in the left column of the window.

You see the list of standard Radius EditDV Unplugged transitions in 
the right column.

3. Select a transition and drag it over the cut between two clips in 
the Sequencer. When you see the insertion cursor, release the 
mouse button to apply the transition. 

The transition is seen as a gold strip with a black border. The name 
of the transition appears in the gold strip.

Note:  All transitions except Cross Fade Audio are placed in video 
tracks and cannot be used in audio tracks. Cross Fade Audio can 
only be placed at a cut in an audio track.

Changing the Duration and Cut Point
After adding a transition to your program, you can change its duration 
and where it occurs relative to the cut point. 



Applying Radius EditDV Unplugged Transitions
To change the duration of a transition and the cut point 
position: 

1. Click the transition on the Timeline in the Sequencer window to 
select it. 

You see a black border around the selected transition.

2. Choose Transition Settings from the Sequencer menu. Or, press 
Option and double-click on the transition.

You see the Transition Settings dialog box.

3. Enter the number of frames to be used as the length of the 
transition in Transition Duration.

The preset number is 30, which is one second of video. The mini-
mum number of frames that can be used is 3. The maximum number 
is either 300 frames or the shorter of the two clips involved in the 
transition.

Cut point between clips 
without transition

Cut point between 
clips with transition

Selected transition

Program 
selection
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Note:  The clips involved in a transition use frames beyond the 
marked In and Out points to accommodate the duration of the 
transition. 

Note:  When a source clip does not contain enough frames to 
accommodate the transition, Radius EditDV Unplugged freezes the 
first or last frame of that clip, depending on whether it is the 
incoming or outgoing clip. To eliminate this freeze frame you can 
shorten the transition, change the cut point of the transition or 
change the In or Out point of the source clips. Freeze frames in 
transitions are indicated by a red bar at the end of the clip when the 
transition view is expanded in the Sequencer window.

4. Choose a position for the cut point between the clips from the 
Cut Point pop-up. 

The preset position is Center. To use a position different from the 
preset, use the pop-up, or enter a number of frames for the position 
of the cut point relative to the beginning of the transition.

5. Click OK.

The transition length is adjusted to the new setting. Its location is up-
dated in the Sequencer window according to the settings entered in 
the Transition Settings dialog box. 

Viewing Transitions in Expanded View
To see exactly how a transition is positioned in relation to its clips, you 
can expand its display in a program track.



Applying Radius EditDV Unplugged Transitions
For example, if your primary video track looks like the following:

Expand the track by clicking the blue triangle to the right of the track’s 
eye buttons. The track unfolds to an A/B roll style display to show the 
overlap between the clips and the transition. 

Previewing a Transition
There are several ways for you to preview your transition. When a 
transition is selected in a track, the Program monitor in the Monitors 
window switches to the FX monitor. You can switch between using the 

Click here 
to expand 
the track

Track 1
expanded

Freeze frame of incoming clip 
will be created for the Dissolve

Transition cut point is 
located at the center
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FX monitor and the Program monitor by using the buttons at the left 
end of the control ribbon in the Sequencer window, or their keyboard 
equivalents (F13 and F14). 

You can preview a transition or review an animation of a transition to 
preview it in the FX monitor. 

To preview a transition:

• You can see a preview of a transition by dragging the Timeline cursor 
through it while it is selected in the Sequencer. The transition is 
previewed on one frame from each clip to allow you to review the 
transition without waiting for a render.

FX Monitor

Program
monitor

button

FX monitor
button

Snapshot button
Animate button

Mark Selection button

Zoom button



Applying Radius EditDV Unplugged Transitions
Note:  Hold the control key while dragging to disable the snap-to 
feature of the Sequencer, which may interfere with previewing short 
transitions. Zoom the Sequencer if necessary to display enough 
frames to allow for dragging. The left and right arrow keys can also 
be used to move conveniently through a transition.

To review an animation of a transition:

• Click the transition in the Timeline and click the Animate button in 
the control ribbon of the Sequencer window, choose Animate from 
the Sequencer menu, or press Command-L, to animate a transition.

You see an animation of any movement in the transition in the FX 
monitor on still frames from the two clips. Since the animation re-
turns to the location of the Timeline cursor, it is recommended that 
you place the Timeline at the end of the transition before animating. 

You can also take a snapshot of a single frame from your program, at 
final quality, with the transition applied to that frame.

Note: A snapshot renders all enabled tracks, not just the transition. A 
Snapshot is useful to review how the transition will look in your final 
program.

To get a snapshot of one frame at final quality:

1. In the Sequencer, move the Timeline cursor to the desired 
frame.

2. Click the Snapshot button in the control ribbon of the 
Sequencer window, choose Snapshot from the Sequencer menu, 
or press Command-K.

To see the full effect of a transition at final quality:

• Click the transition in the Timeline of the Sequencer to select it, 
hold down Shift, and drag the Timeline cursor through the 
transition. You see the clip and the transition play in the FX monitor 
at final quality as quickly as your computer can render it a frame at 
a time.

Note:  To eliminate snap to grid in the Sequencer window, hold 
down the ctrl key while dragging. For short transitions you may 
want to Zoom in the Sequencer so that you can drag to each frame 
of your transition.
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• To preview your transition at final or draft quality in the context of 
your program, update the Program track to include the transition, 
then play the Program track. To quickly select the region of the 
Timeline that must be updated, first ensure that the transition is 
selected, then click the mark selection button in the lower left hand 
corner of the Sequencer window and choose Overwrite Program 
Track from the Program menu. For more information on using the 
Program track to review your final program, see “Using Program 
Tracks” on page 79 for details.

Removing a Transition
If you decide you don’t want to use a transition after dragging it into 
your program, you can remove it.

To remove a transition from a program:

• Click the transition to select it and press the delete key. 

Modifying Transitions
The controls provided for each Radius EditDV Unplugged transition let 
you modify how the transition works. 

To use transition controls:

1. Double-click a transition in the Timeline or, if the transition is 
already selected, press Command-2.

2. Choose the settings you want to use in the Controls window.

The selected settings take effect immediately.

3. Click the Close button in the upper-left corner of the Controls 
window to close it.

The following sections describe each of the Radius EditDV Unplugged 
transitions. 



Modifying Transitions
Using the Cross Fade Audio Transition
The Cross Fade Audio transition fades out the end of one audio clip 
while fading in the beginning of the next. After applying the transition, 
you can change its duration and its relation to the cut point. When you 
double click on a clip in an audio track, the Radius EditDV Unplugged 
Controls window displays controls that apply to that entire track, and 
the individual clip. 

Using the Dissolve Transition
A Dissolve transition blends the end of the outgoing clip and the 
beginning of the incoming clip. It can also fade the end of the outgoing 
clip to a selected color, and fade in from that color to the beginning of 
the incoming clip.

When you apply the Dissolve transition and open the Controls window, 
you see the Dissolve page. 

To use a Dissolve to Color transition:

1. With the Dissolve transition applied to a cut in the Timeline, 
open the Controls window by double-clicking or pressing 
Command-2.

2. Click the Dissolve to Color checkbox.

Returns Dissolve
page to the

preset values

Click here to use
a Dissolve to

Color transition
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3. Hold the mouse button down over the Color box in the 
Controls window to display the Radius EditDV Unplugged color 
palette.

The pointer changes to an eyedropper.

4. Drag the eyedropper to the color you want to use.

If you want to match a color in your video, drag the eyedropper over 
the color in the Monitors window.

5. Release the mouse button. 

The eyedropper picks up the selected color, displays it in the color 
box, and uses it for the Dissolve to Color transition.

Note:  At the center point of the transition the frame will be entirely 
filled with the selected color, regardless of the transition cut point.



Modifying Transitions
Note: You can use the Apple Color Picker to choose a color for your 
Dissolve to Color transition by clicking in the Color box.

Using the Iris Transition
An Iris transition opens the beginning of the incoming clip over the top 
of the outgoing clip. 

Some Apple Color Picker Options
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Choosing a Shape for the Iris

The Iris is preset to open as a circle. You can change the shape of the Iris 
to an oval, a square, or a rectangle. 

To change the shape of the Iris:

• Choose the shape you want to use from the Shape pop-up on the 
Transitions page.

Reversing the Iris Transition

When you reverse an Iris transition, the outgoing clip in the Iris closes, 
revealing the beginning of the incoming clip. 

To reverse the Iris transition: 

• Click the Reverse button on the Transitions page.

Selecting a Softness Setting

The Iris is preset to have a distinct edge separating it from the clip 
behind it. You can use the Softness control on the Transitions page to 
change the softness setting and blur the edges of the Iris. 

Returns
Transitions
page to the

preset values

Choose a
shape

Use to soften
the edges of

the iris
Click here 
to create a 
zoom effect

Click here to 
reverse the 
movement 
of the iris

Click to open
Border page



Modifying Transitions
To select a softness setting for the Iris: 

• Drag the slider on the Softness control to the desired setting.

As you drag the slider, you see the number in the Softness box 
change. You can also type the new setting number into the Softness 
box.

Edges are softened more at higher softness settings. The result of the 
Softness setting is previewed in the FX monitor.

Zooming the Iris In or Out

Normally the Iris opens or closes to reveal the incoming clip. By using 
the Zoom button on the Transitions page, you can zoom in or zoom 
out the incoming clip over the outgoing clip within the selected Iris.

To zoom the Iris in:

• Click the Zoom button on the Transitions page.

Use the Reverse button with the Zoom button and you can zoom 
out the outgoing clip in the transition to reveal the incoming clip.

Using a Border With an Iris Transition

You can add a border of a selected color and thickness to the Iris. If you 
are using a Softness setting that blurs the edges of the Iris, it also blurs 
the border.
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To create a border for an iris transition:

1. Click the Border tab at the top of the Controls window.

You see the Border page for the transition.

2. Click the Border check box.

To choose a thickness for a border:

• Drag the slider on the Thickness control to the desired setting.

You can also type the new setting number into the Thickness box. 
The smaller the setting, the narrower the border; the larger the set-
ting, the wider the border.

To choose a color for a border:

1. Click the Color box on the Border page and hold the mouse 
button down to display the Radius EditDV Unplugged color 
palette.

The pointer changes into an eyedropper.

2. Drag the eyedropper to the color you want to use.

Or, if you want to match a color in your video, drag the eyedropper 
over the color in the monitors window.

3. Release the mouse button. 

The eyedropper picks up the selected color, displays it in the color 
box, and uses it for the border.

Note:  You can use the Apple color picker when choosing a color for 
your border by clicking in the Color box.

Check to add
a border

Set border
Thickness

Set the
border color



Modifying Transitions
Using the Radial Wipe Transition
A Radial Wipe transition sweeps away the end of a clip with a circular 
or semi-circular motion, revealing the beginning of the next clip. 

When you apply the Radial Wipe transition and open the Controls 
window, you see the Radial Wipe page. 

Like the Iris transition, the Radial Wipe transition provides a Softness 
control that you can use to blur the edges of the Radial Wipe. For 
specific instructions about selecting a softness setting see “Selecting a 
Softness Setting” on page 120. 

Choosing a Position for a Radial Wipe

A Radial Wipe is preset to wipe away the current clip in a circular 
motion with the center of the wipe positioned in the center of the clip, 
like the hands of a clock. You can change the Position setting from the 
center of the clip to one of the four corners.

To choose the center of rotation position for a Radial Wipe: 

• Choose the center of rotation position from the Position pop-up.

Returns Radial 
Wipe page to the 
preset values

Click here to reverse the 
movement of the radial wipe

Choose a start 
position for the 
radial wipe

Use to soften the 
edges of the 
radial wipe

Choose a start 
angle for the 
radial wipe 
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Choosing a Start Angle for a Radial Wipe

When you use the Center start position for a Radial Wipe, you can also 
choose the start angle for the wipe. The preset start angle begins the wipe 
at the 3:00 o’clock position.

To change the start angle for a Radial Wipe:

• Drag the pointer on the Start Angle dial to the position where you 
want the wipe to start.

As you drag the pointer, you can see the numbers in the Start Angle 
box change, as well as the angle on the FX monitor. You can also 
type the angle in degrees in the text box.

Reversing a Radial Wipe Transition

When you reverse a Radial Wipe transition, you reverse the direction of 
the current Radial Wipe setting. For example, if you reverse a Radial 
Wipe using the Center position and the preset start angle, the direction 
of the wipe reverses to move counterclockwise. 

To reverse a Radial Wipe transition: 

• Click the Reverse button in the Controls window.

Using the Wipe Transitions
A Wipe transition wipes away the end of a clip with a linear motion, 
revealing the beginning of the next clip underneath. Radius EditDV 
Unplugged provides several different types of Wipe transitions. 

Like the Iris transition, the Wipe transitions let you blur the edges of a 
wipe and create a border for it. For specific instructions about selecting a 
softness setting and creating a border, see “Selecting a Softness Setting” 
on page 120 and “Using a Border With Wipe Transitions” on page 127. 

When you apply the Wipe transition and open the Controls window, 
you see the Wipe page.



Modifying Transitions
Choosing a Type of Wipe

You can choose from four different types of Wipes: Wipe, Barn Door, 
Venetian Blind, and Band Wipe. The Wipe is preset and sweeps away the 
current clip horizontally, from left to right, to reveal the incoming clip.

The other types of wipes work as follows, if used with the preset settings 
on the Transitions page:

• A Barn Door wipe shows the first frame of the incoming clip, as if it 
were a barn door, closing over the last frame of the outgoing clip.

• A Venetian Blind wipe displays the outgoing clip in strips over the 
incoming clip. The strips gradually open like a Venetian blind during 
the transition, revealing the incoming clip.

• A Band Wipe gradually moves the incoming clip, displayed in 
alternating bands, from both the left and right side of the clip. The 
bands eventually reach the opposite side of the clip and completely 
cover the outgoing clip. 

Returns 
Transitions 
page to the 
preset settings

Use to soften 
the edges of 
the wipe

Click here to 
reverse the 
movement of 
the wipe

Choose a
Wipe type

Click here to open 
the Border page

Use this
control for
Venetian
Blinds or

Band Wipes

Choose a
direction Use to move 

one or both 
clips
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Determining the Direction of a Wipe

Radius EditDV Unplugged is preset to create a horizontal wipe by 
default. You can change the Direction setting to create a vertical wipe.

To change the Direction setting: 

• Choose Vertical from the Direction popup on the Transitions page. 

Reversing a Wipe Transition

When you reverse a Wipe transition, you reverse the direction of the 
current wipe setting. For example, if you reverse a horizontal Barn Door 
wipe, the last frame of an outgoing clip opens outward from the center, 
as if it were a barn door opening, revealing the first frame of the 
incoming clip.

To reverse a Wipe transition: 

• Click the Reverse button on the Transitions page.

Using the Width Control 

You can use the Width control on the Transitions page to choose how 
wide or narrow Radius EditDV Unplugged makes the blinds used in a 
Venetian Blind wipe or the bands in a Band Wipe.

This control is
available only

when you select
a Venetian Blind

or Band Wipe



Creating Custom Transitions

 

 

 

To choose a width for venetian blinds or bands:

• Choose Wide, Medium, or Narrow from the Width pop-up.

Adding Motion to Transitions

Using the Move Outgoing and Move Incoming controls on the 
Transitions page, you can create what is sometimes called a DVE or 
Push/Pull transition. Instead of using one of the methods of wiping out 
the outgoing clip to reveal the incoming clip, or vice versa; you cause 
one or both of the clips to move. The following table describes how to 
use the Move Outgoing and Move Incoming controls. 

Note: The direction of movement of the clips in the above transitions 
depends on whether or not Reverse is checked.

Using a Border With Wipe Transitions

You can add a border of a selected color and thickness to a Wipe and a 
Barn Door wipe. Using a border with one of these Wipe transitions is 
the same as using a border with an Iris transition. For specific 
instructions for turning on a border and choosing a border thickness and 
color, see “Using a Border With an Iris Transition” on page 121.

Creating Custom Transitions
If you find that you are making the same changes to a transition over 
and over, you might want to save the settings as a new custom 
transition. When you save a custom transition, Radius EditDV 
Unplugged saves it in a folder in an effects bin under a name that you 
assign. You see a new transition document displayed in the Effects 
window with a special icon that designates it as a custom transition.

Click: To do the following:
Move Outgoing Move the outgoing clip in the transition aside, revealing the

incoming clip behind.

Move Incoming Move the incoming clip in the transition into view, covering
the outgoing clip.

Move Outgoing 
and Move 
Incoming

Move both clips until the outgoing clip gradually disappears
from view and the incoming clip gradually replaces it.
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 You can drag custom transitions into your programs just as you do the 
other Radius EditDV Unplugged transitions.

To create a custom transition:

1. In the Sequencer, double-click the transition you want to use as a 
starting point for your custom transition.

The controls for the transition are displayed in the Controls window. 

2. Choose the settings you want to use.

3. Drag the custom transition from the Sequencer to the Effects 
window.

You see the following dialog box.

Custom transition

Use this button to 
create a new 
folder to store 
custom 
transitions



Creating Custom Transitions
4. Click New to create a folder for storing custom transitions.

Or, if you’ve already created a custom transitions folder, double click 
on this folder to open it. When creating a new folder navigate one 
level up from the transitions folder so that Radius EditDV Un-
plugged places your custom folder in the Plug-Ins folder at the same 
level as Transitions.

You see the following dialog box.

5. Enter a name for your custom transition folder.

It is not required but recommended that you store your custom tran-
sitions in their own folder to keep them separate from the Radius 
EditDV Unplugged supplied transitions.

6. Enter a name for your custom transition in the Save Transition 
As box and click Save.
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A new transition bin is created with your custom transition in it.

Removing Custom Transitions
Custom transitions are stored in the finder and can be removed in the 
same way any file is removed from the finder, by dragging it to the trash. 
Be sure never to remove any of the transitions supplied with Radius 
EditDV Unplugged as these are the basis for all custom transitions.

Note:  It is important that you never discard any of the Radius EditDV 
Unplugged transitions provided for you with the application. They are 
the foundation for all custom transitions. A custom transition file stores 
only the changes made to the preset transition used as its starting point.

Note: Since custom transitions and filters are simply files containing 
parameter settings, they may, like any Macintosh file, be moved from 
one workstation to another, sent via e-mail and shared among Radius 
EditDV Unplugged users.

Custom Bin

Custom Transition



Capturing Your Audio Media
Chapter 7: Working With Audio

Audio is an integral part of video production and critical to the success 
of a program. Radius EditDV Unplugged provides essential editing tools 
for working with audio as part of the editing process. Audio clips are 
generally handled in the same way as video clips. This chapter discusses 
the specifics of working with audio, setting volume, pan, and time 
varying control of audio volume envelopes using the Sound Fade filter.

Capturing Your Audio Media
In addition to the audio captured with video by your camcorder, audio 
media can be imported from a CD or an AIFF file. If source clips 
contain both video and audio media, you can import audio media at the 
same time video media is imported. To import audio from a CD, see 
“To import an audio track from a CD:” on page 43.

 Reviewing Audio in the Source monitor
Audio is reviewed in the Source monitor in the same manner as video. 
You can double-click a source clip in the Project window to place it in 
the Source monitor, or drag the clip into the Source monitor. 

When reviewing a source clip containing only audio in the Source 
monitor, an audio icon is displayed. The length of the clip is represented 
by the slider bar.

Audio clips are played by clicking the Play/Stop button in the Source 
monitor or by dragging the cursor through the slider bar.
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For more information about reviewing source clips in the Source 
monitor, see unplugged.

Adjusting the Volume in the Source Monitor
The Audio Adjust button in the Source monitor controls the volume for 
a source clip. Each source clip has an associated clip volume. After a clip 
has been placed into the Sequencer its clip volume may be adjusted with 
the audio control panel.

To adjust the volume for a source clip in the Source monitor:

1. Point to the Audio Adjust button and hold down the mouse 
button to display the volume control. 

Note:  Hold the Shift key while displaying the volume control to 
allow overdriving the audio beyond 100% (0 dB).

2. Drag the slider on the volume control to the desired position 
and release the mouse button.

When the audio level of a source clip in the Source monitor is al-
tered, the level selected effects the clip when it is played. When a clip 
is moved into the Sequencer from the Source monitor, the audio lev-
el of that clip retains the volume set in the Source monitor. 

Audio icon
denotes an

audio source
clip

Patch Matrix
reflects audio

only in Source



Reviewing Audio in the Source monitor
After moving a source clip into the Sequencer and creating an audio 
clip, you no longer adjust its volume from the Source monitor. Vol-
ume adjustments are then made in the Sequencer window or Pro-
gram monitor. See “Setting the Volume of your Audio Program” on 
page 142.

For more information about the function of Source monitor but-
tons, see “Reviewing Clips in the Source Monitor” on page 57.

Reviewing Source Clips in the Sound Monitor
The audio from a source clip can be displayed as audio waveforms in the 
Sound monitor.

To use the Sound monitor:

• With a clip containing audio in the Source monitor, choose Show 
Sound Monitor from the Window menu, or press Command-3.

Radius EditDV Unplugged displays the Sound monitor window 
containing the audio waveform for the source clip. If the clip con-
tains stereo audio, both tracks are shown in the Sound monitor with 
the left channel, shown in white, above the right channel, shown in 
red.

The segment of the clip between the In and Out points is displayed with 
a darker background than the rest of the source clip. A time cursor in the 
Sound monitor reflects the current position of the slider in the Source 
monitor.

The name of your source clip is shown at 
the top of the Sound monitor

Each tick
mark in the

Sound
monitor

indicates a
frame in your

clip

In Point Out Point

Time cursor
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Close the Sound monitor by clicking the Close button in the upper-left 
corner of the Sound monitor window, or choose Hide Sound Monitor 
from the Windows menu.

Zooming the View in the Sound Monitor
You control the amount of detail seen in the Sound monitor by 
zooming in and out. When zooming in, less of the audio clip is seen but 
in greater detail. Zooming out allows a longer segment of audio to be 
shown, but in less detail.

To zoom in the display in the Sound monitor:

1. Move the pointer into the Sound monitor and press Option.

A magnifying glass containing a plus sign appears.

2. Click to zoom in the display.

To zoom out the display in the Sound monitor:

1. Move the pointer into the Sound monitor and press Control.

A magnifying glass containing a minus sign appears.

2. Click to zoom out the display.

Scrubbing Audio in Source Clips
In addition to playing a source clip, there are four ways to scrub audio in 
source clips. 

• To scrub audio normally in the Sound monitor, drag the Sound 
monitor cursor to hear the audio played in small sound chunks. 

Radius EditDV Unplugged also simulates the Jog/Shuttle wheel found 
on many professional tape decks by tracking your mouse movement. 
Hold the command key while dragging to place the Sound monitor in 
Jog/Shuttle mode. The current mode is defined by the setting in the 
Scrub While Stepping in the Audio Scrub settings in the Sequencer 
menu.

• When in Jog mode Radius EditDV Unplugged plays your audio at 
half speed as long as you are dragging the mouse. If you drag your 
mouse to the left your audio will play in reverse. 



Reviewing Audio in the Source monitor
• While shuttling, Radius EditDV Unplugged plays your audio either 
half or normal speed depending on how far you have moved your 
mouse.

• You can also hear a clip play one frame at a time by stepping forward 
or backward through it with buttons or the keyboard and turning on 
Scrub While Stepping in the Audio Scrub settings in the Sequencer 
menu.

Note:  In order to scrub audio in the Source monitor the source clip 
must be in the Source monitor and the Sound monitor window 
must be open.

To prepare an audio source clip for scrubbing:

1. Double-click on a clip in a selected bin in the Project window or 
drag the clip, to place it in the Source monitor.

2. Select Show Sound Monitor from the Window menu.

The Sound monitor window appears.

To scrub an audio source clip:

1. Click on the waveform in the Sound monitor to begin normal 
scrubbing. Hold the mouse button down and drag the time 
cursor through the Sound monitor.

Audio will play as fast as you move the mouse. The Sound monitor 
time cursor appears as a vertical line when you first click on a wave-
form. The mouse pointer disappears when the time cursor moves. 
The audio will play in short staccato chunks, as long as the cursor is 
being moved.

To step through using the buttons in the Source monitor:

1. Choose Scrub While Stepping from the Audio Scrub submenu 
of the Sequencer menu. 

A check mark appears to the left of Scrub While Stepping, indicating 
that it is activated.

2. Use the step forward and backward buttons in the Source 
monitor to move through an audio clip as indicated by the 
buttons.

You can also use the keyboard equivalents for stepping, Right Arrow 
and Left Arrow.
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To jog the audio of a source clip:

1. Choose Jog in the Audio Scrub submenu of the Edit menu.

A check mark appears at the left of the word Jog when it is activated.

2. Press Command and click in the Sound monitor over the 
waveform to begin scrubbing. Drag the time cursor through the 
Sound monitor.

A vertical line, the Sound monitor time cursor, appears at the point 
you clicked. The mouse pointer disappears when the time cursor is 
moved. The audio clip will play at half speed for as long as the mouse 
is moving. The clip will play forward or backward, depending on the 
direction you move the mouse. 

To shuttle the audio of a source clip:

1. Choose Shuttle in the Audio Scrub submenu of the Sequencer 
menu.

A check mark appears at the left of the word Shuttle when it is acti-
vated.

2. Press Command and click in the Sound monitor, over the 
waveform to begin scrubbing. Drag the time cursor through the 
Sound monitor. 

A vertical line, the Sound monitor time cursor, appears at the point 
you clicked. The mouse pointer is replaced by a square stop icon.

3. If you press Command and drag the cursor a short distance, the 
mouse pointer will be replaced by a single triangle that points in 
the direction the cursor is moved. 

The clip will play at half-speed in the direction the mouse is moved.

4. If you press Command and drag the cursor a longer distance, the 
mouse pointer is replaced by two triangles pointing in the 
direction the cursor moves. 

The clip will play at full speed as long as the cursor is moving. It plays 
forward or backward, depending on the direction the mouse is 
moved.

Note:   Jog and Shuttle are mutually exclusive options, only one of 
them can be active at any given time.

For more information about buttons in the Source monitor, see 
“Reviewing Clips in the Source Monitor” on page 57.



Editing Audio Clips into the Timeline
Editing Audio Clips into the Timeline
Audio clips, or source clips containing video and audio, are moved into 
the Timeline in the Sequencer either by dragging or via the Patch matrix. 
For additional information on moving clips, see “Assembling a 
Program” on page 63. 

Two audio tracks (A1 and A2) are automatically open in the Sequencer 
window when a new project is started

Note: Stereo audio is displayed as A1 in the Tracks column in the Project 
window.

Note:  If the audio clips in your program define the structure of your 
program more than your video (for example, a narration about a 
historical event or a music video), you may want to assemble your audio 
clips first. 

Audio
tracks
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Playing Audio Tracks 
To play the audio tracks in the Timeline in the Sequencer, click the Play/
Stop button in the Sequencer window or in the Program monitor. All 
audio tracks that are play-enabled in the Sequencer will play when the 
Play/Stop button is clicked. To select audio tracks in your program for 
playback:

• Enable each track you want to play by clicking the ear icon to the left 
of the track.

The ear icon is gold when the track is activated, grayed when it is not.

Soloing Audio Tracks
An audio track may be soloed (all other tracks off) by option-clicking its 
ear icon. It will be enabled and all other audio tracks will be disabled. 
Option-clicking on a track that is already solo enabled will solo disable 
it, turning all other audio tracks on. Soloing is especially useful for 
turning on the AP (Audio Program) by itself for playback after 
rendering. 

Editing Audio in the Sequencer window
Once audio source clips are placed in the Timeline, they can be 
manipulated and edited in the same way as video clips—dragging them 
to new positions on the Timeline, adding a cross-dissolve, forcing edits 
in them, etc. For more information about editing clips, see “Chapter 5: 
Editing a Program” on page 87. The following sections discuss aspects of 
editing specific to audio.

Active Audio
Track

Inactive Audio
Track



Editing Audio in the Sequencer window
Viewing Sound Waveforms in the Sequencer
Sound waveforms of clips in the audio tracks of the Timeline can be 
viewed in the Sequencer. You can scrub, jog or shuttle these clips 
directly in the Sequencer.

To see the sound waveforms in the Sequencer:

1. Click on the ear icon to enable the audio track.

2. Click the blue arrow to the left of the audio track.

The audio track expands, the arrow changes position indicating the 
track display is open and points down.

3. To return the track to normal mode, click the blue arrow again.

The arrow returns to its original position. The track collapses and the 
waveforms disappear. 

Scrubbing Audio Tracks in the Sequencer Window
Pressing the command key while dragging the Timeline cursor scrubs all 
enabled audio tracks together using the mode checked in the Audio 
submenu of the Sequencer menu. 

To enable an audio track, click the ear icon to the left of the track. The 
icon is gold when the track is enabled, gray when it is disabled. The 
difference between scrubbing in the Sequencer and scrubbing in the 
Sound monitor is that audio is off by default in the Sequencer unless 
the command key is pressed.

Audio wave
forms
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To scrub audio tracks in the Sequencer:

1. Position a clip in the Timeline of the Sequencer and enable the 
audio track to be scrubbed.

2. Select Normal in the Audio Scrub submenu of the Sequencer 
menu.

A check mark appears at the left of the word Normal when it is acti-
vated.

3. Press Command, point at the top end of the Sequencer Timeline 
cursor and drag through the clip or clips. 

Audio will play as fast as you move the mouse. The audio will play 
in short staccato chunks, as long as the cursor is being moved.

To jog while scrubbing audio clips in the Sequencer:

1. Position a clip in the Timeline of the Sequencer and enable the 
audio track to be scrubbed.

2. Select Jog in the Audio Scrub submenu of the Sequencer menu.

A check mark appears at the left of the word Jog when it is activated.

3. Press Command, point at the top end of the Sequencer Timeline 
cursor and drag through the clip or clips. 

The arrow of the mouse pointer disappears. The audio clip will play 
at half speed for as long the cursor is moving. The clip will play for-
ward or backward, depending on the direction the cursor is moved. 

To shuttle while scrubbing audio clips in the Sequencer:

1. Place a clip in the Timeline of the Sequencer.

2. Enable the audio track.

3. Select Shuttle in the Audio Scrub submenu of the Sequencer 
menu.

A check mark appears at the left of the word Shuttle when it is 
activated.

4. If you press Command, point at the top end of the Timeline 
cursor, and drag it, the mouse pointer becomes a square. 



Editing Audio in the Sequencer window
5. If you press Command, point at the top end of the Timeline 
cursor, and drag it a short distance, the mouse pointer will be 
replaced by a single triangle that points in the direction the 
cursor is moving. 

A clip will play at half-speed in the direction the cursor moves.

6. If you press Command, point at the top end of the Timeline 
cursor and drag it a longer distance, the mouse pointer is 
replaced by two triangles pointing in the direction the cursor is 
moving. 

The clip will play at full speed as long as the cursor moves. It plays 
forward or backward, depending on the direction the cursor moves.

Note:  Only one of the Audio Scrub submenu options: Normal, Jog 
or Shuttle, can be active at a time. These options can also be 
selected with the command key equivalents shown in the submenu 
for faster switching between modes. 

Note:  These scrubs modes can be used with or without waveform 
display.

To hear program audio one frame at a time:

1. Enable the audio track by clicking the ear icon to the left of it.

2. Select Scrub While Stepping from the Audio Scrub submenu of 
the Sequencer menu. 

When you click, a check mark appears to the left of Scrub While 
Stepping, indicating that it is activated.

3. Use the step forward and backward buttons in the control ribbon 
of the Sequencer window, or the keyboard arrows, to move 
forward and backward through an audio clip.

The audio will play in short chunks as you step through the Sequenc-
er.

Note:   Scrub While Stepping can be activated with any of the scrub 
modes.
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Setting the Volume of your Audio Program
Audio volume may be changed for an entire track, an individual clip or 
a section of a program using the Sound Fade filter. The volume of 
individual clips in an audio track can be set to balance differences in the 
audio levels between clips. You can also use the sound Fade filter to 
control the volume envelope using keyframes over a period of time.

To set the volume in the Sequencer window, use the Audio Controls 
window. 

To Set the Volume of a Clip or a Track

1. Select the audio clip or track and open the Controls window:

• Click the Audio Adjust button in the Program monitor.

• Choose Show Controls Window from the Window menu, or press 
Command-2. 

In the Audio Controls window, the Track Settings and Clips Settings 
sliders are preset at zero, unless you have adjusted a source clip volume 
in the Source monitor. This indicates that the audio clips in the program 
are at 100% of the level at which they were captured. The boxes under 
the settings report the audio levels in decibels. 

To change the volume for an audio clip in the Sequencer:

1. Click the audio track containing the clip.

Sets volume 
for an entire 
audio track

Sets volume 
for a clip

Selects a pan 
setting for a clip

Returns Audio 
Controls to the 
preset values

Pan control cursor



Editing Audio in the Sequencer window
2. Position the Timeline cursor over that audio clip.

3. In the Audio Controls window, use the slider on the Clip 
Settings volume control to adjust the audio level of the clip.

Audio adjustments on tracks and clips may also be made interactive-
ly while the clip is playing.

To change the volume for an audio track in the Sequencer:

1. Click the audio track.

2. In the Audio Controls window, use the slider on the Track 
Settings volume control to adjust the audio level for the track.

When the audio level for a track is changed, all clips on the track are 
adjusted accordingly, but their individual clip volumes remain un-
changed. 

Note:  When changing volumes for a clip or track the final volume 
you set is the one used by Radius EditDV Unplugged for the entire 
track or clip. To set volumes that vary over time within a clip use the 
sound fade filter. For more information on the sound fade filter, see 
“Using the Sound Fade Filter” on page 144. 

Selecting a Pan Setting for an Audio Clip
Use the pan control cursor below the Clip Settings volume control in 
the Audio Controls window to select a pan setting for an audio clip. 

To select a pan setting for a clip:

1. In the Sequencer, position the Timeline cursor over the audio 
clip.

2. Open the Audio Controls window by clicking the Audio Adjust 
button in the Program monitor.

You can also press Command-2, or choose Show Controls from the 
Window menu.

3. Move the pan control cursor on the Pan Setting control left or 
right to the desired setting.

The pan control cursor on the control is preset at zero, which sets 
the pan at Center. As you drag the pan slider, the numerical setting 
in the text box to the right of the slider changes. 
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You choose a pan setting for an entire clip. To fade the audio in a clip 
from Full Left to Full Right, or vice versa, force an edit in the clip and 
use the Cross Fade Audio transition at the cut. For more information see 
“Force an Edit” on page 93 and “Using the Cross Fade Audio 
Transition” on page 117.

Using the Sound Fade Filter
Track and clip volumes provide fixed control for the entire length of the 
track or clip respectively. Time varying control of audio volume is 
provided by the Sound Fade filter. Like most filters in Radius EditDV 
Unplugged, it supports keyframing of its volume parameter and linear- 
or spline-based interpolation for smooth changes between keyframes. In 
addition, it provides access to volume keyframes by dragging the rubber 
band control in the FX track of the audio track. Sound Fade filters can 
be saved as custom filters to create commonly used fades.

Applying the Sound Fade Filter

The Sound Fade filter is applied like other filters in Radius EditDV 
Unplugged, except that it can only be applied to audio tracks.

To apply a Sound Fade filter to an audio track:

1. Choose an audio track where you want to add the filter. Click 
that track to select it. 

You see a black border around the selected track.

2. Choose Add FX Track from the Sequencer menu, or press 
Command-Backslash (\) if there is not already an FX track on the 
audio track you want to adjust.

A new FX track is added, below any existing FX tracks.

3. Choose Show Effects Window from the Window menu.

Radius EditDV Unplugged opens the Effects window. 

4. Click Filters in the left column of the window to select it.

5. Select the Sound Fade filter and drag it into an FX track in the 
Sequencer. 

The audio track may either be opened, showing the audio waveform, 
or hidden.



Editing Audio in the Sequencer window
6. Place the filter below the clip where you want to apply the Sound 
Fade. 

You see an outline where the filter will be applied before you release 
the mouse button. The filter will snap to the clip you apply it to, so 
it’s easy to apply a filter to an entire clip, although it can be applied 
anywhere on the timeline. After you release the mouse button the fil-
ter is displayed as a green strip in the FX track. The black border in-
dicates it is selected. The name of the filter appears in the strip.

Note:  For more information on using filters in Radius EditDV 
Unplugged, see Chapter 7: Creating Special Effects with Filters.

Adjusting Volume from the Controls Window

Audio levels may be adjusted, and keyframes created, either from the 
volume slider in the controls window or by dragging the keyframes 
directly in the Sequencer.

To adjust sound volume from the controls window:

1. Double-click a Sound Fade filter on the FX track to select it. If 
the filter is already selected, press Command-2 or go to the 
Window menu and select Controls Window.

2. Position the Timeline cursor in the Sequencer where you want to 
adjust the volume. 

 
Preset Sound Fade
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3. Choose the volume setting you want to use in the Controls 
window.

Radius EditDV Unplugged creates a keyframe at the position of the 
Timeline cursor using the selected setting. You see a small white tri-
angle in the FX track that indicates the volume at that keyframe, and 
a line indicating the volume envelope.

4. After choosing filter settings, click the Close button in the upper-
left corner of the Controls window to close it.

Note:  The Audio Program must be updated to hear the effect of a 
Sound Fade filter.

Adjusting Audio Levels in the Sequencer

When an audio volume is adjusted in the Controls window the 
appropriate keyframe is also adjusted in the Sound Fade filter in the FX 
track. To make adjusting audio levels more convenient, these keyframes 
may also be adjusted directly by dragging them. Audio keyframes may 
be dragged up or down to adjust volume level or, like other keyframes, 
left and right to change their position on the Timeline.

To adjust keyframes by dragging: 

1. To show the FX track on an audio track, click on the green 
triangle to the left of the gold track button.

The FX track will be displayed. 

2. Click and drag the keyframes in the FX track directly.

If the Controls window is displayed, the volume slider will change as 
you adjust the keyframe in the FX track. 

 Percentage of
original value



Updating the Audio Program
Note:  Hold the Control key while dragging to constrain the 
position of the keyframe. You can then move the keyframe 
vertically to change the volume, but it will remain at its original 
time in the Sequencer.

3. Add keyframes anywhere in the Sound Fade filter by clicking on 
the red line and dragging it to the desired volume.

Remove a keyframe by clicking to select it, then pressing the Delete 
key.

Note:  The volume slider and text box in the Controls window 
provide greater precision for control of audio level than dragging 
keyframes in the FX track.

 Updating the Audio Program
All or part of the audio portion of a program in the Sequencer can be 
rendered in the same way as video tracks are rendered. Audio and video 
tracks can be rendered together or separately. If you are using multiple 
audio tracks and plan to make a DV tape with audio and video, render 
them to a single AP (Audio Program) track and play that track alone. 
Track playback is controlled by the gold ear button and rendering is 
controlled independently by the red render button. All audio tracks with 
the red button enabled will be included when rendering, while all tracks 
with the gold ear enabled will be included on playback.

For more information about rendering in the Sequencer, see “Reviewing 
a Program” on page 78 and Chapter 10: Managing Disk Storage.

 

Audio level 
keyframe
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Applying Radius EditDV Unplugged Filters
Chapter 8: Creating Special Effects With 
Filters

Special effects are created using Radius EditDV Unplugged filters. 
Filters are placed in FX tracks to define where in your program they are 
to be applied. When you update your Program track, your video is 
passed through the filters to modify it and merge it into a new video 
stream containing the effects that you’ve described in the Sequencer. 
You can use the filters with their presets, or develop custom versions of 
each, and save them to use again.

Applying Radius EditDV Unplugged Filters
Radius EditDV Unplugged filters are general purpose tools that can be 
used to create a wide variety of effects. Each filter has a wide variety of 
applications for creating compelling video. The Radius EditDV 
Unplugged filters are: Color Adjust, Fade, Mirror, Tint and Titling. All 
filters provide controls for creating dynamic effects that change over 
time using keyframes. 

To use a Radius EditDV Unplugged filter:

1. Choose Show Effects Window from the Window menu.

Radius EditDV Unplugged opens the Effects window. 

2. Click Filters in the left column of the window to select it.

You see the list of Radius EditDV Unplugged filters in the right col-
umn.
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3. Select the desired filter and drag it into an FX track in the 
Sequencer. 

4. Place the filter below the clip you want to apply the effect to. 

You see an outline of where the filter will be applied before you re-
lease the mouse button. The filter will snap to the clip you apply it 
to, so it’s convenient to apply a filter to an entire clip, although it 
can be applied anywhere on the timeline. After you release the 
mouse button the filter is displayed as a green strip in the FX track. 
The black border indicates it is selected. The name of the filter ap-
pears in the strip.

Changing Filter Position and Length 
When you first drag a filter into an FX track, it assumes the same 
position and length as the clip you place it under. You can easily adjust 
its position and change its length. 

To change the position of a filter: 

• Click the filter to select it and drag it to a new position on the 
Timeline.

You can drag the filter to cover part or all of one clip, or place it so 
that it covers more than one clip.

You can change the length of a filter by dragging the right end of it or by 
using the Set Filter Length command in the Sequencer menu.

Note: While dragging, you can turn off the snap to alignment feature by 
holding the ctrl key.

Selected color
adjust filter

FX monitor
is active



Applying Radius EditDV Unplugged Filters
To change the length of a filter using Set Filter Length: 

1. Click the filter to select it.

You see a black border around it.

2. Choose Set Filter Length from the Sequencer menu.

You see the Set Filter Length dialog box.

3. Change the current filter length to the desired length and click 
OK. 

The filter expands or contracts according to the length you entered.

You can also extend the filter by clicking on the right end of it and 
dragging it to the desired length.

Note: The filter is synchronized to the Timeline so even if you change 
the underlying source clip it remains in place.

Copying and Pasting Filters
Radius EditDV Unplugged provides ways to reuse filters that you have 
constructed. Filters can be copied and pasted like text in a word 
processor. They can also be saved in an effects bin for reuse on 
subsequent projects. For more information on saving custom filters see, 
“Creating Custom Filters” on page 165.

To copy a filter: 

1. Click the filter to select it.

A selected filter is surrounded by a black border. 

Current filter length
151



CHAPTER 8: CREATING SPECIAL EFFECTS WITH FILTERS                                       

152
2. Select Copy from the Edit menu.

You may also use keyboard equivalents to copy a filter.

3. Select the track where you want to paste the filter.

A selected track is surrounded by a black border.

4. Select insert or overwrite on the Monitors window.

If you choose insert the effect will be inserted at the current time, 
pushing all filters to the right (to later times). The FX track will be 
lengthened by the length of the copied filter. If you choose overwrite 
the FX track remains the same length and any filter in the overwritten 
path will be removed.

5. Position the Timeline cursor where you want the In point of the 
filter.

6. Select Paste from the Edit menu.

The filter will be inserted or overwritten at the location of the Time-
line cursor in the selected track.

Using Filter Controls
In general, you adjust filter controls by opening a filter’s control panel 
and placing the time cursor in the Sequencer at the time where you want 
the effect to occur. As you adjust the controls, Radius EditDV 
Unplugged places keyframes in the filter to remember your settings. 
Thus, what you see at any given time in the Sequencer is what you will 
get in your final program track at that time.

The controls provided for each Radius EditDV Unplugged filter let you 
determine exactly how the filter works. For example, you can use the 
Fade filter to perform a traditional fade to black over whatever length 
you choose. However, by changing the Fade To color and using 
keyframes, you can also use this same filter to flash to white or another 
color.

To use the filter controls:

1. Double-click a filter on the FX track to select it. If the filter is 
already selected, press Command-2 or select Show Controls 
Window in the Window menu.

2. Position the Timeline cursor in the Sequencer where you want to 
apply specific filter settings. 



Applying Radius EditDV Unplugged Filters
Note:  An initial keyframe at the first frame of every filter is always 
required, you can adjust the settings of this keyframe but cannot 
remove it.

3. Choose the settings you want to use in the Controls window.

Radius EditDV Unplugged creates a keyframe at the position of the 
Timeline cursor using the selected settings. You see a small white tri-
angle at the lower edge of the FX track that indicates the keyframe.

4. After choosing filter settings to create the desired effect, click the 
Close button in the upper-left corner of the Controls window to 
close it or select Hide Controls Window from the Window 
menu.

Using Keyframes With Filters
At the beginning of a filter, Radius EditDV Unplugged sets a modifiable 
default keyframe. Each time you make an adjustment to the settings of 
the filter’s controls, Radius EditDV Unplugged marks the frame where 
you made those adjustments as another keyframe. The settings at a 
keyframe remain in effect until the next keyframe. Thus, if you want an 
effect to apply for the length of the filter, make the changes with the 
Timeline cursor set on the first keyframe. When you make adjustments 
at several frames, multiple keyframes are established. Radius EditDV 
Unplugged calculates appropriate progressive values to gradually change 
from the values in the first keyframe, to the values set in the next 
keyframe, and so on. These values are used to create dynamic effects—
effects that change over the length of the filter as your video plays.

To use keyframes with a filter:

1. Once you have placed a filter, position the Timeline cursor in 
the filter where you want a keyframe.

2. Choose the settings for this frame from the Controls window of 
the Window menu.

The frame is marked as a keyframe, you see a small white triangle at 
the lower edge of the FX track.

3. Move the Timeline cursor to where you want the next keyframe.

4. Choose your desired settings in the Controls window.
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To move a keyframe to a new time in a filter:

1. Select the keyframe by clicking on the small triangle that 
denotes a keyframe.

The triangle becomes black when it is selected.

2. Drag the selected keyframe to the new location.

You can drag the keyframe to any location within the filter.

To delete a keyframe:

1. Select the keyframe by clicking on the small triangle that 
denotes a keyframe.

The triangle becomes black when it is selected.

2. Press the delete key on the keyboard.

The keyframe is removed and the triangle disappears.

You can set as many keyframes as you want in the filter, however each 
keyframe must be on a separate video frame. You can use keyframes with 
any of the Radius EditDV Unplugged filters.

As the Timeline cursor moves to a new keyframe the control panel displays the new parameters.



Previewing Special Effects Created With Filters
Note: To change the settings at the default keyframe at the beginning of 
a filter, position the Timeline cursor in that frame and adjust the settings 
in the filter’s Control window. 

Removing a Filter
If you decide you don't want to use a filter after dragging it into your 
program, you can remove it.

To remove a filter from a program:

• Click the filter to select it and press the Delete key.

Previewing Special Effects Created With Filters
There are several ways to see the effect of applied filters before finishing 
your program. When you select a filter and position the Timeline cursor 
within the filter, Radius EditDV Unplugged switches the Program 
monitor, in the Monitors window, to the FX monitor. You use the FX 
monitor to preview filters and position your effects in your program.

FX monitor 

Preview mode
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You can switch between using the FX monitor and the Program monitor 
by using the buttons at the left end of the control ribbon in the 
Sequencer window. 

To see a preview of a filter:

• Click the filter in the Timeline of the Sequencer to select it. Drag the 
Timeline cursor through the filter.

You see a preview of the effect of the filter in the FX monitor applied 
to a single frame of the underlying clip. This allows you to review the 
effect of your settings without waiting for rendering.

To see the clip at final quality with the filter in place:

• Click the filter in the Timeline of the Sequencer to select it. Hold 
down the Shift key and drag the Timeline cursor through the filter.

You see the clip with the filter applied in the FX monitor.

You can review an animation of a filter to see how it works over time. 
Such a preview provides you with an opportunity to adjust the pacing of 
the effect of the filter before rendering your program.

To review the animation of a filter: 

1. Click the filter in the Timeline to select it.

2. Click the Animate button in the control ribbon of the 
Sequencer, choose Animate from the Sequencer menu, or press 
Command-L.

You see an animation of any movement in the filter in the FX mon-
itor. Radius EditDV Unplugged will skip frames as necessary to pre-
view the flow of the effect in realtime.

FX monitor
button

Program
monitor

button

Snapshot button
Animate button

Render button



Using the Tint, Color Adjust, Fade and Mirror Filters
You can also get a snapshot of your complete program at final quality, 
with all filters applied to that frame. When the FX monitor is in normal 
mode you will often see an instant render of the effect and all 
underlying tracks when you release the mouse button. You can use the 
snapshot button to see a rendering of all active tracks, including those 
that overlay the filter you are working with.

To see a snapshot:

1. In the Sequencer, move the Timeline cursor to the frame you 
want to see.

2. Click the Snapshot button in the control ribbon of the 
Sequencer, Choose Snapshot from the Sequencer menu, or press 
Command-K.

Using the Tint, Color Adjust, Fade and Mirror Filters
The following sections in this chapter explain some of the Radius 
EditDV Unplugged filters. For information about the Titling filter, see 
Chapter 9: Creating Titles.

Using the Color Adjust Filter 
The Color Adjust filter provides tools to adjust the color balance in your 
clips. For example, you can use the Color Adjust filter to bring out the 
reds (or blues, or greens) in a clip. You could also brighten, change the 
contrast, or darken to compensate for lighting in the original video. 
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When you apply the Color Adjust filter and open the Controls window, 
you see the following: 

The table below describes the various controls on the RGB page of 
Color Adjust:

Returns the RGB 
page to the preset 
settings



Using the Tint, Color Adjust, Fade and Mirror Filters
The More page provides additional Color Adjust controls. 

To display the More page for the Color Adjust filter: 

• Click the More tab at the top of the controls window.

You see More page.

The following table describes the controls on the More page:

Control: When you want to:
Brightness Change the amount of light in an image.
Contrast Increase or decrease the difference between the darkest and light-

est parts of an image.
Gamma Change the brightness of the mid-range values.
High Clip Remove colors from the high end of the color values.
Low Clip Remove colors from the low end of the color values.
Red Change the amount of red used in an image.
Green Change the amount of green used in an image.
Blue Change the amount of blue used in an image.

Control: When you want to:
 Hue Adjust the color mix in an image.
Saturation Changes the intensity of the colors. 
Broadcast Safe Constrains to colors allowed for television broadcast-

ing.

Returns the More 
page to the 
preset settings
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Using the Fade Filter
The Fade filter lets you dissolve frames to or from a color. One common 
use of this filter is to gradually bring in the beginning of your program 
from black. 

When you apply the Fade filter and open the Controls window, you see 
the Fade page. 

When you first apply the Fade filter, you see a 50% blend of the fade 
color and the clip in the FX monitor. The preset fade color is black and 
the blend setting is at 50. You can choose a different fade color and 
change the blend setting to vary the appearance of the clip using the 
Fade filter. 

To choose a fade color:

1. Click in the Fade Color box and hold the mouse button.

The pointer changes into an eyedropper and you see the Radius Edit-
DV Unplugged color palette.

Returns the 
Fade page to 
the preset 
settingsSelect the

fade color

Adjust how
much fade

color is used



Using the Tint, Color Adjust, Fade and Mirror Filters
2. Drag the eyedropper to the color you want in the color palette.

If you want to match a color in your video, drag the eyedropper to 
the color in the Monitors window. As you drag the eyedropper over 
different colors you will see the Fade Color box change.

3. Release the mouse button. 

The eyedropper picks up the selected color, displays it in the color 
box, and uses it for the Fade filter. The results are also displayed in 
the FX monitor.

Note:  Click in the Fade Color box to see the Apple Color Picker. This 
window can also be used to choose and adjust the color used with the 
Fade filter.

Some Apple Color Picker Options
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To select a blend setting: 

• Drag the slider on the Blend control in the Controls window to the 
desired setting.

As you drag the slider on the Blend control, you see the number in 
the Blend box change. If you know the exact setting, you can type 
the number into the Blend box. A preview of the blended image is 
shown in the FX monitor.

At a setting of 0, the fade color is not present. At a setting of 100, you 
see only the selected fade color.

You can use the Blend control with keyframes to gradually blend the 
fade color with the clip until it is completely faded to the selected color. 
Or, reverse the procedure and gradually fade from the color to the clip. 
You see your changes immediately in the FX monitor. 

Using the Mirror Filter
Use the Mirror filter to flip frames horizontally, creating a mirror image. 
When you apply the Mirror filter and open the Controls window, you 
see the Mirror page. 

When you first drag the Mirror filter into an FX track of the Sequencer, 
you see the mirror image of the clip in the FX monitor. You can click the 
Mirror checkbox to return the clip to its normal orientation.

Returns the Mirror 
page to the preset 
settings

The Mirror filter is preset to create a 
mirror image of a clip



Using the Tint, Color Adjust, Fade and Mirror Filters
You can use the Mirror control to reverse the entire clip, or with 
keyframes to flip frames in a clip back and forth. You see your changes 
immediately in the FX monitor.

Using the Tint Filter
You can use the Tint filter to change color frames to black and white, or 
to tint frames in a clip with a selected color.

When you apply the Tint filter and open the Controls window, you see 
the Tint page. 

When you first apply the Tint filter to an FX track, you see the clip 
displayed in black and white in the FX monitor. You can change the 
colors used to tint the clip and adjust the blend of the colors.

To choose a different bright or dark color:

1. Click in the Bright Color or Dark Color box and hold the mouse 
button down to display the Radius EditDV Unplugged color 
palette.

The Bright Color selection affects the brighter colors, and the Dark 
Color selection affects the darker colors.

2. Drag the pointer, which now looks like an eyedropper, to the 
color you want to use.

To match a color in your video, drag the eyedropper over the color 
in the Monitors window.

3. Release the mouse button. 

Returns the 
Tint filter 
settings to 
the presets

Use these color
boxes to adjust

Bright and Dark
colors in the video

Use this slider
to adjust the

quantity of Tint
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The eyedropper picks up the selected color, displays it in the color 
box, and uses it in the Tint filter.

Note: You can also use the Apple Color Picker to choose your tint 
colors. Click in the Bright Color or Dark Color box. You see the Color 
Picker Window.

To create a negative effect: 

• Reverse the bright and dark colors.

If you reverse the bright and dark colors in the Tint filter you’ll see 
a negative effect similar to the following.

To select a blend setting: 

• Drag the slider on the Blend control to the desired setting.

As you drag the slider on the Blend control, the number in the Blend 
box changes. If you know the exact setting, you can type the number 
into the Blend box.

At a setting of 0, the clip used with the filter looks normal. At a setting 
of 100, you see the clip completely tinted by a blend of the selected 
colors.

By using keyframes with different Blend control settings, you can 
achieve a gradual blending of the colors. You see your changes 
immediately in the FX monitor.

Negative effect 
created using 
the Tint filter

Source
footage



Creating Custom Filters
Creating Custom Filters
If you find that you are making the same changes to a filter’s presets and 
creating the same keyframes over and over, you might want to save your 
settings as a custom filter. You can use one of the preset filters or an 
existing custom filter as a starting point for a new custom filter.

Radius EditDV Unplugged saves a custom filter file in the plug-ins 
folder with the other Radius EditDV Unplugged filters using a name 
that you assign. You see the new filter displayed with a special document 
icon that designates it as a custom filter. You apply a custom filter to 
your program the same way you use any other filter.

To create a custom filter:

1. In the Sequencer, double-click the filter you want to use as a 
starting point for your custom filter.

You see the filter’s controls in the Controls window. In the Sequenc-
er, the Timeline cursor s positioned within the filter and the filter is 
selected. 

2. Choose the settings you want to use for your custom filter at this 
position.

When you adjust the settings, you create a keyframe. You can repo-
sition the Timeline cursor and choose new settings to create as many 
keyframes as you want.

Custom filterCustom 
Effects bin
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3. Drag the filter from the Timeline in the Sequencer to the Effects 
window and drop it there.

You see the following dialog box.

4. Enter a name for your custom filter in the Save Filter As box and 
click Save.

Note:   It is important that you never delete any of the Radius 
EditDV Unplugged preset filters, they are the foundation for all 
custom filters. A custom filter file stores only a document 
containing the settings for a particular effect and not the filter itself.

To create a New Effects bin to store custom filters:

1. In the Sequencer, double-click the filter you want to use as a 
starting point for your custom filter.

You see the filter’s controls in the Controls window. In the Sequenc-
er, the Timeline cursor moves to the beginning of the filter. 

2. Choose the settings you want to use for your custom filter at this 
position.

When you adjust the settings, you create a keyframe. You can repo-
sition the Timeline cursor and choose new settings to create as many 
keyframes as you want.



Creating Custom Filters
3. Drag the filter from the Timeline in the Sequencer to the Effects 
window and drop it there.

You see the following dialog box.

4. Click New to create a folder for storing custom filters.

Or, if you’ve already created a custom filters folder, double click on 
this folder to open it. When creating a new folder navigate one level 
up from the filters folder so that Radius EditDV Unplugged places 
your custom folder in the Plug-Ins folder at the same level as Filters.

You see the following dialog box.

5. Enter a name for your custom filter folder.

It is not required but recommended that you store your custom fil-
ters in their own folder to keep them separate from the Radius Edit-
DV Unplugged supplied filters.

6. Enter a name for your custom filter in the Save Filter As box and 
click Save.

Use this button to 
create a new 
folder to store 
custom filters
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Note:  It is important that you never delete any of the Radius EditDV 
Unplugged filters provided for you with the application. They are the 
foundation for all custom filters. A custom filter file stores only a 
document containing the settings for a particular effect and not the filter 
itself.

Removing a Custom Filter
Custom filters are stored in the finder and can be removed in the same 
way any file is removed from the finder, by dragging it to the trash. Be 
sure never to remove any of the filters supplied with Radius EditDV 
Unplugged as these are the basis for all custom filters.

Custom filterCustom Bin



Working with FX Tracks
Working with FX Tracks
Filters are placed in the FX track just below the video track. 

Hiding the FX Track
While you are not using the FX track Radius EditDV Unplugged allows 
you to hide it to save screen space.

To hide an FX track: 

1. Click the green triangle to the left of the gold track button. 

You only see the source track.

Click here to hide
the FX tracks

Click here to
show FX tracks
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Applying the Titling Filter
Chapter 9: Creating Titles

Using text in a video program can include creating a main title, subtitles, 
and credits. Text is created in Radius EditDV Unplugged with the 
Titling filter. It can create text in various fonts, sizes, and colors; or 
enhance text using font styles, color and opacity gradients, borders, 
shadows and backgrounds. 

Keyframes allow you to develop text that scrolls or crawls across your 
video or DVE style moving title effects. All titles employ sub-pixel 
motion and are anti-aliased for high quality results. The Titling filter also 
supports an alpha channel mode for video in text effects and traveling 
matte creation.

Title effects that you have created can be saved as custom filters for use 
as templates in any program. Custom titles can be used to efficiently 
create a program with consistent titles.

This chapter provides examples of how to use keyframes with the Titling 
controls. You can use keyframes with all of the text settings, except for 
those in the Font area of the Text Style page. The controls in that area 
have to do with selecting fonts, font sizes, font styles, positioning text, 
and kerning text characters and apply for the entire duration of the title 
effect. For more information on using keyframes with the Titling filter 
see, “Using Keyframes With Filters” on page 153.

Applying the Titling Filter
You can use the Titling filter with a video clip to superimpose titles and 
credits, or you can use it to play your titles and credits on a color 
background.

To use the Titling filter: 

1. Choose Show Effects Window from the Window menu, or press 
Command-1.

2. Select Filters in the left column of the window.
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3. Drag the Titling filter from the right column of the Effects 
window into the desired FX track in the Sequencer. 

When you see the insertion cursor, release the mouse button to 
apply the filter. You can place several Titling filters into multiple FX 
tracks over a single video track to layer titles.

4. Adjust the position and duration of the filter, if necessary.

See “Changing Filter Position and Length” on page 150 for more in-
formation. 

5. Double-click the filter in the FX track to open its controls in the 
Controls window. If the filter is already selected, press 
Command-2.

The FX monitor replaces the Program monitor when you open the 
controls window. 

6. In the FX monitor, click where you want to begin your text.

You see a text cursor and a text box in the monitor. Set the controls 
on the different pages of the Titling controls window to determine 
the appearance of your text.

When you start typing, 
your text appears here

Radius EditDV Unplugged uses 
the FX display when you are 
working with a filter

Text box



Applying the Titling Filter
The following sections describe how to use the settings in the Titling 
filter controls window to create text over video. For general information 
about using Radius EditDV Unplugged filters, see “Chapter 8: Creating 
Special Effects With Filters” on page 149.

Using the Text Style Page
When you start typing in the FX monitor you see text appear in the text 
box on the FX monitor with the font and size currently selected in the 
Text Style page of the control window. The Radius EditDV Unplugged 
Titling filter works much like a word processing application. When you 
reach the right side of the text box, your text wraps to the next line, or 
you can press Enter to start a new line at any time. 

You use the Text Style page for the Titling filter to select the appearance 
of the individual letters of your text. You can choose how you want your 
text to look before you start typing, or you can type your text and then 
select all or part of it and make changes. 

When you apply the Titling filter and open the Controls window, you 
see the Text Style page.

The Titling filter provides 
four pages of controls

Returns 
Text Style 
page to the 
preset 
values

Choose a font

Choose a font size

Add a text border

Choose 
font 
styles

Adjust the spacing 
between characters

Use to position text

Adjust the 
spacing 
between 
lines
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Selecting Text
When working with text you either select individual characters for 
setting their style or you select the text as an object for setting properties 
such as color or position that apply to the text as a whole. Once you 
type text, you select all or part of it before changing its appearance. 

To select text: 

• Drag the text cursor over the text you want to select.

The selected text is highlighted.

After selecting text, make choices from the Text Style page. These 
choices affect only the characters selected at the time you change a 
setting, except when you choose leading, which affects all of the text in 
the Title filter.

Positioning Text on the Screen
You may work with your text as a complete unit–as a graphics object. 
For example, to animate text you move it as an entire unit to a new 
location in the FX monitor. 

To select text as an object: 

• Click outside the text box. 

You see a selection box surrounding the text with selection handles 
in each corner. Whenever this selection box is displayed you may are 

Selected text



Applying the Titling Filter
working with all of the text as a single graphics object.

To return to word processing mode to edit your text, click outside the 
selection box. You see the text cursor positioned where you last left it 
and the box changes to the resizing box with a single handle on the right 
side.

Choosing a Font and Font Size
The preset font in the Text Style page is Geneva at a preset size of 48 
points. To use a different font and size, you can change these settings at 
any time. Whenever you type in text, it will use the current font and 
style settings. 

To change the font for text:

• Select the text you want to effect.

• Choose a new font from the Font pop-up on the Text Style page.

If you are changing the font for existing, selected text, you see the 
change immediately in the FX monitor.

To change the font size for text:

• Select the text you want to effect.

• Choose a new font size from the Font Size pop-up on the Text Style 
page.

To use a font size that is not in the pop-up, type a number in the 
Font Size box and press Enter. 

Choosing a Font Style
Checkboxes for the available font styles appear at the right of the Text 
Style page. You can use multiple font styles with the same text. 

To add a font style to text:

• Select the text you want to effect.

• Click the checkbox for the style you want to use. 

If you are adding the style to existing, selected text, you see the 
change immediately in the FX monitor.
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Setting Text Width and Justification
When you begin typing text into the FX monitor, you are typing in the 
text box. The setting in the Line Width box on the Text Style page 
controls the width of the text box, and the amount of text you enter 
determines the length of the box. As you add lines of text, the box 
extends. The selection in the Justification pop-up on the Text Style page 
controls how text is justified.

Choose how
text is justified

Set the width
of the text box



Applying the Titling Filter
If you type text until the FX monitor is full, your text will scroll off the 
bottom of the monitor. However, you may continue to enter text and it 

will be added to the bottom of the box. You can later move the text box 
or change its width to bring the text into view.

Changing the Width of the Text Box

You can change the width of the text box to present your text in 
different ways similar to setting paragraph attributes in a word processor. 
For example, you might want to create a narrow column of text and 
position that column at a specific location over a clip. 

To change the width of the text box from the Text Style page:

• Drag the selection handle on the right side of the box in the FX 
monitor.

• or, Type the width you want to use in the Line Width box on the 
Text Style page and press Enter.

You see the text box change size and any text in the box rewrap ac-
cording to the new size.

Your text can 
scroll off the 
bottom of the 
Program monitor

The boundaries of 
the text box allow 
for a margin

Your text wraps within the 
boundaries of the text box

This text is left
justified
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Justifying Text

You can position your text at the left side of the text box, at the center, 
or at the right side. 

To justify your text:

• Choose Left, Right, Center, or Off from the Justify pop-up.

If you are justifying existing text, you see the change immediately in 
the FX monitor.

If you choose Off from the Justification pop-up, the left edge of text is 
positioned at the left side of the text box, but text does not 
automatically wrap at the right side of the text box. Press Enter when 
you want to begin a new line of text. Justification off can be used to 
produce a long line of text that scrolls horizontally across the screen.

Positioning Text Within the Safe Area

It is important to know that you can use only about 80% of the total 
video area for text if you are creating your program for standard video 
devices, such as television. This 80% area, where text is not distorted, is 
called the title safe area.

There is also an area called the action safe area, which encompasses 
about 90% of the total video and where you can be sure action in your 
video is visible. 

To view the safe areas for your program:

• Click the Safe Area button in the FX monitor. 



Applying the Titling Filter
You see two frames in the FX monitor that outline the safe areas. You 
can select your text as an object and click anywhere inside the selection 
box to drag it.

Note: If you plan for your text to scroll off the screen, use keyframes and 
move it past the safe area. However, make sure that the text starts and 
ends within the safe area to ensure it will be visible in your final 
program.

Kerning Text Characters 
Kerning adjusts the spacing between text characters, bringing them 
closer together or moving them farther apart. You can kern two text 
characters or a selection of text characters. 

To kern text characters: 

1. Select the characters you want to kern, or position the text cursor 
between two characters. 

2. Type a number between -100 and +100 in the Kerning box in the 
Text Style window and press Enter. 

Negative numbers tighten the spacing between text characters. Posi-
tive numbers spread characters further apart. Each number is equiv-
alent to one point.

Title safe area

Action 
safe area

Safe Area 
button in the 
FX display
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Leading Text 
Leading adjusts the spacing between lines of text, bringing them closer 
together or moving them farther apart. Leading affects the entire text 
object. You can also keyframe the leading so it changes over time. 

To lead text:

1. Type a number between -100 and +100 in the Leading box in the 
Text Style window and press Enter.

Negative numbers tighten the spacing between lines of text. Positive 
numbers spread lines further apart. Each number is equivalent to 
one point.

Adding a Text Border
You can add a border to text and control its color and thickness. 

To add a border to text: 

• Click the Border button at the bottom left of the Text Style page.

You see a border around the letters of your text in the currently se-
lected color and size. 

To choose a color for the text border:

1. Point to the Color Swatch, press and hold the mouse button to 
display the Radius EditDV Unplugged color palette.

The pointer changes into an eyedropper.

2. Drag the eyedropper to the color you want to use.

If you want to match a color in your video, drag the eyedropper over 
the color in the Monitors window.

3. Release the mouse button.

The eyedropper picks up the selected color, displays it in the color 
box, and uses it for the color of the text border.



Using the Text Page
Note:  You can also use the Apple Color Picker to choose a color for 
your text border. Click the Color box to display the Color Picker.

To choose a thickness for the text border:

• Drag the Thickness control slider to the desired setting. 

If you know the exact setting you want to use or if you want to use a 
size of less than a whole number, you can type the size into the box 
next to the Thickness control. 

The smaller the setting for the border thickness, the narrower the 
border; the larger the setting, the wider the border.

Using the Text Page
The Text page for the Titling filter provides additional control over the 
appearance of your text. It also provides controls for scaling, animating 
and positioning text. The Text page defaults to a color of grey text and a 
softness of zero. 

Note: To create the best looking titles adjust the color and set the 
softness to at least one.

To display the Text page for the Titling filter: 

• Click the Text tab at the top of the Controls window.

Some Apple Color Picker Options
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You see the Text page:

When using the Text page, you work with text as a graphics object. 
When you click the tab to display the Text page, the text cursor 
disappears, and your text is surrounded by a selection box with selection 
handles in the corners.

Returns Text page to the 
preset values

Indicate position 
and scale of text

Choose how
text will

move
between

keyframes

Click here to
create a
shadow

behind text

Choose color 
and opacity and 
create color and 
opacity gradients

Text selected 
as an object

Text handles 
for resizing 
text.



Using the Text Page
Moving Text
With text selected as an object, you can easily position it as a single unit 
within the video frame. 

To move text as a unit: 

1. Select your text as an object. 

Click the Text page, or click outside of the resizing box. You see a 
selection box with selection handles around the text.

2. Click anywhere in the text selection box and drag it to a new 
position. 

If the Text page is displayed when you drag text in the FX monitor, you 
can see the numbers in the H (horizontal) and V (vertical) Position 
boxes on the Text page changing. You can also type numbers in the 
Position boxes and press Enter, if you know the exact setting or want to 
use a fraction of a number (expressed as a decimal) for subpixel 
positioning.

Scaling Text
When you first start typing text into the FX monitor, the text is scaled 
on a one-to-one, horizontal to vertical aspect ratio. You can change the 
scale of a unit of text, but you cannot scale individual text characters.

To change the scale of text:

1. Select your text as an object.

You see a selection box with selection handles appear around the 
text.

2. Use the selection handles on the corners of the selection box to 
drag your text to a different scale. 

As you drag a selection handle in the FX monitor, you can see the 
horizontal and vertical numbers in the Scale boxes on the Text page 
change. If you know the exact numbers you want to use for scaling 
your text or if you want to use decimal numbers, type numbers in 
the Scale boxes and press Enter.
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Radius EditDV Unplugged is preset to maintain the one-to-one aspect 
ratio of your text to make it easy to zoom the size of the text up or down 
without distorting its appearance. To create a squashed or stretched look 
you must turn off Maintain Aspect Ratio and adjust the numbers in the 
two scale boxes in the Text page. 

You can set keyframes to make your text zoom. Radius EditDV 
Unplugged calculates appropriate progressive values and gradually 
zooms the size of your text from the size in the first keyframe to the size 
in the second keyframe.

Note: Higher quality is obtained by scaling large fonts down to smaller 
sizes than by scaling small fonts up to larger sizes. 

To change the aspect ratio of the text while scaling: 

• Click the Maintain Aspect Ratio checkbox on the Text page to 
remove the checkmark.

To create a zoom effect for a title, you can combine text scaling and 
keyframes.

Moving Text Between Keyframes
Text is animated by setting keyframes. Set the Timecursor in the 
Sequencer then drag your text, selected as an object, to the position you 
want it to have at that point in time. Then move the Timecursor and 

Keyframe 1 Keyframe 2
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reset the text to a new position in the FX monitor. A keyframe will be 
created each time you reposition the text. When the effect is rendered 
Radius EditDV Unplugged will move or change the effect as specified 
from keyframe position to keyframe position.

For example, you can have your title scroll across your video from 
bottom to top (or vice versa). You only have to set two keyframes one at 
the bottom of the screen at the start of the effect and one at the top of 
the screen at the end of the effect, Radius EditDV Unplugged will figure 
out the in-between positions.

You can also have your title crawl across your video from left to right 
(or vice versa). Or, you can use the Titling filter on two FX tracks to have 
different parts of your title flow onto the screen from either side. 

Note: If you drag your text off the edge of the FX monitor and can no 
longer access it, you can click the Center button on the Text page to 
move the text back to the center. Then reposition it to the desired 
location.
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How text moves between keyframes is controlled by the setting of the 
Interpolation pop-up on the Text page. The following table describes 
the pop-up settings.

Choosing a Text Color
Radius EditDV Unplugged provides a selection of colors for you to use 
with text. You select a text color using the Color Swatch on the Text 
page. You can also create a color gradient for the entire text object. 

To choose a text color: 

1. Point to where the two color squares (the Color Swatch) overlap.

2. Press and hold the mouse button to display the Radius EditDV 
Unplugged color palette.

The pointer changes into an eyedropper.

Setting: Result:
Linear Create movement between keyframe settings along straight line

Spline Create movement between keyframe settings along curved line
creating a smooth, flowing movement. 

Hold Hold settings from one keyframe until the next keyframe and us
the space of only one frame to jump to the next settings. 

Use these color 
squares to select 
a text color
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3. Drag the eyedropper to the color you want to use.

If you want to match a color in your video, drag the eyedropper over 
the color in the Monitors window.You see the color in the Color 
Swatch change continuously as you move the eyedropper.

4. Release the mouse button.

The eyedropper picks up the selected color and uses it for your text. 
You see the text color change immediately in the FX monitor.

Note:  You can also use the Apple Color Picker to choose a color by 
clicking in the overlap area of the color squares.

Some Apple Color Picker options
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Creating a Color Gradient
You can create a color gradient for your text using the two squares in the 
Color Swatch separately. 

To create a color gradient: 

1. Select the first color for the gradient by pointing to the top 
square of the Color Swatch, outside the overlap area.

2. Press and hold the mouse button to display the Radius EditDV 
Unplugged color palette.

The pointer changes into an eyedropper.

3. Drag the eyedropper to the color you want to use.

If you want to match a color in your video, drag the eyedropper over 
the color in the Monitors window.

4. Release the mouse button.

The selected color appears in the top square.

5. Select the second color for the gradient by using the same 
procedure to select a color from the bottom square, again 
outside the overlap area.

The selected color appears in the bottom square. The overlap area re-
flects the combination of the two colors.

6. Select a direction for the gradient from the Direction pop-up at 
the right of the checkerboard squares.

In normal preview mode you will see the effect of the gradient setting 
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when you release the mouse button. In Fast mode, click the Snap-
shot button in the Sequencer window to see a snapshot of the color 
gradient in the FX monitor.

Note:  You can also use the Apple Color Picker to choose colors for 
a color gradient by clicking outside the overlap area of the color 
squares.

Selecting an Opacity Setting
Using the checkerboard squares that appear next to the color squares on 
the Text page, you can select an opacity setting or opacity gradient to 
create varying transparency effects in your text. Radius EditDV 
Unplugged is preset to create opaque text.

To change the opacity setting: 

1. Point to where the two checkerboard squares overlap.

2. Press the mouse button.

Radius EditDV Unplugged displays an Opacity control below the 
squares. 

3. Drag the slider on the Opacity control to a different setting.

The lower the setting, the greater the transparency. The higher the 
setting, the greater the opacity. You can see the opacity setting re-
flected in the checkerboard squares. 

In normal preview mode you will see the effect of the opacity setting in 
the FX monitor when you release the mouse button. In Fast mode click 
the Snapshot button in the Sequencer window to see the effect of the 
opacity setting.
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Creating an Opacity Gradient
You can use the same checkerboard squares that you use to select an 
opacity setting for your text to create an opacity gradient. A gradient 
can be used to fade in portions of the text.

To create an opacity gradient: 

1. Select the first opacity setting for the gradient by pointing to the 
top square of the two checkerboard squares, outside the overlap 
area.

2. Press and hold the mouse button to display the opacity control 
and drag the slider to the opacity setting you want to use.

You see the opacity setting reflected in the top square.

3. Select the second opacity setting for the gradient by using the 
same procedure to select a setting from the bottom square of the 
two checkerboard squares, again outside the overlap area. 

You see the opacity setting reflected in the bottom square. The over-
lap area reflects the gradient between the two settings.

4. Select a direction for the gradient from the Direction pop-up at 
the right of the checkerboard squares. 

In normal preview mode you will see the effect of the opacity gradi-
ent setting in the FX monitor when you release the mouse button. In 
Fast mode click the Snapshot button in the Sequencer window to see 
a snapshot of the opacity gradient in your text in the FX monitor.
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Selecting a Softness Setting
You can use the Softness control to give text sharp, distinct edges or soft, 
blurred edges. You can keyframe softness to gradually change your text 
from one setting to another.

To select a softness setting: 

• Drag the slider on the Softness control to the desired setting.

As you drag the slider on the Softness control, you can see the num-
ber in the Softness box change.You can also type the exact setting 
you want to use into the Softness box.

At a setting of 0, the edges of text are sharp and defined and text will 
tend to look alaised, to remove this edge set the softness to at least one. 
At a setting of 10, the edges are blurred and undefined. At a setting of 
50, the text is so blurred as to be nearly invisible. In normal preview 
mode you will see the effect of the softness setting on the FX monitor 
when you release the mouse button. You can also click the Snapshot 
button in the Sequencer window to see a snapshot.

Adding a Text Shadow
You can add a drop shadow to text, choose a color or color gradient, an 
opacity setting or opacity gradient, and select a softness setting. You can 
determine the apparent position of the shadow’s light source by setting 
a direction and distance for the shadow. 

To create a shadow behind text: 

• Click the Shadow button on the Text page. 

A shadow appears behind your text, offset below and to the right of 
the text. The selection box shifts down and to the right to indicate 
that the shadow is selected. 

You choose color and opacity, create gradients, and select a softness 
setting for a shadow the same way you choose these settings for text. For 
more information, see “Choosing a Text Color” on page 186, “Creating 
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a Color Gradient” on page 188, “Selecting an Opacity Setting” on 
page 189, “Creating an Opacity Gradient” on page 190, and “Selecting a 
Softness Setting” on page 191.

Selecting a Text Shadow

When you first create a shadow, it is selected. If you deselect your 
shadow by making changes to your text, you can select it again at any 
time.

To select a text shadow, do one of the following:

• Click directly on the shadow outside the selection box for the 
currently selected text object.

• Press Option and click the shadow. 

Positioning a Text Shadow

Although a shadow initially appears offset below and to the right of its 
text, you can place the shadow anywhere in relation to the text. You can 
also keyframe the position of the shadow independently of the text. This 
is useful when creating 3D-motion effects.

To reposition a shadow behind text: 

• With the shadow selected, drag it to a new position behind its text.

As you drag the shadow, you can see the Direction dial and the num-
bers in the Direction box change and the position of the shadow 

Check this box to
create a shadow
behind your text

Set the distance
of your shadow

from your text

Set the softness 
of the shadow

Set the direction 
of the shadow 
relative to the 
text
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change in the FX monitor. You can also drag the pointer on the Di-
rection dial to reposition the shadow. If you want to use a decimal 
number for the setting or if you know the exact setting, you can type 
a number in the Direction box and press Enter. You then see the 
shadow at its new position in the FX monitor.

For example, suppose you create the following keyframes: 

Radius EditDV Unplugged calculates progressive values to move the 
text drop shadow between the keyframes, creating the illusion of the text 
moving in relation to the light source creating the shadow.

Note: To create a glow behind your text, choose a color for the glow, a 
softness setting near 10, and a setting distance of 0.

Choosing a Distance Setting

When you first create a shadow, its distance setting from the text is 5. 
You can change the preset distance setting for the shadow to one of your 
choice. 

To change the distance setting for a shadow: 

• With the shadow selected, drag the slider on the Distance control to 
a new setting.

As you drag the slider on the Distance control, you can see the num-
ber in the Distance box change. If you know the exact setting or if 
you want to use a decimal number, you can type a number in the 
Distance box and then press Enter to see the new setting.
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Creating a Background Behind Text
You can create titles and other text on top of program clips, or you can 
create solid backgrounds behind text. The background can totally cover 
the frame behind the text, or it can be a rectangle or oval between the 
text and a video clip. 

You use the Background page for the Titling filter to create a background 
behind text. You can also create colored graphics objects with no 
associated text and use the objects to create mattes when layering video.

To display the Background page for the Titling filter: 

• Click the Background tab at the top of the Controls window.

You see the Background page.

Returns Background page to 
the preset values

Click here to 
create a 
background

Choose the 
shape of the 
background

Click here to 
create a 
shadow for the 
background

Choose color, 
opacity, and 
create 
gradients



Creating a Background Behind Text
To create a background for text: 

• Click the Background checkbox on the Background page.

A blue rectangle is placed behind the text in the FX monitor. The 
background rectangle is surrounded by a selection box with selection 
handles.

In addition to choosing the shape of the background, you can determine 
its position, size, and whether or not its position is locked to your text 
so that it animates as your text animates. You can also choose a color or 
color gradient, an opacity setting or opacity gradient, and a softness 
setting. 

You choose color and opacity, create gradients, and select a softness 
setting for a text background the same way you choose these settings for 
text. For more information, see “Choosing a Text Color” on page 186, 
“Creating a Color Gradient” on page 188, “Selecting an Opacity 
Setting” on page 189, “Creating an Opacity Gradient” on page 190 and 
“Selecting a Softness Setting” on page 191.

By dragging a text background to different positions in the FX monitor 
and creating keyframes at different times, you can cause the background 
to move any way you choose. This works the same as dragging text to 
different positions and creating different keyframes. For more 
information, see “Moving Text Between Keyframes” on page 184. 
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Selecting the Background 
When you first create a background, it is selected. If you deselect your 
background by making other changes to your text, you can select it 
again at any time. 

To select a deselected background, do one of the following:

• Click the background outside the selection box for the currently 
selected text object.

• Press Option and click the background. 

You see the selection box appear around the background.

Positioning the Background
When you first create a background behind text, the background is 
selected. The background is rectangular and positioned behind your 
text. You can drag a text background away from its text to any position 
on the FX monitor. 

To reposition a background rectangle: 

• Drag the background rectangle to a new position. 

When you drag the background rectangle in the FX monitor, you 
can see the H (horizontal) and V (vertical) Position numbers on the 
Background page changing. If you know where you want to position 
your text background or if you want to use decimal numbers, you 
can type numbers in the Position boxes and press Enter.

Although you can drag a text background away from its text, when you 
start dragging text, the background follows it. To drag text away from its 
background you must unlock the text from the background.

To unlock text from its background:

• Click the Lock to Text checkbox on the Background page. 



Creating a Background Behind Text
Choosing a Background Size
You can make your background rectangle any size you want, including 
full screen to cover the entire frame behind your text.

To change the size of a background rectangle: 

• Drag the handles on the background selection box. 

When you drag the selection handles for the background selection 
box, you see the H (horizontal) and V (vertical) Size numbers on the 
Background page changing. If you want to maintain the aspect ratio 
of the background rectangle, press Shift while you drag the selection 
handles. 

You can also type numbers in the Size boxes and press Enter. 

Choosing a Background Shape
You can choose to use an oval shape for a background, rather than the 
preset rectangular shape.

To change a background rectangle to a background oval: 

• Choose Oval from the Shape pop-up on the Background page. 

The background shape changes to an oval.

Adding a Background Shadow
You can add a shadow behind a text background, choose a color for the 
shadow or color gradient, an opacity setting or opacity gradient, and 
select a softness setting. You can also determine the position of the 
shadow’s light source by choosing a direction setting and distance 
setting for the shadow. 

To create a shadow behind a background: 

• Click the Shadow button on the Background page. 

A shadow appears behind your background, offset below and to the 
right. The selection box shifts down and to the right to indicate that 
the shadow is selected. 
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You choose color and opacity, create gradients, and select a softness 
setting for a background shadow the same way you choose these settings 
for text. For more information, see “Choosing a Text Color” on 
page 186, “Creating a Color Gradient” on page 188,“Selecting an 
Opacity Setting” on page 189, “Creating an Opacity Gradient” on 
page 190, and “Selecting a Softness Setting” on page 191.

Selecting a Background Shadow

When you first create a shadow, it is selected. If you deselect your 
background shadow by making other changes to your text, you can 
select it again at any time.

To select a background shadow, do one of the following:

• Click the shadow somewhere outside the selection box for the 
currently selected text object.

• Press Option and click the shadow. 

You see the selection box appear around the background shadow.

Positioning a Background Shadow

Although a shadow initially appears offset below and to the right of its 
background, you can place the shadow anywhere in relation to the 
background. 

To reposition a shadow behind a background: 

• With the shadow selected, drag it to a new position behind the text 
background.

As you drag the shadow, the Direction dial and the numbers in the 
Direction box change. You can also drag the pointer on the Direc-
tion dial to reposition the shadow. Or, you can type a number in the 
Direction box and then press Enter to see the shadow at its new po-
sition in the FX monitor.

Choosing a Distance Setting

When you first create a background shadow, its distance setting from its 
background is 5. You can change this preset to one of your choice. 



Setting the Master Controls
To change the distance setting for a background shadow: 

• With the shadow selected, drag the slider on the Distance control to 
a new setting.

As you drag the slider on the distance control, the number in the 
Distance box changes. You can also type a number in the Distance 
box and then press Enter to see the background shadow at its new 
distance setting in the FX monitor.

Setting the Master Controls 
You use the More page for the Titling filter to choose settings that affect 
your title as a whole including all shadows and backgrounds. This page 
also provides controls to rotate text.

To display the More page for the Titling filter: 

• Click the More tab at the top of the Controls window.

You see the More page.

Returns More page 
to the preset values

Choose 
settings that 
affect the title 
as a whole

Choose a 
rotation angle 
for text
199



CHAPTER 9: CREATING TITLES                                       

200
Choosing a Master Opacity Setting
The Master Opacity control lets you control the overall opacity of your 
entire title. Using this control and setting keyframes, you can fade your 
title and all its shadow and background components in or out together.

To select a master opacity setting: 

• Drag the slider on the Master Opacity control to a different setting.

The lower the setting, the greater the transparency. The higher the 
setting, the greater the opacity. 

In normal preview mode you will see the effect of the opacity setting 
when you release the mouse button. To see a snapshot of the effects of 
the opacity setting in the FX monitor, click the Snapshot button in the 
Sequencer window.

Choosing a Composite Mode
The Composite Mode setting lets you either place your text over video 
or place your text into an Alpha channel and play your video through 
the text. The preset value, RGB, indicates you want to place text over a 
video clip or background.

To place your text in an Alpha channel: 

• Choose Alpha from the Composite Mode pop-up on the More page.

If you are using one video track when you choose Alpha, you see 
your video clip through your text letters and black everywhere else. 
If you have video in two video tracks, use the Titling filter with the 
second track, and then choose Alpha, your second video track shows 
through the text letters and first video track can be seen everywhere 
else. 

When you choose Alpha from the Composite Mode pop-up, all text 
attributes are ignored since the text itself is not displayed. However, the 
text border and background continue to be shown.



Setting the Master Controls
For example, the following shows a title placed over a clip with RGB 
selected as the composite mode.

With Alpha selected as the composite mode, it looks like this: 
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Inverting Text and Video
You can reverse the characteristics of your text with the video clip 
behind it so that your clip is tinted the color of the text and the video 
shows through the text characters. 

To invert text and video: 

• Click the Inverse button on the More page.

For example, suppose you create a title over a clip like this:

If you click the Inverse button, you see the following:



Setting the Master Controls
Rotating Text
You can rotate your text to any angle by using the Rotation control on 
the More page. 

To rotate text:

• Drag the pointer on the Rotation dial until your text is positioned 
where you want it. 
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As you drag the pointer on the Rotation dial, you see the number in 
the Rotation box change and your text rotate in the FX monitor. You 
can also type a number in the Rotation box and then press Enter to 
see the new angle of rotation in the FX monitor.



Detaching Source Clip Media
Chapter 10: Managing Disk Storage

Desktop nonlinear video editing requires tremendous disk storage. To 
assist you with managing the large files necessary when editing, Radius 
EditDV Unplugged provides a method for managing disk files from 
within your project. 

Detaching Source Clip Media 
When a movie file is used in a project, the project contains a reference 
to the external disk file. The external file is said to be attached to the 
project. EditDV Unplugged provides commands for determining if clips 
are used in your project, detaching them, and optionally deleting them 
from disk if you no longer need them and wish to free up the disk 
storage for other purposes. When you detach a clip from your project, 
EditDV Unplugged retains a reference to its name in the Project 
window. If you wish to completely remove the clip and its reference 
from your project you can delete clips from a bin using the Clear 
command in the Edit menu, or the Delete key. For more information on 
deleting clips see, “Deleting Clips From a Bin” on page 56.

Note: Be very careful if you remove media from your hard disk while in 
the Finder. There is no easy way for Radius EditDV Unplugged to 
retrieve that media.

To detach and optionally delete source clip media from your 
project:

1. Click a source clip in the Project window to select it.

Shift-click multiple clips to select them, or choose Select All from 
the Edit menu to select all of the clips in a bin.
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2. Choose Detach Clip Media from the Edit menu.

The Detach Options dialog box appears.

3. Click the “Only detach clips that are not in use” checkbox. 
Generally you want to detach only clips that you are not using in 
your program.

If you are cleaning up your hard drive and want to detach the clips 
you haven’t used in your program select the “Only detach clips that 
are not in use” checkbox. It is possible to detach clips that are in use, 
but they must be reattached or removed from your program before 
you can properly update your Program tracks or play your program.

4. If you want EditDV Unplugged to delete the movie files from 
your hard disk, click the “Delete media files from Disk”
checkbox. 

You can optionally choose to leave the source files on your hard disk 
for use in other projects, even though they will be removed from this 
project.

5. Click OK.

Note: If media files are not deleted, they can be reattached to the project 
(see “To Reattach Clip Media” later in this chapter) or deleted by 
locating them in the Finder and dragging them to the Trash.

Warning: Before deleting media files from disk, be aware of all the 
places they may have been used. If media files that have been used in 
several projects are removed from disk, they are no longer available for 
any of those projects.



Reattaching Clip Media
Reattaching Clip Media
If media is not deleted when detached it can be reattached to the source 
clip information in the Project window log. You may want to reattach 
media if you need to extend your program with previously unused 
media. 

To attach source clip media:

1. Click a source clip in a Project window bin to select it.

2. Choose Attach Clip Media from the Edit menu.

A dialog box appears.

3. Find and select the media file to be attached. Click Open. 

Radius EditDV Unplugged attaches the media file to the selected 
source clip.

Reclaiming Storage from Unused Clips
The Clean Up Bin command in the Edit menu deletes all of the clips in 
the current bin that are not in use in your project. This command 
removes all references to these clips from your project and removes the 
files from disk. 

Note: If these files are used in other projects, those projects will not be 
able to play or render.

The Clean Up Bin command is especially useful for removing files from 
the Program bin that are no longer in use. As you update your Program 
tracks, files are created that contain the results of any effects you have 
added to your program. By applying the Clean Up Bin command to the 
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Program bin, any old Program clips that have been overwritten during 
editing will be automatically removed from your project and your hard 
disk.

To clean up a bin:

1. Click the bin name to make it the current bin.

2. Choose Clean Up Bin from the Edit menu.

A warning dialog box appears. 

3. Click Delete.

All clips in the current bin that are not in use by your project will be 
removed from the project and deleted from your hard disk.



Printing to Videotape From the Program Tracks
Chapter 11: Creating Final Output

Radius EditDV Unplugged includes a Print to Video component for 
Radius MotoDV and Apple FireWire Systems. This component is used 
to output your final program via FireWire to DV videotape. Before a 
program can be printed to videotape, however, all of the operations that 
you have specified via transitions, filters, and layering must be 
integrated to create a final movie. Radius EditDV Unplugged renders a 
final movie from the video and audio source clips using your 
instructions contained in the applied transitions and filters. The end 
result is a single playable media unit, the final product you will print to 
videotape—a video program with all the video clips, special effects, and 
audio media working together to convey your message.

Use the Save Program Movie command in the File menu to create a 
stand alone self-contained DV movie of your program track that may be 
imported into other QuickTime applications for further processing.

Printing to Videotape From the Program Tracks
Once the program tracks are fully updated the program can be reviewed 
or recorded to videotape. When printing to videotape, be sure to have 
the videotape equipment properly connected to your computer 
according to the instructions that accompanied it. For more information 
on using program tracks, see “Using Program Tracks” on page 79.

To record your program to videotape with Radius MotoDV:

1. Place the eye icon on the Video Program track and the ear icon 
on the Audio Program track to select them for playback, and 
mute all other audio tracks.
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2. Choose Print to Video from the File menu and Radius DV PTV 
from the submenu (or press command-p).

The DV Player dialog box appears.

3. Select the settings you wish to use for playback.

Specify whether you want to play the clip once or multiple times. 
Specify the audio format. The Consumer setting creates unlocked 
audio and the Pro setting locked audio. Enter the number of seconds 
to pre-roll your videotape and how many seconds of black or color 
bars to output onto the tape before and after your movie.

4. Press the Shift key to enable the Record button and click Record 
to record your tape, or press Play to play it only.

If you pressed Record your DV device will be placed into record 
mode and your movie will then be played after the delay you specify. 
If you clicked Play, it will playback immediately without first putting 
your DV Device into record mode.

Note:  Be sure that you have a blank, write enabled tape in your DV 
device before beginning to record.

To record your program to videotape with Apple FireWire:

1. Place the eye icon on the Video Program track and the ear icon 
on the Audio Program track to select them for playback, and 
mute all other audio tracks.

2. Choose Print to Video from the File menu and Apple DV PTV 
from the submenu.

Choose the
type of deck

you are
recording to



Saving a Program Movie
Note: EditDV Unplugged is configured by default to use the Radius DV 
Player when pressing command-p. To change the default to Print to 
Video for Apple FireWire, remove the Radius DV Player plug-in from 
the Print to Video folder (in the Plug-ins folder in the Radius EditDV 
Unplugged folder).

A progress dialog box appears.

3. Your video and audio will be sent out over the FireWire to your 
DV device.

If you have a video monitor attached to your DV device you will see 
and hear your program.

4. To record your program to tape you must manually put your DV 
device into record mode and then select Print-to-video.

Note:  Be sure that you have a blank, write enabled tape in your DV 
device before beginning to record.

Saving a Program Movie
A Program Movie is a version of the rendered audio and video clips, 
placed in the audio and video program tracks. It can be saved as a 
separate file that is independent of your project. While in your EditDV 
Unplugged project the Program tracks refer to your source clips and to 
the rendered material on your media drive. If you wish to move the 
project to another hard drive, you must move all of the source material 
with it in order for it to play properly.

You can, however, save your final program out to a separate file that 
does not refer to your source clips. This file is created by copying all 
necessary frames from source clips to the new file to make a self-
contained QuickTime movie. This movie can then be played 
independent of the project and any source clips.
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To create a self-contained Program Movie:

1. Place the eye icon on the Video Program track and the ear icon 
on the Audio Program track to select them, and mute all other 
audio tracks. 

2. Select the portion of your program that you want to output to a 
separate file.

Use the in and out points to specify part or all of the program. See 
“Selecting Part of a Program” on page 70 for more information on 
selecting portions of your program from the sequencer.

3. Choose Save Program Movie from the File menu.

The Save Program Movie dialog appears.

4. Enter a name for the new file in the standard file dialog. Click 
Save.

A progress bar will appear on your computer monitor while the mov-
ie is being made self-contained.

When the file has been created it will be opened in a movie player 
window inside Radius EditDV Unplugged, with the first frame of the 
Program movie showing. This movie may be output using Print to 
Video or played using the DV Player application from your desktop.

Note:  The length of a self contained movie is currently restricted by 
the operating system to two gigabytes, which is approximately nine 
minutes of video when using DV format.

Enter the name
for the self-

contained movie.



Appendix A: Glossary

Note: Some of the terms listed may refer to features in Radius EditDV 
that are not included in Radius EditDV Unplugged.

3-point edit Marking three of the four points needed to place a source clip 
into a program and allowing Radius EditDV Unplugged to 
calculate the fourth point. For example, an editor identifies an 
In and Out point in the source clip and an In point in the 
program and allows Radius EditDV Unplugged to calculate the 
Out point in the program. This technique allows for complex 
multi-track synchronized video/audio editing.

4-point edit Marking all four points to place a source clip into a program. 
The speed of the source clip is adjusted (speeded up or slowed 
down) to fit the space allowed for it in the program.

action safe area Approximately 90% of a the video frame, where action will be 
visible on a standard display.

alpha channel Information attached to each pixel that represents how that 
pixel is to be blended with background.

analog media The term used to refer to the media found on traditional 
videotape recordings.

animation Any change of a parameter over time. Generally refers to a 
change in position of the video frame, moving the video over a 
background while it plays.

anti-aliasing The process of smoothing the edges of graphics and text to 
prevent flicker and jagged edges.

Assemble Edit A method for building a videotape in which a series of clips are 
placed one after the other to create, or assemble, a program.

back-timing Using a 3-point edit to mark two out points and one in point, 
allowing the computer to match up the two out points and 
calculate the remaining in point. For example, marking an in 
and out point on a source clip and an out point in a program 
and allowing Radius EditDV Unplugged to calculate the in 
point in the program.

Band wipe Transition that produces the effect of displaying an incoming 
clip as alternating bands that eventually cover the outgoing clip. 

Barn Door wipe A transition that opens or closes the first frame of an incoming 
clip over the outgoing clip as if it were two sliding doors. 
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bin A location for storing and organizing clips in the Project 
window.

Character Generator 
(CG)

The equipment used in a linear editing suite to create titles or 
other text on video. (Radius EditDV Unplugged provides the 
Titling Filter for creating text)

Chroma Key filter A Radius EditDV filter that allows for a selected color in a clip 
to be made transparent. It is generally used to superimpose one 
clip on another.

clip A set of contiguous frames beginning at a designated In point 
and ending at a designated Out point. 

compression The digital representation of media in an efficient storage 
format. For video, motion-JPEG is often used. Compression 
may be lossy in that the original picture cannot be 
reconstructed exactly.

Color Adjust filter A Radius EditDV Unplugged filter that produces a change in 
the color aspects of a clip by allowing adjustment of individual 
channels.

Color Replace filter A Radius EditDV filter that produces a change in the color of 
objects or areas within a clip based on their hue values.

crawl The gradual movement of text across a clip. An effect produced 
by using the Radius EditDV Unplugged Titling filter and key 
frames.

Cross Fade Audio 
transition

A Radius EditDV Unplugged transition that causes the end of 
one audio clip to fade out, while the beginning of the next clip 
fades in.

cut An abrupt transition between two clips. The first frame of the 
incoming clip immediately follows the last frame of the 
outgoing clip. 

cut point The position of a cut relative to an overlying transition.

device control 
software

A software module that controls a video deck to allow the 
capture of source clips to the hard drive of a computer. 

digitize To convert an analog video or audio signal into a digital signal 
that can be used by a computer.

Dissolve transition A transition in which the end of one clip gradually blends with 
the beginning of the next. 

Note: Some of the terms listed may refer to features in Radius EditDV 
that are not included in Radius EditDV Unplugged.



drop frame timecode Timecode that is accurate relative to actual video running time. 
The numerical reference drops two numbers every minute to 
allow for the fact that there are actually 29.97 frames of video 
per second, rather than 30 frames per second.

drop shadow A shadow that is offset from an object or text in a video.

DVE effects A digital video effect (DVE) is created by taking any existing 
video source and manipulating its position within the video 
frame. In Radius EditDV Unplugged this is accomplished by 
using the PZR and PIP filters.

EDL Edit Decision List. A computer generated list containing 
information about a specific program, the SMPTE timecodes 
and options chosen during production. It is used to inform an 
editing system of all the parameters involved in the creation of 
that program. An EDL is generally used to assemble a program 
in a traditional video editing suite.

eyedropper A cursor symbol that appears when a Radius EditDV 
Unplugged color box is clicked. It is used to choose new colors 
from anywhere on the screen.

Eliminate A Radius EditDV Unplugged procedure for removing media 
from a video program and also removing the space that the 
media occupied in the program.Using Eliminate forces the 
remainder of the program to adjust accordingly and shortens 
the length of the entire program. Sometimes called a ripple edit.

Erase A Radius EditDV Unplugged procedure for removing media 
from a video program, leaving black space (called filler) in its 
place to maintain the spacing and length of the entire program. 
Sometimes called a non-ripple edit.

Fade filter The Radius EditDV Unplugged filter that raises or lowers video 
levels in clips. With the Fade filter a clip will change over time 
to all one color or black (fade out); or will gradually develop 
from a color or black (fade in).

filler Blank space added to the Timeline in the course of editing a 
program.

filter A computer software module used to process and modify digital 
video for adding special effects to a program.

Note: Some of the terms listed may refer to features in Radius EditDV 
that are not included in Radius EditDV Unplugged.
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flow In Radius EditDV Unplugged the act of transferring video and 
audio tracks from a source clip into tracks in the Sequencer 
window using the Patch Matrix.

fps Frames per second.

force an edit To insert a cut at a desired point in a clip.

frame One complete still image of video media. Video media is made 
up of a series of frames. Each video frame has two interlaced 
fields.

full field A complete video image consisting of two fields of video per 
frame.

FX track A separate track on the Timeline in the Sequencer used strictly 
for creating special video effects with Radius EditDV 
Unplugged filters.

Hold An interpolation setting in Radius EditDV Unplugged that 
maintains settings from one key frame until the next key frame 
and uses the space of only one frame to jump to the next 
setting.

identifier Name or number given to a clip or segment of a video to allow 
for easy recognition of the segment and its contents. 

image resolution A measurement of the quality of a video image based on the 
number of pixels that make up the image. Image resolution in 
Radius EditDV Unplugged is a component of RIQ (Radius 
Image Quality).

In point The SMPTE time code of the specific frame at which a clip 
begins.

Insert Edit Placing a section of a source clip in the Timeline of the 
Sequencer at the position of the Timeline cursor. The media 
currently to the right of the insertion point is moved farther to 
the right to accommodate the insertion of the new clip. 

insertion cursor Double triangles that appear on the FX tracks showing where a 
filter will be inserted.

interesting time A place in a video program where an editorial event occurs, 
such as the beginning of a filter or transition, new clip, or key 
frame.

Interpolation The progressive calculation of a parameter between key frames.

Note: Some of the terms listed may refer to features in Radius EditDV 
that are not included in Radius EditDV Unplugged.



Iris transition A Radius EditDV Unplugged transition that creates the 
appearance of an enlarging opening revealing a incoming clip 
underneath. It is made to look like the iris of the eye opening, 
or enlarging.

jog To move forward or backward in video or audio media by 
playing at slow speed through it. 

JPEG Joint Photographic Experts Group. An international standard 
for still picture data compression. 

kerning The amount of space between text characters. Kerning varies 
between fonts.

keyframe A frame at which a set of specific parameters is assigned. Radius 
EditDV Unplugged automatically calculates differences 
between key frames in a clip and adjusts the frames accordingly. 

key out Removing a section of video by making it transparent by 
creating an alpha channel based on color (Chroma Key) or on 
brightness (Luma Key). Chroma and Luma are filters in EditDV.

leading The space between lines of text.

Linear A setting in the Radius EditDV Unplugged Interpolation pop-
up that allows the creation of movement between key frame 
settings along straight lines.

linear editing The traditional form of tape based video editing.

log The numbers, either SMPTE or computer generated (for video 
that doesn’t contain SMPTE timecodes), that Radius EditDV 
uses to identify media. The log also includes additional 
information, such as tape identifiers and clip duration.

Luma Key filter Radius EditDV filter that allows the areas of light or dark in a 
clip to be made transparent, revealing the background clips in 
those regions.

Mirror filter Radius EditDV Unplugged filter that flips frames horizontally 
to create an opposite but identical image.

non-drop frame 
timecode

Timecode that does not compensate for the 29.97 frames of 
video per second of NTSC video, rather than 30 frames per 
second. Each frame is assigned a unique, consecutive SPMPTE 
time code.

NTSC The National Television Standards Committee.

Note: Some of the terms listed may refer to features in Radius EditDV 
that are not included in Radius EditDV Unplugged.
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NTSC signal The standard composite video signal adopted by the NTSC. It 
has a frame rate of 29.97 fps. 

Off Line When no disk file exists for a reference to a clip in a program, 
the file is said to be off line.

On Disk The media file for a clip is stored on a hard drive and referenced 
from within a program.

opacity The degree to which an image is transparent, allowing images 
behind to visually show through.

Out point The SMPTE time code defining the end of a clip. The frame 
with this time code is not included in the clip.

Overwrite Edit Placing a section of a source clip on the Timeline in the 
Sequencer and replacing or “overwriting” that program section. 

PAL Phase Alternating Line. 

PAL signal The most common composite video signal used in Europe. It 
has a frame rate of 25 fps.

pan When used in reference to video, it is the sweeping movement 
of a camera across a scene or the appearance of such movement 
in a video as created by Radius EditDV Unplugged’s PZR filter.

pan setting When used in reference to audio, the setting that determines 
how audio output is divided between left and right speakers.

Patch Matrix The display in the Monitors window that identifies the video 
and audio tracks in the current source clip and the available 
tracks in the Sequencer window. Allows the user to direct the 
flow of the source clip tracks into Sequencer tracks.

picture view A mode of appearance for Radius EditDV Unplugged’s Project 
window. The picture view contains small thumbnails of the 
clips stored in the bins in the Project window.

PIP Abbreviation for Picture in a Picture, a video effect which places 
several complete images on the screen at the same time. Radius 
EditDV provides the PIP filter for creating a picture in a picture.

PIP box The graphic image you manipulate in the FX monitor when 
creating a Picture in a Picture effect. Video in the video track 
immediately above the PIP effect will show in the PIP box once 
the effect is rendered.

Note: Some of the terms listed may refer to features in Radius EditDV 
that are not included in Radius EditDV Unplugged.



pixel A single picture element. The smallest element in a graphic 
image. Pixels are combined with other pixels to make up a 
graphic image. Picture quality increases as the number of pixels 
increase in a measured area of an image.

point A standard measurement unit for type sizes. One point equals 
approximately 1/72 of an inch.

primary source clip A source clip that has media attached to it. The original source 
clip from which secondary source clips and reference clips are 
created.

program A sequence of reference clips arranged in a meaningful order. 
The final result of production with Radius EditDV Unplugged—
a video program.

project A Radius EditDV Unplugged organizational unit containing 
the media units that when incorporated and edited will 
constitute a program. 

project preset Options that define the parameters for the production of a 
program, such as audio sampling rate that are established before 
beginning production.

PZR filter Radius EditDV filter that enables the rotation of clip frames 
around any of three axes, the positioning of a frame in any of 
three dimensions and the control of the point of view through 
perspective adjustments.

QuickTime System software from Apple Computer, Inc. that enables the 
storage, editing, and playing of digitized video and audio media 
on a computer.

Radial Wipe 
transition

A Radius EditDV Unplugged transition that sweeps away the 
outgoing clip with a circular or semi-circular motion to reveal 
the incoming clip.

Radius EditDV 
Unplugged Color 
Palette

Radius EditDV Unplugged’s tool for choosing a desired color 
for use with many of the filters and transitions. A color might 
be chosen to be replaced, to be keyed out, to be changed, etc.

reference clip A clip that Radius EditDV Unplugged creates from a source clip 
when the source clip is placed on the Timeline in the 
Sequencer. A reference clip does not contain any digitized 
media but refers to the digitized source clip. A reference clip 
only exists in a sequence and is the only kind of clip that a 
sequence contains.

Note: Some of the terms listed may refer to features in Radius EditDV 
that are not included in Radius EditDV Unplugged.
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render The processing of a series of individual clips, transitions and 
filters into a single playable media unit.

roll edit An editing process where both outgoing and incoming clips are 
trimmed at a cut point to shorten one while lengthening the 
other to maintain the overall length of a program.

rotate A function of Radius EditDV Unplugged’s PZR filter that 
allows clip frames to be turned on any of three axes. 

scroll Moving text from the bottom to top and continuing off the 
visual boundaries.

scrub To play through an audio or video clip interactively (under 
manual control) to evaluate it or locate a specific event. Radius 
EditDV Unplugged provides a display for observation of the 
audio waveform as it is scrubbed.

secondary source 
clip

A source clip created from a primary source clip, a subclip. It 
contains no media, it only refers to the primary clip.

shuttle To move smoothly, forward or backward, through video or 
audio media at a constant rate.

SkyView A graphic overview of the program in the Timeline. Visually 
relates the current view of the Timeline to the complete 
program.

SMPTE Abbreviation for the Society of Motion Picture and Television 
Engineers. 

SMPTE timecode The timecode used by the SMPTE to identify frames in a 
videotape. Each frame has a unique address in an 
hours:minutes:seconds:frames format. 

source clip A clip that refers directly to physical media. 

splice The physical act of cutting a medium, such as film or audio 
tape, to add new tape to it or take out portions of it. 

Spline A setting in the Radius EditDV Unplugged Interpolation pop-
up that produces movement between key frame settings along 
curved lines; creating a smooth, flowing motion.

Split Edit 

(L-cut or J-cut)

Adjusting synchronized audio or video clips so that one starts 
slightly before or after the other.

step To move forward or backward one frame at a time.

Note: Some of the terms listed may refer to features in Radius EditDV 
that are not included in Radius EditDV Unplugged.



stereo Audio split on two physical tracks, one on the right and one on 
the left.

text box A box surrounding text created by the Titling filter. Allows for 
the text to be moved or adjusted in one piece.

text object Radius EditDV Unplugged provides this option that allows you 
to work with text produced by the Titling filter as one unit, 
instead of individual text characters. 

text view A mode of appearance for Radius EditDV Unplugged’s Project 
window. The text view contains names, descriptions, and 
numbers of clips stored in the Project window bins.

Timeline The graphic representation of a program displayed in the 
Sequencer window. 

Tint filter Radius EditDV Unplugged filter that produces the appearance 
of viewing video through colored glass.

title safe area The standard area of a video in which text can be seen on a 
television screen.

Titling filter Radius EditDV Unplugged filter that produces text in a video in 
various fonts, sizes, and colors. Text can also be enhanced by 
using the filter’s ability to create different color and opacity 
gradients, borders, shadows, and backgrounds. 

track A horizontal band across the Sequencer window that 
graphically represents a series of clips in your program. The 
Sequencer window has multiple tracks containing different 
types of media.

transition The change from one clip to another in a video program. 

trim handles The frames before and after the In and Out points for a source 
clip to allow for trimming and transitions.

Venetian Blind wipe A Radius EditDV Unplugged transition that produces the effect 
of having an outgoing clip displayed in strips over the incoming 
clip. The strips open, like a Venetian blind, to reveal the 
incoming clip.

Wipe A type of transition that uses a moving edge to replace the 
current clip to reveal the next clip. 

Note: Some of the terms listed may refer to features in Radius EditDV 
that are not included in Radius EditDV Unplugged.
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Zoom One of the functions of the Radius EditDV PZR filter that 
simulates the effect of having a camera move in very close to 
the subject, objects, or areas in a frame; or move away from the 
subject and display a wide view of the entire frame.

Note: Some of the terms listed may refer to features in Radius EditDV 
that are not included in Radius EditDV Unplugged.



Menu Shortcuts
Appendix B: Radius EditDV Unplugged 
Shortcuts

Most actions in Radius EditDV Unplugged can be performed either 
with the mouse or by using the keyboard. Menu commands have keys 
that initiate the command when used with the Command key. The 
buttons in Radius EditDV Unplugged windows can be activated by a 
mouse click or a keystroke. The following sections describe shortcuts for 
using the keyboard with Radius EditDV Unplugged. 

Menu Shortcuts
Many of the menu items in Radius EditDV Unplugged can be accessed 
directly from the keyboard. To use the shortcut keys for menu 
commands, hold down the Command key and press the key indicated 
in the menu to the right of the menu item. For example: to open a file 
press Command-o, to save a project press Command-s.

Keyboard Layout
The following table illustrates where commands are located on the 
keyboard. Pressing the key executes the same command as clicking the 
button in a window with the corresponding icon.

edit

edit
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Sequencer Window Shortcuts

Result Action

Add/delete marker on current clip at Timecursor position Command - m
Animate the selected effect in the FX monitor 2 (two)
Automatic Snapshot when changing the current time Shift - click in the timeline ruler
Bring clip up in source monitor Double-click clip in Sequencer
Bring up control window and move time to closest keyframe Double-click any filter or transition
Bring up filter length dialog Option - double-click a filter
Bring up speed dialog Option - double-click source clip
Bring up transition settings dialog Option - double click a transition
Clear In point u
Clear Out point p
Clear In and Out points [
Eliminate currently selected area of program and collapse 
the space underneath

. (period)

Erase currently selected area of program and leave filler / (forward slash)
Eliminate currently selected object and collapse 
the space underneath

Option - delete

Erase currently selected clip or filter Delete 
Find Frame Command - ]
Insert or Overwrite only video or audio Option - drag clip from Source mon-

itor or Project window to Sequencer
Mark In point i or F1

Program 
monitor

Erase

FX monitor

Trim monitor

Eliminate

Next interesting time

Next trim

Previous trim

Animate
Snapshot

Previous interesting time

Move to
In point

Move to Out point

Clear In point

Mark In point

Mark Out point

Clear Out point Clear In and Out points
Mark In and Out

Move backward ten

Move backward one
Play/Stop

Move 
forward ten

Move 
forward one



Sequencer Window Shortcuts
Mark Out point o or F2
Mark In and Out points ]
Mark the in point for your selection Control - click in selection area 

below timeline ruler
Mark the out point for your selection Option - click in selection area below 

timeline ruler
Mark the in point then the out point for your selection Click in selection area below time-

line ruler
Move backward one (1) frame Left arrow or k
Move backward ten (10) frames j
Move forward one (1) frame Right - arrow or l
Move forward ten (10) frames ;
Move Eye to track V1 Control - z
Move to beginning of program Home key
Move to end of program End key
Move to In point t
Move to Out point y
Move Timeline one page to right Page up key
Move Timeline one page to left Page down key
Next interesting time Option - right arrow or 5
Previous interesting time Option - left arrow or 4
Next Trim point F4
Previous Trim point F3
Override snap to interesting time while dragging Timecursor Hold control key while dragging 
Override snap to interesting time while dragging clips Hold control key while dragging 

clips
Play/stop program Spacebar or d
Play Enable/Disable track A1 Control - b
Play Enable/Disable track A2 Control - n
Render Enable/Disable track V1 Option - z
Render Enable/Disable track A1 Option - b
Render Enable/Disable track A2 Option - n
Render every frame in an effect Shift - right arrow, Shift-drag cursor
Scrub program sound Command - drag in timeline
Scrub mode to normal Command-7
Scrub mode to jog Command-8
Scrub mode to shuttle Command-9
Scrub while stepping on or off Command-0
Select track above the currently selected track Up arrow
Select track below the currently selected track Down arrow
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Monitor Window Shortcuts 

Snapshot of the current position of the Timeline cursor 1 (one)
Solo activate, render or audio play a track Option - click on appropriate button
Toggle sequencer zoom between close-up and current setting Option - click in the time scale
Zoom-in -
Zoom-out +

Results Action

Add/delete marker on current clip at Timecursor position in Pro-
gram

Command - m

Animate effects motion 2
Clear In point u
Clear Out point p
Clear In and Out points [
Display volume control to allow overdriving the audio beyond 
100%

Hold Shift key while pressing 
Audio Adjust button

Display Source/Program monitor F13
Display FX monitor F14
Display Trim monitor F15
Edit \ or Enter
Exit DV Player Command-.
Mark In point i or F1
Mark Out point o or F2
Play d or spacebar
Play in selection f
Play to mark g

Play Selection

Play/Stop Step Forward One

Step Backward One

Step Backward Ten Play to Mark

Step Forward 
Ten

Loop 

Audio Adjust 

Move to In point

Move to Out point

Clear In point Mark In point

Mark Out point
Clear Out point

Clear In and 
Out points



Monitor Navigation Shortcuts
Monitor Navigation Shortcuts

Trim Window Shortcuts

Play full screen Option - d or option - spacebar
Play full screen in selection Option - f
Play full screen to In or Out point Option - g
Play/stop clip Spacebar
Set to edit in Insert mode q
Set to edit in Overwrite mode w
Snapshot 1(one)
Toggle between Source and Program monitor Tab

Results Action

Move to In-point t
Move to Out-point y
Move to next interesting point Option - right arrow
Move to previous interesting point Option - left arrow
Step forward one (1) frame Right arrow or l
Step backward one (1) frame Left arrow or k
Step forward ten (10) frames ;
Step backward ten (10) frames j

Results Action

Move to 
next Trim

Play through Trim
Trim 
outgoing

Frames to play 
before and after 
trim point 

Move to 
previous Trim

Trim one 
frame left

Trim ten 
frames right

Trim 
outgoing

Trim one 
frame right

Trim 
incoming

Trim 
incoming

Roll Edit
Trim ten 
frames left
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Sound Monitor Window Shortcuts

Filter Shortcuts

Result Action

Move to next Trim point F4
Move to previous Trim point F3
Play through trim F12
Play through trim full screen Option - F12, Option - spacebar
Trim outgoing clip F9
Trim incoming clip F11
Trim both clips (Roll edit) F10
Trim minus ten (-10) frames F5
Trim minus one (-1) frame F6
Trim plus ten (+10) frames F8
Trim plus one (+1) frame F7

Results Action

Change scrub mode to normal Command-7
Change scrub mode to jog Command-8
Change scrub mode to shuttle Command-9
Scrub the sound in jog or shuttle mode Command - drag
Turn scrub while stepping on or off Command-0
Zoom-in Option - click
Zoom-out Control - click

Result Key

Toggle to original color while Color Palette is active Escape



Titling Shortcuts
Titling Shortcuts

Print to Video and DV Player Shortcuts

Result Action

Constrain movement of text horizontally or vertically while mov-
ing

Shift - drag

Constrain the aspect ratio while resizing text Shift - drag
Decrease kerning value by 1 Option - down arrow
Display text edit view Control - click
Increase kerning value by 1 Option - up arrow
Move backward through the text Left arrow
Move forward through the text Right arrow
Move selected object up, down, left or right Up, down, left, or right arrow

Result Action

Access the DVPlayer print to video Command - p
Cancel playback Command - . (period)
Pause/resume playback Spacebar
When Paused
Step back one frame Left arrow
Step forward one frame Right arrow
Fast Rewind Shift - left arrow
Fast Forward Shift - right arrow
Quickly step backwards Control - left arrow
Quickly step forwards Control - right arrow
Move to start of movie Option - left arrow
Move to end of movie Option - right arrow
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Device Control Shortcuts

Results Action

Toggle Play and Pause d or spacebar
Step one-frame back k or left arrow
Step one-frame forward l or right arrow
Begin Capture Command - t
Stop Capture Command - . (period)
Fast play, fast forward Shift-right arrow, Shift-right 

arrow
Fast reverse play, fast reverse Shift-left arrow, Shift-left 

arrow

Move to 
next Trim

 

Play 

Fast forward

Step one 
frame forward

Stop 

Step one frame 
backward

Pause

Capture/Stop 
Capture



Opening a QuickTime Movie
   
Appendix C: Using QuickTime

 

Radius EditDV Unplugged is designed to work seamlessly with DV 
footage and also easily create other types of QuickTime movies. 
QuickTime movies can be viewed in a player window inside of Radius 
EditDV Unplugged or with Apple’s MoviePlayer application. A non-DV 
QuickTime movie can be created by using the QuickTime Movie Player 
application. 

 

Opening a QuickTime Movie

 

Before you open a movie you can see a frame of it in the Preview section 
to the left of the file list in the Open dialog box. Click to select the clip 
and click Create in the Preview area. 

 

To view a clip in a Player window:

 

1.

 

Select Open from the File menu.

 

You see the Open dialog box.

 

2.

 

Select Show Media Only from the pop-up in the Open Dialog. 

 

3.

 

Double-click the clip in the list in the Open dialog box. Or select 
the clip in the list and click Open.

 

The clip is opened in the 

 

player window,

 

 on your computer moni-
tor. Use the buttons and slider at the bottom of the player window 
to play and stop the clip.

Use the Player Size sub-menu in the Window menu to set the size of 
the player window.
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After opening a clip in the player window, you can adjust the window 
size. When you finish reviewing the clip, close the window or add the 
clip to your project.

 

To adjust the size of the player window, do one of the 
following:

 

• Drag the window from the lower right corner to the size you want.

• Choose Player Size from the Window menu, and choose a size from 
the submenu.

 

To close the player window:

 

• Click the Close box in the upper-left corner of the window, or 
choose Close Window from the File menu (or press Command-W).

Choose Open again from the File menu to view more clips.

 

Adding a QuickTime Movie to a Project 

 

A QuickTime movie open in a player window can be added to your 
project. 

 

Adjust the
audio

Click to play and 
stop play

Drag slider 
bar to jog

Click to step backward 
one frame

Click to step 
forward one 
frame



Apple QuickTime Compressors
   

To add a movie in a player window to your project:

 • With the clip in the player window, choose Add to Project from the 
Edit menu (or press Command-J).

The clip information is added to the currently selected bin in the 
Project window and the player window closes.

 

Apple QuickTime Compressors 

 

Apple Computer provides several compressors/decompressors 
(CODECS) with QuickTime. If you are creating a program to use on 
CD-ROM or in a presentation that needs to play on a variety of 
different Macintosh models rather than a full-frame video program, you 
may want to use one of these. 

When working with compressors/decompressors, there are a number of 
trade-offs between the size of a program, how fast it plays (in frames per 
second) and the sound quality, limited by the speed of your computer 
and hard disk. To get more quality in one area, you may have to give up 
quality in another. The following sections describe and compare the 
compressors that are part of QuickTime.

 

The Video Compressor

 

The Video compressor was designed to decompress video data quickly 
so that movies can play smoothly on your Macintosh. This compressor 
is best suited for sequences of digitized video data. It is a good choice 
for creating final movies for software playback when you don't have 
time to create a Cinepak program. 

 

The Animation Compressor

 

The Animation compressor is best suited to computer graphics and 
computer generated movies. It maintains the original video data exactly 
at its highest quality setting and maintains good image quality at lower 
settings, though it loses some of the original data at lower settings. 
Lower quality settings maintain a good balance between quality and 
speed. The millions of colors+ option of this compressor should be used 
for storing 32-bit PICT files that contain alpha channel information. 
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The Cinepak Compressor

 
The Cinepak compressor enables each frame of video to occupy less 
storage space than most other compressors, while retaining relatively 
high quality. It decompresses information smoothly and efficiently, and 
is ideal for making final production programs for playback in computer 
based presentations or CD-ROM applications. It is asymmetric in that it 
requires significantly more time to compress than to play back.

 

The Graphics Compressor

 

The Graphics compressor is best suited for 8-bit still images or when 
high compression ratios are more important than playback speed. It is 
not typically used for video.

 

The Photo-JPEG Compressor

 

The Photo-JPEG compressor implements a compression technique 
developed by the Joint Photographic Experts Group (JPEG). It is best 
suited for still images, but may be used for video programs. However, 
due to the decompression speed of this compressor, video programs 
generally don't play smoothly. You might want to make a JPEG program 
as a way to store a program with good quality, but you probably want to 
convert the program to another compressor before playing it.

 

YUV Codec Compressor

 

A YUV compressor/decompressor component stores data in YUV 4:2:2 
format. The compression algorithm does not maintain the original 
video data exactly, but the image quality is extremely high. The 
compression ratio is approximately 2:1 and does not support frame 
differencing. The YUV Codec compressor typically gives better results 
than the Video compressor. In addition, it is also useful as an 
intermediate storage format if you are applying multiple effects or 
transitions to an image. 



Apple QuickTime Compressors
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Index

 

Symbols

Numerics
3-point edit 91
4-point edit 93
A
action safe area 178
activating track for editing 87
activating/deactivating

Monitors window ??–19
Sequencer window tracks 68
source clip tracks 66

Alpha channel 200
Animate button 156
Animate command 156
Animation compressor 233
Apple Color Picker 119, 161, 181
aspect ratio

with text 184
with text background 197

Attach Clip Media command 207, 208
audio

editing clips in Sequencer window 138
moving clips into program 137
playing program tracks 138
reviewing in Source monitor 131
selecting a pan setting 143
selecting tracks to play 138
setting volume in Source monitor 132
setting volume in the Sequencer 142
using the Sound Monitor 133

audio clips 131–147
moving clips into the Timeline 137
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shuttle while scrubbing in the Source monitor 136
stepping in the Source monitor 135
to shuttle in the Sequencer 140
viewing sound waveforms in the Sequencer 139

audio scrubbing 134
jog while scrubbing 136, 140
stutter scrub 135

B
background shadow

creating 197
distance setting for 198
positioning 198
selecting 198
size, changing 198

background, text
creating 195
maintaining aspect ratio 197
positioning 196
selecting 196
selecting shape 197
size, changing 197

Band Wipe
choosing width of bands 126
described 125

Barn Door Wipe 125
bins

changing view in 48
creating 46
deleting 47
deleting source clips from 56
displaying contents as pictures 50
moving clips between 54
organizing source clips in 46
picture of text and picture view 8
picture of text view, picture view 8
renaming 47



  

selecting 47
black and white, creating 163
border

in Iris transitions 121
in Wipe transitions 124
selecting thickness in transition 122
with text 180

Brightness setting 159
Broadcast Safe setting 159
C
Capture menu 38
Capture Options 35
Capture Window 34
Capturing 33
Capturing clips 38
CinePak compressor 234
circular 123
clip sync 98
clips, 

 

See

 

 source clips, reference clips
color

adjusting with ColorAdjust filter 157
for Dissolve transition 117
for Fade filter 160
for text 186
for text border 180
for Tint filter 163
for transition border 122
gradients in text 188

ColorAdjust filter
Broadcast Safe colors, using 159
described 157
More page 159
RGB page 158

column, for Titling filter text 177
columns in text view 48
Composite Mode settings 200
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Configuring for Device Control 34
Contrast setting 159
control ribbon

Project window 46
Controls window

displaying transition controls 116
with key frames and filters 153

controls window
Titling filter controls 173

copying projects 31
crawling text 185
Create Secondary command 54, 63
credits, creating

 

See

 

 Titling filter
Cross Fade Audio transition 117
cursors

insertion cursor 172
text cursor 172
timeline cursor 64

custom
filters 165
transitions 127

cut
forcing 93
trimming 99

D
deactivating track for editing 87
deleting

 

See also

 

 removing 89
part of a program 89
Project Window bins 47
source clips from bins 56

Detach Clip Media command 206
device control

choosing where to store clips 37
Digitize window ??–39



  

Digitizer window ??–39
digitizing

without device control 38
direction

for text background shadow 198
for text shadow 192
for Wipe transitions 126

Dissolve transition 117
Radius Edit color palette used with 118

distance setting
for text background shadow 199
for text shadow 193

DVE transition 127
E
editing a program

activating track for editing 87
adding filler 88
changing clip speed 94
deactivating track for editing 87
editing audio clips 138
editing clips 91–107
forcing an edit 93
freezing clip frame 96
reversing direction of clip 95
roll edit 105
split edits 106
trimming cuts 99
using a 3-point edit 91
using a 4-point edit 93

Eliminate button 90
Erase button 89
eyedropper 118, 122, 160, 163, 180
F
Fade filter

Blend control with key frames 162
described 160
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filler 88
adding to Timeline 88
synchronizing Sequencer tracks 68

filters
animating 156
application and use of 149
ColorAdjust filter 157
creating custom 165
Custom filters 165
dragging into FX tracks 144, 150
Fade filter 160
introduction to 18
key frames in 154
length, changing 150
Mirror filter 162
position, changing 150
previewing 155
removing 155
Tint filter 163
Titling filter 171

Find Frame command 98
fit-to-fill edit 93
flipping frames 162
folders

choosing for digitizing 37
finding clips in other projects 41

font styles, choosing 175
font, choosing type and size 175
Force Edit command 93
freeze frame 96
FX monitor

introduction 6
previewing filters 155

FX tracks
adding 144, 169
dragging filters into 144, 150



  

G
Gamma setting 159
Get Info command 54
Graphics compressor 234
H
hardware used with Radius Edit 1
High Clip setting 159
horizontal wipes 126
Hue setting 159
I
Import Audio 43
Import audio CD 43
Import PICT 41
Importing 39
In points

clearing in Source monitor 61
setting in Source monitor 61

Insert button 69
inserting

filler space in program 88
source clip tracks into Timeline 69

interesting times, moving to 74
Interpolation methods 186
Introduction to Radius Edit 1
Iris transition

creating border 122
described 119
Macintosh color wheel used with 122
Radius Edit color palette used with 122
reversing 120
selecting softness setting 120
zooming 121

J
justifying text 178
K
kerning text characters 179
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key frames
creating zoom effect with text 184
introduction to 21
moving text with 195
use with any Radius Edit filter 154
with Fade filter 162
with filters 154
with Mirror filter 163
with text 171
with Tint filter 164

L
length, filter 150, 151
Linear Interpolation Method 186
Low Clip setting 159
M
Macintosh color wheel 122
markers, inserting and removing 75
master settings for text 199
Mirror filter 162
monitors

 

See also

 

 Program monitor, Source monitor
Monitors window 5
More page 199
O
opacity gradient, creating 190
opacity setting

for text 189
master setting 200

Out points
clearing in Source monitor 61
setting in Source monitor 61

oval text background 197
Overwrite button 69
P
pan settings 143
Pan/Zoom transition 127



  

Patch buttons 65
Patch Matrix

choosing source clip tracks 66
choosing source clip tracks to use 66
described 65
displaying source clip tracks 65
flowing source clips onto timeline 68
mapping tracks 67
synchronizing Sequencer tracks 68
using Insert 69
using Overwrite 69

Photo-JPEG compressor 234
picture view

changing number of columns 52
changing order of clips 51
choosing 50

player window 231
point 179
positioning

clips on Timeline 70
filters 150
text 178
text background 196
text background shadow 198
text shadow 192
Timeline cursor 74

poster frame 50
preferences

Project Window 50, 52
Sequencer Window 72, 97

presets
font 175
project 10
Project Preset dialog box 10

previewing filters 155
primary source clips 54, 62
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program
assembling in Sequencer window 63
getting closeup view 77
navigating 73
rendering during assembly 80
reviewing final 209
selecting part of 70

Program Clips 81
Program monitor

buttons 78
picture 6
playing rendered section in 82

Program Track 79
program track, expanding 112
project

adding source clips from player window 233
reverting to previous copy 32
saving copy of 31
saving first time 30, 31

project preset 29
project presets

description of Radius Edit presets 10
Project window

picture, introduction 7
preferences 50, 52

Q
QuickTime compressors 233
QuickTime VDIG 38
R
Radial Wipe transition

described 123
reversing 124
selecting softness setting 123
selecting start angle 124

Radius Edit color palette 118, 122, 163, 180, 186, 188
rectangular text background 196



    
reference clips
See also source clips
creating 64
repositioning on Timeline 70

removing
filters 155
part of a program 89

renaming
bins 47
source clips 55

rendering 209–??
changing render preferences 85
enabling/disabling tracks for 81
explanation of 209
overwriting a rendered section 84
playing a rendered section 82
program sections during assembly 79
updating a rendered section 83

reversing
direction of a reference clip 95
Iris transition 120
Radial Wipe transition 124
Wipe transitions 126

reverting to previous project 32
reviewing final program 209
RGB Composite mode 201
RIQ

Appendix C 231
project presets 10

roll edit 99, 105
S
safe areas 178
Saturation setting 159
Save Program Movie 209
Saving 31
saving
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copy of project 31
custom filters 165
custom transitions 127
project initially 30
reverting to previous project 32

scaling text 183
scrolling text 185
secondary source clips

creating in Project window 54
creating in Source monitor 62
defined 54
using to create secondary source clips 62

selecting
audio tracks for playing 138
background text shadow 198
part of program 70
part of program for rendering 80
text 174
text as object 174
text shadow 192
tracks for editing 87
tracks for rendering 81

selection bar 71
Sequencer window

activating/deactivating tracks 68, 87
adding render track 80
assembling program in 63
button bar 71
inserting markers 75
making track visible 78
moving to interesting times 74
picture, introduction 8
removing markers 75
removing track 85
using drop frame time scale display 72
using Skyview 76



      
zooming in and out 76
Set Filter Length command 150
Set Poster Frame command 51
shadow

See also background shadow, text shadow
SkyView 65, 76
snapshot

of filter frame 157
of transition frame 115

Softness control
in Iris transition 120
in Radial Wipe transition 123
in Titling filter 191
in Wipe transitions 124

Sound advance cut 106
Sound Input Settings 36
Sound Monitor

displaying a stereo clip 133
to close 134
using with source clips 133
zooming in and out 134

source clips
See also reference clips
activating/deactivating tracks 66
adding to project 233
assembling into program 63
attaching media to 207
capturing without device control 38
Clip Info window 53
deleting from bins 56
detaching media 205
detaching media from 205
displaying tracks in Patch Matrix 65
dragging into Sequencer Window 69
finding for specific frame 98
flowing into Timeline with Patch Matrix 68
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getting information about 53
moving between bins 54
naming 39
organizing in bins 46
placing in Source monitor 57, 58
reattaching media 207
renaming 55
reviewing in source monitor 57
secondary source clips, creating 54, 62
setting In/Out points in Source monitor 61
using other formats 40

Source monitor
adjusting In and Out points 61
buttons 60
creating secondary source clips in 62
described 58
Edit button 69
picture 6
reviewing source clips in 57, 58
using Patch Matrix 65
using to review source clips 57

spacing text characters
See kerning text characters

Speed command 94
Spline Interpolation Method 186
split edit 106
Start Angle dial 124
Subpixel Positioning 183
subtitles, creating

See Titling filter
synchronizing reference clips 96
T
text

See also Titling filter
appearance 173
background, using 194



  
border 180
color 186
color gradient, creating 188
crawling 185
cursor 172
font styles, choosing 175
font, choosing 175
inverting 202
justifying 178
kerning characters 179, 180
moving 183
opacity gradient, creating 190
opacity setting, selecting 189
placing in Alpha channel 200
scaling 183
scrolling 185
selecting 174
shadow, using 191
softness setting, selecting 191
typing 173
wrap 173

text border
Radius Edit color palette used with 180

text box 176
text color

Radius Edit color palette 186
text color gradient

Radius Edit color palette used with 188
Text page 181
text shadow

creating 191
distance setting for 193
positioning 192
selecting 192, 196
size, changing 193
text background shadow, using 197
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Text Style page 173
text view

changing column widths 49
choosing 53
columns in 48
hiding columns 50

thickness
for text border 181
for transition border 122

Timeline
filling specific amount of space 91
filling specific space with set clip size 93
insertion cursor 70
introduction to 8
Timeline cursor 64

Tint filter 163
Macintosh color wheel used with 164
Radius Edit color palette used with 163

title safe area 178
titles, creating

See Titling filter
Titling filter

background for text 195
Background page 194
background shadow, using 197
border for text 180
color for text 186
color for text border 180
color gradient, creating 188
described 171
entering text 173
font size, choosing 175
font styles, choosing 175
font, choosing 175
how to use 171
Interpolation methods 186



    
introduction to adding text 20
justifying text 178
kerning text characters 179, 180
master settings 200
More page 199
moving text 183
moving text with key frames 195
opacity gradient, creating 190
opacity setting, selecting 189
placing text in Alpha channel 200
preset font and size 175
safe area and text 178
scaling text 183
selecting text 174
selecting text as object 174
softness setting, selecting 191
superimposing text on clips 171
text box, resizing 177
Text page 181
text shadow, using 191
Text Style page 173
typing text 173

tracks
activating/deactivating for editing 87
activating/deactivating in Sequencer 68
enabling/disabling for rendering 81
in source clip 66
making visible 78
playing video 78

transferring program to videotape
See printing program to videotape

transitions
animating 114
application and use of 109
Band wipe 125
Barn Door 125
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Barn door 125
border, using 121
controls, using 116
creating custom 127
Cross Fade Audio transition 117
Dissolve transition 117
DVE 127
expanding track to see 112
introduction to 17
Iris transition 119
linear motion in 124
Radial Wipe transition 123
softness setting, selecting 120
Venetian blind 125
Wipe transitions 124

Trim window 99
changing number of frames played with a cut 107
editing cuts 100
introduction 7
shortening or lengthening Outgoing and Incoming clips 102
trimming Outgoing and Incoming clips simultaneously 105

trimming clips
lengthen or shorten incoming clip 103
lengthen or shorten outgoing clip 104
multiple tracks 106

U
Use drop frame time scale preference 73
Using MotoDV for Capture 33
V
Venetian Blind wipe

choosing width of blinds 126
described 125

vertical wipes 126
Video compressor 233
Video Input Settings 35
videotape



    
playing without device control 39
volumes

choosing for digitizing 37
finding clips in other projects 41, 44

W
waveforms, audio 133
width

See also thickness
border width 121
choosing for venetian blinds and bands 127
setting for columns in text view 49

windows
management of 9

Wipe transitions
Band Wipe 125
Barn Door wipe 125
border, using 124
described 124
determining direction 126
DVE transition 127
moving clips in 127
Pan/Zoom transition 127
reversing 126
selecting softness setting 124
Venetian Blind 125
Wipe transition 125

wrapping text 173
Y
YUV Codec compressor 234
Z
zooming

Iris transition 121
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